Using SDSF in a JES3 Environment

Simplify management of JES3 systems

Common UI for both JES2 and JES3

Write powerful scripts using SDSF/REXX

Juha Vainikainen
Paul Rogers
Karan Singh
First Edition (October 2009)

This edition applies to Version 1, Release 11, Modification 0 of z/OS (product number 5694-A01).
Contents

Notices .............................................................................................................. v
Trademarks ..................................................................................................... vi

Preface .............................................................................................................. vii
The team that wrote this paper ....................................................................... vii
Become a published author .............................................................................. vii
Comments welcome ....................................................................................... viii

Chapter 1. z/OS System Display and Search Facility (SDSF) overview .......... 1
  1.1 SDSF functions ......................................................................................... 2
  1.2 JES3 SDSF primary option menu .......................................................... 3
     1.2.1 SDSF panel structure in the JES3 environment ............................ 3
     1.2.2 JES3 monitor ................................................................................... 6
     1.2.3 Using SDSF in batch ....................................................................... 6
     1.2.4 Using SDSF with the REXX programming language ................. 7
     1.2.5 JES3 SDSF security ......................................................................... 7
     1.2.6 SDSF server .................................................................................... 7

Chapter 2. SDSF online help and panels ......................................................... 9
  2.1 PF keys .................................................................................................... 10
  2.2 Help panels ............................................................................................. 10
  2.3 SDSF tutorial .......................................................................................... 13
  2.4 SDSF panels ........................................................................................... 13
  2.5 Action bar ................................................................................................ 17
  2.6 Action characters ..................................................................................... 21
  2.7 SDSF server ........................................................................................... 21
  2.8 SDSF security and ISFPARMS overview ............................................. 22
     2.8.1 ISFPARMS statements for the JES3 environment ..................... 23
     2.8.2 FLD/FLDENT statements and tabular displays ....................... 23
  2.9 COLSHELP command .......................................................................... 25
  2.10 Overtyping fields .................................................................................. 26

Chapter 3. Working with JES3 ..................................................................... 29
  3.1 SDSF features for working with JES3 .................................................... 30
  3.2 Users’ authorization ............................................................................... 30
  3.3 Filtering display data .............................................................................. 33
  3.4 View alternate form of a tabular SDSF panel ...................................... 37
  3.5 Input queue (I) panel .............................................................................. 37
  3.6 Status (ST) panel ................................................................................... 43
  3.7 Viewing jobs’ spool data ......................................................................... 45
  3.8 JESPLEX (JP) panel ............................................................................... 50
  3.9 Job Class (JC) panel ............................................................................... 52
  3.10 Spool Volumes (SP) panel .................................................................... 53
  3.11 Hardcopy log displays .......................................................................... 55
  3.12 SYSLOG panel (LOG S) ...................................................................... 60
     3.12.1 Commands for the SYSLOG panel ......................................... 62

Chapter 4. Working with MVS .................................................................... 65
  4.1 Display Active Users (DA) panel ............................................................ 66
4.2 System Requests (SR) panel ...................................................... 70
4.3 Scheduling Environment (SE) panel ........................................ 72
4.4 Resource (RES) panel ............................................................... 73
4.5 Enclaves (ENC) panel ............................................................... 74
4.6 Processes (PS) panel ................................................................. 77
4.7 Health Checker (CK) panel ......................................................... 79

Chapter 5. SDSF REXX and SDSF in batch ....................................... 83
5.1 SDSF REXX ............................................................................. 84
5.2 SDSF in batch .......................................................................... 88

Appendix A. A sample REXX exec to display JES3 job zero data sets ....... 93
5.3 SDRXJ0DS REXX .................................................................. 94

Appendix B. Sample files ................................................................. 103
B.1 ISFPRM00 sample ................................................................. 104

Related publications ...................................................................... 111
IBM Redbooks ............................................................................. 111
Other publications ........................................................................ 111
Online resources ........................................................................... 111
How to get Redbooks ................................................................... 111
Help from IBM ............................................................................. 111

Index ............................................................................................ 113
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

| BookManager® | PrintWay™ | System z® |
| DB2® | RACF® | z/OS® |
| GDDM® | Redbooks® | z9® |
| IBM® | Redbooks (logo) | zSeries® |
| OS/390® | System z10™ | System z9® |
| Parallel Sysplex® |

The following terms are trademarks of other companies:

Java, SBI, and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.
Preface

This IBM® Redpaper publication offers a broad overview of features of the z/OS® System Display and Search Facility (SDSF) for JES3. z/OS R10 delivers the (long-requested) ability to use SDSF in a JES3 environment.

This Redpaper describes the features, panels, and functions of SDSF for JES3 and provides implementation and customization details.

The team that wrote this paper

This paper was produced by a team of specialists from around the world working at the International Technical Support Organization, Poughkeepsie Center.

Juha Vainikainen was a Senior I/T Specialist in IBM Finland until his recent retirement. He has extensive experience with all aspects of OS/390® and z/OS and all related subsystems. Juha continues to share his vast knowledge about these topics as a consultant for various ITSO documentation projects.

Paul Rogers is a Consulting IT Specialist at the International Technical Support Organization, Poughkeepsie Center. He writes extensively and teaches IBM classes worldwide on various aspects of z/OS, z/OS UNIX®, and Infoprint Server. Before joining the ITSO 20 1/2 years ago, he worked in the IBM Installation Support Center (ISC) in Greenford, England providing and JES support for IBM EMEA and the Washington Systems Center. Paul has worked for IBM for 41 years.

Karan Singh is a Project Leader with the International Technical Support Organization (ITSO) in Poughkeepsie, NY. His areas of expertise include core z/OS technologies.

Thanks to the following people for their contributions to this project:

Rich Conway, Bob Haimowitz
International Technical Support Organization, Poughkeepsie Center

Scott Greer, Ken Jonas, Joseph Perillo
IBM

Become a published author

Join us for a two- to six-week residency program! Help write a book dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You will have the opportunity to team with IBM technical professionals, Business Partners, and Clients.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you will develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at:
Comments welcome

Your comments are important to us!

We want our papers to be as helpful as possible. Send us your comments about this paper or other IBM Redbooks® publications in one of the following ways:

► Use the online Contact us review Redbooks form found at:
  ibm.com/redbooks

► Send your comments in an e-mail to:
  redbooks@us.ibm.com

► Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Chapter 1. z/OS System Display and Search Facility (SDSF) overview

The System Display and Search Facility (SDSF- Program Number 5694-A01), a feature of IBM mainframes running z/OS, enables users and administrators to view and control various aspects of the mainframe's operation. These include jobs in execution, job output, status of running Unix System Services processes, system information, workload scheduling, and log files.

SDSF displays data on panels. Commands and actions that you enter on the panels let you monitor and control jobs and system resources. The SDSF Primary Option Menu lists the panels that you are authorized to use.

Most SDSF panels display information in a tabular format. You can scroll the information up, down, right, and left. The tabular panels have a fixed field, at the left, that does not move as you scroll right and left.

History
SDSF was originally known as SPOOL Display and Search Facility when it was a field-developed program offering. The word SPOOL was changed to System when it became a program product in the late 1980s. Starting with z/OS Release 9 SDSF also supports a REXX interface, allowing batch program facilities to use SDSF. The REXX support implementation presents data through stem variables containing SDSF-originated information.

Prior to z/OS Release 10, SDSF was supported for use with JES2 but not JES3. At and beyond z/OS Release 10 JES3 is supported, with some new commands to display the JES3 job information.
1.1 SDSF functions

SDSF is a program that runs under z/OS TSO/E and uses Interactive System Productivity Facility (ISPF) panels. Some of the functions described in this book are specific to JES3. With SDSF, you can do the following:

- Display immediate, up-to-date information about the jobs submitted to JES3 for processing, including:
  - Jobs on the JES3 queues
  - Job status of a specific job, including the job's priority and input class, the time and date the job was entered in the system, and the time and date the system began processing the job
  - System information about active jobs
  - Spool data sets for a specific job
  - Output from a job
- Monitor and control jobs, output, and resources in a JES3 complex without using JES3-specific command syntax.
- Manage system resources, such as main processors in the JES3 complex, job classes, and WLM enclaves.
- Enter MVS and JES3 system commands from any TSO/E terminal.
- View the system log (SYSLOG), operations log (OPERLOG), or user log (ULOG) online and search for specific information, which can reduce problem management time and eliminate the need for a printed copy of the log.
- View input data sets of jobs that are being processed or waiting to be processed.
- View output data sets online and purge them, which can reduce the system print load.
- Monitor and control the IBM Health Checker for z/OS checks.
- Get online information: help for panels, commands, and messages; an interactive tutorial for ISPF users; and online documentation through BookManager®.

SDSF may be invoked on either a local or global processor running z/OS V1R10 JES3 or later. When SDSF is invoked on a local processor, the global processor must also be at the z/OS V1R10 JES3 or later level.

SDSF information

Information about SDSF and z/OS is available on the Internet. If it is supported by your 3270 emulator, you can click a Web address to launch a Web browser.

- SDSF home page: usage tips, presentations, as well as a wizard to help you enable the Sysplex support can be found at:
- The latest edition of z/OS SDSF Operation and Customization, SA22-7670 is available at:
1.2 JES3 SDSF primary option menu

Figure 1-1 shows the ISPF display of the z/OS Version 1 Release 11 SDSF primary option menu in a JES3 environment for a user with full authority.

1.2.1 SDSF panel structure in the JES3 environment

Figure 1-2 is a view of the full SDSF panel structure in the JES3 environment.

JES3 primary menu options

Figure 1-2 shows the JES3-related functions on the authorized primary option menu panel. The SDSF commands are as follows:

DA  The Display Active Users (DA) selection allows authorized users to display information about jobs, users, and started tasks that are active in the sysplex. It
Using SDSF in a JES3 Environment

also shows system data, such as CPU usage and paging information. In a JES3 environment, the DA selection also requires RMF.

**I**  The *Input Queue (I)* selection allows authorized users to display information about jobs that are on the JES input queue or that are executing.

**ST**  The *Status (ST)* selection allows authorized users to display information about jobs, started tasks, and TSO users on the JES queues.

**LOG O**  The *OPERLOG (LOG O)* selection allows authorized users to display a sysplex-wide system message log, which contains console messages, operator commands, and responses for the sysplex.

**LOG S**  The *SYSLOG (LOG S)* selection allows authorized users to display the system log. The SYSLOG is a data set residing in the primary job entry subsystem's spool space. If JES3 DLOG is active on the global, system log entries are for the whole JES3 complex. The DLOG message prefix (IATYCNS TYPE=DLOG) is different from the MVS hardcopy log prefix (IHAHCLOG). The JES3 *F 0 command enables or disables the DLOG.

**SR**  The *System Requests (SR)* selection allows authorized users to display outstanding operator replies (WTORs) and messages retained by the Action Message Retention Facility (AMRF).

**JP**  The *JESPlex (JP)* selection allows authorized users to display and control the main processors in a JES3 JESPlex.

**JC**  The *Job Class (JC)* selection allows authorized users to display and control the job classes defined to JES. Both JES and WLM managed classes are shown.

**SE**  The *Scheduling Environment (SE)* selection allows authorized users to display the sysplex wide scheduling environments. A scheduling environment is a list of resource names along with their required states. If an MVS image satisfies all of the requirements in the scheduling environment associated with a given unit of work, then that unit of work can be assigned to that MVS image. If any of the requirements are not satisfied, then that unit of work cannot be assigned to that MVS image.

**RES**  The *Resource (RES)* selection allows authorized users to display WLM resources. To display resources in the sysplex, access the panel with the RES command. To display resources for a scheduling environment, access the panel with the R action character from the SE panel. When a resource is used as part of a scheduling environment, the resource is an abstract element that can represent an actual physical entity (such as a peripheral device), or an intangible quality (such as a certain time of day). A resource is listed in a scheduling environment along with a required state of ON or OFF. If the corresponding resource state on a given system matches the required state, then the requirement is satisfied for that resource.

**ENC**  The *Enclaves (ENC)* selection allows authorized users to display information about WLM enclaves. An enclave is an anchor for a transaction that can be spread across multiple dispatchable units in multiple address spaces. These multiple address spaces can even span across multiple systems in a parallel sysplex. The value of using an enclave to represent a transaction is that the resources used to process the transaction can be accounted to the transaction itself, rather than to the address space or spaces that the transaction runs in. In addition, you can assign a performance goal to the enclave, which means that as a transaction consumes system resources, it can switch periods to run with a new goal. Any number of tasks and SRBs can be grouped in an enclave.

**PS**  The *Processes (PS)* selection allows authorized users to display information about z/OS UNIX System Services processes. A process is a program or command that is actually running the computer. It consists of a loaded version of the executable file,
its data, its stack, and its kernel data structures that represent the process's state within a multitasking environment. The executable file contains the machine instructions (and any calls to shared objects) that will be executed by the hardware. A process can contain multiple threads of execution. A process is created via a fork() system call and ends using an exit() system call. Between fork and exit, the process is known to the system by a unique process identifier (pid).

SP
The Spool Volumes (SP) selection allows authorized users to display information about JES spool volumes.

CK
The Health Checker (CK) selection allows authorized users to display information from IBM Health Checker for z/OS.

ULOG
The User Session Log (ULOG) selection allows authorized users to display the MVS and JES commands and responses issued during the user's session, including commands generated by SDSF and SAF. SDSF deletes the user session log when an SDSF session is ended or when the ULOG CLOSE command is issued. SDSF uses MVS console services to acquire an extended console that is used to issue commands and receive responses.

/
The slash (/) system command allows system commands to be issued.

JES2 SDSF primary panel
Figure 1-3 shows the ISPF display of the z/OS Version 1 Release 11 SDSF primary option menu in a JES2 environment for a user with full authority.

The SDSF support in the JES2 environment includes several functions that are not available in the JES3 support. These are:

- The Output Queue (O) selection displays information about spooled output for jobs, started tasks, and TSO users on any nonheld output queue.
- The Held Output Queue (H) selection displays information about SYSOUT data sets for jobs, started tasks, and TSO users on any held output queue.
- The Initiator (INIT) selection displays information about initiators.
- The Printer (PR) selection displays information about printers and jobs being printed.
- The Punch (PUN) selection displays information about punches and jobs being punched.
1.2.2 JES3 monitor

This monitor does automatic monitoring of JES3 functions. The JES3 monitor DSP runs as an FCT under the JES3 Nuc task. It monitors unavailable JES3 resources. A JES3 resource is anything that can use an FCT or a job that can become unavailable. The monitor DSP allows you to monitor the following JES3 resources:

- Generalized subtasks
- AENQ resources
- JQEs
- Job numbers
- File directory entries
- JSAM buffers
- Spool space

**Note:** Compared with the JES3 SDSF primary option menu (Figure 1-1 on page 3), JES2 has commands for H, O, INIT, PR, PUN, RDR, LINE, NODE, RM and SO panels that are not currently supported in the JES3 environment.

1.2.3 Using SDSF in batch

Using batch job processing, you can issue often-repeated SDSF commands by creating a list of the commands as control statements. In the list, you specify the SDSF panel you wish to use and the operation you wish to perform on it.

SDSF in batch is invoked with one of two program names on a JCL EXEC statement:

- **SDSF** supports commands and action characters.
- **ISFADP** supports commands, action characters, and overtyping of fields on tabular and other panels, such as the print panels.
1.2.4 Using SDSF with the REXX programming language

Using REXX with SDSF provides a simpler and more powerful alternative to using SDSF in batch. An authorized user can access SDSF functions from a REXX program. SDSF provides the following:

- The ISFCALLS command, to add and delete the SDSF host command environment
- The ISFEXEC command, for SDSF commands such as the commands that access SDSF panels
- The ISFACT command, for action characters and overtyping columns
- The ISFSLASH command, to issue a list of system commands
- Special REXX variables, to provide function equivalent to other SDSF commands, and for messages and table data.
- The ISFRESET command, to drop all special variables.

SDSF online help

Information about using REXX with SDSF is also available in SDSF's online help. The help includes links to descriptions of commands, action characters and overtypable columns, which is not included here.

To display the online help about using REXX with SDSF:

- Type REXXHELP on any command line in SDSF when using SDSF under ISPF.
- Type COLSHELP, which shows information about columns on various display panels.

1.2.5 JES3 SDSF security

When processing under JES3, only SAF-based security is used. This is optional in the JES2 environment but required in the JES3 environment. There is no ISFPARMS processing for security purposes. In cases where SAF cannot make a decision (SAF return code 4), the user is denied access to the resource. This is consistent with the general z/OS policy if access to a resource should be denied unless explicitly granted.

1.2.6 SDSF server

The server is optional in all environments.

For JES3, all configuration parameters default if there is no server. That is because the assembler ISFPARMS is not supported in JES3 and the server is required to process the ISFPARMxx parmlib member.

The SDSF server is an address space that SDSF uses to:

- Process ISFPARMS statements.
- Provide sysplex data on the device panels in a JES2 environment. This use of the server does not apply to the JES3 environment.
- Provide sysplex support for the SYSLOG panel. It does not apply to the JES3 environment.

**Note:** This function is removed in z/OS V1R11 with the JES3 support.
When the server is not started, the user must be permitted to the SERVER.NOPARM resource in the SDSF class, otherwise initialization will fail.

**Note:** The current document, *z/OS SDSF Operation and Customization*, SA22-7670 describes the most up-to-date security considerations and customization of SDSF.
SDSF online help and panels

This chapter introduces the SDSF help feature and briefly describes the typical SDSF tabular panel layouts.
2.1 PF keys

Under ISPF, toggle the display of PF keys with **PFSHOW**, and change with **KEYS**. Under TSO, the keys cannot be displayed or changed.

SDSF's pop-ups each have PF keys assigned with an ISPF keylist. Although ISPF allows you to change the values of the keys in keylists, and to turn off the use of keylists, you should use the IBM-supplied key definitions and leave keylists on to ensure that the pop-ups work correctly.

The PF key definitions for SDSF's panels are shown in Figure 2-1.

<table>
<thead>
<tr>
<th>KEY</th>
<th>ISPF (Default)</th>
<th>TSO</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 and 13</td>
<td>Help</td>
<td>Help</td>
</tr>
<tr>
<td>2 and 14</td>
<td>Split the screen</td>
<td>Not used</td>
</tr>
<tr>
<td>3 and 15</td>
<td>End the current panel</td>
<td>End the current panel</td>
</tr>
<tr>
<td>4 and 16</td>
<td>End SDSF</td>
<td>End SDSF</td>
</tr>
<tr>
<td>5 and 17</td>
<td>Repeat the previous FIND</td>
<td>Repeat the previous FIND</td>
</tr>
<tr>
<td>6 and 18</td>
<td>Invoke BookManager</td>
<td>Not used</td>
</tr>
<tr>
<td>7 and 19</td>
<td>Scroll up</td>
<td>Scroll up</td>
</tr>
<tr>
<td>8 and 20</td>
<td>Scroll down</td>
<td>Scroll down</td>
</tr>
<tr>
<td>9 and 21</td>
<td>Swap split screens</td>
<td>Print the screen</td>
</tr>
<tr>
<td>10 and 22</td>
<td>Scroll left</td>
<td>Scroll left</td>
</tr>
<tr>
<td>11 and 23</td>
<td>Scroll right</td>
<td>Scroll right</td>
</tr>
<tr>
<td>12 and 24</td>
<td>Retrieve the previous command. (Some short commands are not retrieved.)</td>
<td>Return the cursor to the command line</td>
</tr>
</tbody>
</table>

*Figure 2-1 SDSF panel key definitions*

2.2 Help panels

Information for end users of SDSF, such as commands, action characters, and messages, is provided in the online help for SDSF.

Help panels appear in pop-up windows in response to user requests for assistance during SDSF application sessions. Figure 2-2 on page 11 shows the table of contents (TOC) for SDSF online help. This panel can be accessed by typing HELP at the Command Input line, by pressing the PF1 key at the SDSF Primary Option Menu, or choosing Option 1. Extended help from the SDSF HELP action bar menu.
SDSF provides HELP for the HELP. Figure 2-3 and Figure 2-4 on page 12 are the window pop-ups for the HELP command. These panels can be accessed by typing HELP at the command input line from any HELP dialog window.
Figure 2-4   HELP: HELP Command (2 of 2)

Figure 2-5 shows the HELP Index pop-up. The HELP index can be accessed by entering I in the command input line from any HELP dialog window. To locate an index character, just type that character on the COMMAND INPUT ===> line.

Figure 2-5   HELP Index
2.3 SDSF tutorial

The SDSF tutorial introduces SDSF and lets you try some of SDSF’s most useful functions. For detailed information such as command syntax, use the help facility.

Some parts of the tutorial ask you to enter information on simulated SDSF panels. These simulated panels respond to your input. Interacting with them will help you learn how SDSF works. However, if you prefer, the system provides the input on interactive panels if you simply press Enter twice.

Except on the interactive tutorial panels, SDSF commands are not valid on tutorial or help panels.

2.4 SDSF panels

The SDSF primary option menu lists the panels that you are authorized to use, and the commands that display the panels. (A few panels, shown later in this topic, are accessed with action characters instead of commands, and do not appear on the primary option menu.)

Most SDSF panels display information in a tabular format. You can scroll the information up, down, right, and left. The tabular panels have a fixed field, at the left, that does not move as you scroll right and left.

Under ISPF, most SDSF functions can be selected from the action bar at the top of the screen. To display a pull-down menu of choices, place the cursor on an option on the action bar and press Enter.

SDSF uses colors on the tabular panels to identify active objects (such as jobs) and overtypable fields, as shown in Table 2-1.

<table>
<thead>
<tr>
<th>Table 2-1  SDSF color indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
</tr>
<tr>
<td>Blue</td>
</tr>
<tr>
<td>White</td>
</tr>
<tr>
<td>Green</td>
</tr>
<tr>
<td>Red</td>
</tr>
</tbody>
</table>
Sample tabular SDSF panel layout

Figure 2-6  Sample SDSF panel layout - DA display

Figure 2-6, Display Active Users Panel, is used to describe the SDSF panel layout and features.

Online HELP example for the DA tabular panel

The following section gives an example of the help feature available for SDSF tabular panels.

Figure 2-7  Help panel for Display Active Users Panel

Figure 2-7 shows the general layout of the first pop-up window for a SDSF display panel. Examples of the help pop-up window topic text (DA display) follows.
The “Introduction to the DA panel” panel is shown in Example 2-1.

**Example 2-1  ** **Topic 1 - Introduction to the DA panel**

The Display Active Users (DA) panel allows authorized users to display information about jobs, users, started tasks, and initiators that are active in the sysplex. It also shows system data, such as CPU usage and paging information.

In a JES3 environment, the DA panel requires RMF.
In a JES2 environment, RMF is required for sysplex-wide data and some columns and actions.

Note: Some of the values on the DA panel, such as CPU% and SIO, are approximate. For detailed and precise performance monitoring, use RMF.

The “Syntax of the DA command” panel is shown in Example 2-2.

**Example 2-2  ** **Topic 2 - Syntax of the DA command**

You must be authorized to use this command.
Where used: Any SDSF panel.
Format: DA (parameters)

Parameters allow you to limit the display by:
- Types of address spaces: jobs, TSO users, started tasks, or initiators
- Positions of address spaces: swapped in, swapped out, in transition, or ready.

The parameters are explained on the next panel.

Example: DA OIN NOTSU
Displays only address spaces that are swapped in, not including TSO users.

The “Action characters: display output, cancel jobs, etc.” panel is shown in Example 2-3.

**Example 2-3  ** **Topic 3 - Action characters: display output, cancel jobs, etc.**

Action characters that can be entered in the NP column by authorized users are:

//    Block repeat; type // on the first row and another // on the last row to be processed
=    Repeat previous action character or overtype
+    Expand the NP column. (Use **RESET** to reset.)
A    Release a held job.
C    Cancel a job. For JES3, also print non-held data sets.
CA   Cancel a job that is defined to Automatic
Using SDSF in a JES3 Environment

Restart Manager (ARM).

CD    Cancel a job and take a dump.
CDA   Cancel a job that is defined to ARM, and take a dump.
CP    Cancel a job and delete held data sets. (JES3 only)

The “Fields on the DA panel” panel is shown in Example 2-4.

Example 2-4  Topic 4 - Fields on the DA panel

- 1st pop-up

The title line shows the following:

<table>
<thead>
<tr>
<th>SDSF DA IPO1</th>
<th>IP*</th>
<th>PAG</th>
<th>CPU/L/Z/</th>
<th>26/</th>
<th>26/</th>
<th>0</th>
<th>LINE 1-20 (20)</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID of system you are logged on to Systems displayed (MVS value or SYSNAME value)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total demand paging rate Lines displayed or first line if 100,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percentage of time the CPU is busy, MVS, LPAR and zAAP views</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total lines (**** if more than 99,999,999)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

S10, if shown, is the total system start I/O rate.
PAG, S10, and CPU values are for the system you are logged on to.

- 2nd pop-up

The Display Active Users panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBNAME</td>
<td>Job name of the address space</td>
</tr>
<tr>
<td>StepName</td>
<td>Job step name, or TSO procedure name for TSO users</td>
</tr>
<tr>
<td>ProcStep</td>
<td>Procedure step name, or terminal name for TSO users</td>
</tr>
<tr>
<td>Type</td>
<td>Type of address space: job, started task, TSO user, or initiator</td>
</tr>
<tr>
<td>JNum</td>
<td>JES job number</td>
</tr>
<tr>
<td>Owner</td>
<td>User ID of job creator</td>
</tr>
<tr>
<td>C</td>
<td>JES input class at the time the job was selected for execution</td>
</tr>
<tr>
<td>Pos</td>
<td>Address space position, for example, swapped in, swapped out, nonswappable, in transition</td>
</tr>
</tbody>
</table>

Several other pop-ups follow that describe the rest of the panel fields.

The “Overtyping fields to change their values” panel is shown in Example 2-5.

Example 2-5  Topic 5 - Overtyping fields to change their values

The following fields can be overtyped by authorized users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGN</td>
<td>Performance group number</td>
</tr>
<tr>
<td>SrvClass</td>
<td>Service class name</td>
</tr>
<tr>
<td>Quiesce</td>
<td>Quiesce indicator (QUIESCE or RESUME)</td>
</tr>
</tbody>
</table>
Overtyping these fields causes an MVS RESET command to be issued. SDSF appends an RO command if the MVS command is targeted for another system.

For more information, select this topic by number:
1 - About overtyping fields

The “Commands: limit jobs displayed, search, etc.” panel is shown in Example 2-6.

**Example 2-6  Topic 6 - Commands: limit jobs displayed, search, etc.**

A few useful commands are shown below. Some require authorization

- FILTER column oper value - Filter jobs shown on any column.
- FIND jobname - Search for a job name.
- SET DISPLAY - Show settings for PREFIX, DEST, SORT, etc.
- SORT column A|D - Sort based on a column, ascending or descending.
- SYSNAME system - Filter jobs by system name.

For complete command help, select a topic by number.

1 - Search and scroll commands (FIND and others)
2 - Filter commands (FILTER, OWNER, PREFIX, SYSNAME and others)
3 - View commands (SORT and others)
4 - Options commands (SET DISPLAY and others)

### 2.5 Action bar

Under ISPF, most SDSF functions can be selected from the action bar, a row of options at the top of the screen. Select an option from the action bar by placing the cursor on an item and pressing Enter. In the pull-down menu of choices that is displayed, select a choice by number or by placing the cursor on it and pressing Enter. Choices ending with an ellipses (…) display a pop-up window.

Most of the SDSF’s displays use the same ISFPCU41 panel. This panel defines the same set of action bar choices for all displays where used.

The action bar choices are:

- **Display** - This action bar choice represents three related choices that appear in the pull-down:
  - **Panels** - The Panels choice displays a menu of the SDSF panels. The SDSF panel menu lists 24 displays. Each display choice is numbered. When a display choice is available, its number is highlighted. The panels list is shown in Figure 2-8 on page 18.
Using SDSF in a JES3 Environment

- Logs... - The Logs pop-up allows you to display one of the two SDSF Log panels.
  - The System Log option displays the SDSF log panel, which displays MVS log data.
  - The User Session Log option displays the SDSF User Session Log (ULOG) panel, which shows MVS and JES commands and responses (including commands generated by SDSF) that you issued during your session.

- Exit SDSF - The Exit SDSF choice of the Display pull-down ends the SDSF session.

- Filter - The Filter choice of the Filter pull-down displays the Filter pop-up, which allows you to filter the data displayed on SDSF panels that display data in tabular format:
  - Filter... - The Filter choice of the Filter pull-down displays the Filter pop-up, which allows you to filter the data displayed on SDSF panels that display data in tabular format.
  - Prefix of jobname... - The Prefix choice of the Filter pull-down displays a pop-up that allows you to filter the DA, I, PS and ST panels based on job name.
  - Owner... - The Owner choice of the Filter pull-down displays a pop-up that allows you to filter the DA, I, PS and ST panels based on owning user ID.
  - Destination... - The Destination choice of the Filter pull-down displays a pop-up that allows you to filter the I, PR, ST, and PUN panels based on destination.
  - System name... - The System name choice of the Filter pull-down displays a pop-up that allows you to specify which systems are to be included on the DA panel.
  - Change APPC to OFF - JES2 - The Change APPC choice of the Filter pull-down acts as a toggle to control the display of APPC transactions on the H and O panels.
  - Replies on the Log... - The Replies on the Log choice of the Filter pull-down displays the Replies on the Log pop-up, which lets you filter the WTORs on the Log panel.

- View - The View option of the action bar allows you to control the view of the data displayed on SDSF panels. To select the View option, press Enter with the cursor on View:
  - Sort... - The Sort choice of the View pull-down displays a pop-up that allows you to sort the SDSF panels that display information in tabular format.
– **Arrange...** - The Arrange choice of the View pull-down displays the Arrange pop-up, which allows you to reorder and change the widths of the columns on panels that display data in tabular format.

– **Set hex to ON** - The Set Hex choice of the View pull-down acts as a toggle to turn hexadecimal formatting of the log or output data sets on or off.

– **Change field list to ALTERNATE** - The Change Field List choice of the View pull-down acts as a toggle to display the primary or alternate fields on SDSF panels that display information in tabular format.

– **Who...** - The Who choice of the View pull-down displays your user ID, TSO logon procedure name, terminal ID, the index number and name of your group in ISFPARMS, information about software levels, and information about the server. An example is shown in Example 2-7.

Example 2-7  Who display

```
USERID=VJUHA,PROC=IKJACCJV,TERMINAL=SC38TC86,GRPINDEX=1,GRPNAME=ISFS
MVS=Z/OS 01.11.00,JES=Z 1.11.0,SDSF=HQX7760,ISPF=6.1,RMF/DA=760,SERVER=YES,
SERVERNAME=SDSF,JESNAME=JES3,MEMBER=SC75,JESTYPE=JES3,GLOBAL=SC75,
GLOBALREL=HJS7760,SYSNAME=SC75,SYSPLEX=PLEX75,COMM=NOTAVAIL
```

The field for server communications (COMM=) shows information about communications between SDSF servers.

– **Print** - The Print option of the action bar allows you to select options for printing data:

  – **Print open sysout...** - The Print Open Sysout choice displays a panel that allows you to specify the attributes of a SYSOUT print file.

  – **Print open data set...** - The Print Open Data Set choice displays a panel that allows you to specify the attributes of a data set to be used as the print file.

  – **Print open file...** - The Print Open File choice displays a panel that allows you to specify the ddname to be used as the print file.

  – **Print...** - The Print choice displays a pop-up that allows you to specify the lines to print from a SYSLOG or output data set. If no print file is open, the Print choice opens a default SYSOUT file.

  – **Print close** - The Print Close choice either frees a SYSOUT print file and makes it available for printing, or closes a print data set.

  – **Print screen with ISPF** - The Print Screen with ISPF choice invokes ISPF's PRINT command to print the screen image to an ISPF list file. This choice does not use SDSF's print file.

– **Options** - The Options option of the action bar allows you to set options such as a find limit and colors:

  – **Set action character display...** - The Set Action Character Display choice of the Options pull-down displays a pop-up that allows you to control the display of valid action characters on SDSF panels.

   Action characters are typed in the NP column of tabular panels. For example, to purge a job, you type **p** in the NP column next to the job on the Status panel.

   The display of the valid action characters for a panel can also be set with the SET ACTION command.

  – **Find limit...** - The Find Limit choice of the Options pull-down displays a pop-up that allows you to limit the number of lines searched when the FIND command is issued on a browse panel.
– **Change include SYSIN to ON** - The Change Include SYSIN choice of the Options pull-down lets you control whether the Output Data Set panels that you select from the DA, ST, or I panels will include SYSIN data sets.

– **Set bookshelf** - The Set Bookshelf choice of the Options pull-down displays a pop-up that allows you to set the default bookshelf to be searched by BookManager.

– **Set display values to ON** - The Set Display Values choice of the Options pull-down acts as a toggle to control the display of values for DEST, OWNER, PREFIX, FILTER, SORT and SYSNAME on the information line. An example snippet of a DA display is shown in Figure 2-9.

```
Figure 2-9   Snippet of a DA display
```

– **Set screen characteristics** - The Set Screen Characteristics choice of the Options pull-down displays a pop-up that allows you to control the use of color and highlighting on SDSF panels, as well as turn the display of the action bar on or off.

– **Set delay for responses** - The Set Delay choice of the Options pull-down displays a pop-up that allows you to control the default timeout value for awaiting responses to the slash (/) command.

– **Set communications timeout** - The Set communications timeout choice of the Options pull-down displays a pop-up that lets you set the timeout value for awaiting sysplex data.

– **Set console name** - The Set Console Name choice of the Options pull-down displays a pop-up that allows you to set the name of the extended console used by SDSF. The extended console is used by the ULOG panel.

– **Set search characters** - The Set Search Characters choice of the Options pull-down displays a pop-up that lets you set the generic and placeholder characters used in pattern matching.

– **Assign PF keys** - The Assign PF Keys choice of the Options pull-down invokes ISPF's KEYS facility to let you change the PF keys for SDSF panels.

– **Change show PF keys to OFF** - The Change Show PF Keys choice of the Options pull-down invokes ISPF's PFSHOW command to let you turn the display of PF keys on or off.

– **Set language for help and tutorial** - The Set Language for Help and Tutorial choice of the Options pull-down displays a pop-up that allows you to select English or Japanese for the Help and Tutorial.

– **Set cursor option** - The Set Cursor choice of the Options pull-down acts as a toggle to control how SDSF places the cursor when you work with rows on tabular panels (except OD).

**ON** causes the cursor to return to the NP column for the last row you worked with. If the row is not on the screen, either because it would require a scroll, or because your
actions or system activity caused it to be removed from the display, the cursor is returned to the command line.

**OFF** causes the cursor to return to the command line.

- **Set confirmation to OFF** - The Set Confirmation choice of the Options pull-down acts as a toggle to control confirmation of action characters. When confirmation is on, SDSF requests confirmation of cancel, purge, restart and system stop action characters on job-oriented tabular panels (DA, H, I, JDS, O, PS and ST), drain and halt actions on the SP panel, and quiesce on the ENC panel.

- **Operlog limit for filter...** - The Operlog Limit for Filter choice of the Options pull-down displays the Operlog Limit for Filter pop-up, which lets you set the amount of Operlog data SDSF will search for records that meet filter criteria.

- **Set date format...** - The Set date format choice of the Options pull-down displays the Set Date Format pop-up, which lets you select the format SDSF uses for dates. The available date formats are mm/dd/yyyy, dd/mm/yyyy, or yyyy/mm/dd and the separator character, either slash (/), dash (-), or period (.).

- **Set log default...** - The Set Log Default choice of the Options pull-down displays a pop-up that allows you to select the default panel for LOG command. The default panel is displayed when you enter LOG with no parameters, or select the Log choice from the Display pull-down.

- **Set default browse action...** - The Set Default Browse Action choice of the Options pull-down displays a pop-up that allows you to select the default action (S, SB or SE) that is issued when you place the cursor in the NP column and press Enter on the job and output panels. The options are S (SDSF browse), SB (ISPF browse), SE (ISPF edit), and None. The default browse action character is invoked when you select a row on a job or output panel (DA, I, JDS, OD or ST) by placing the cursor in the NP column and pressing Enter. The result is the same as if you had typed the action character in the NP column.

  If you select None, then you must type an action character in the NP column to invoke browse.

- **Help** - The Help option of the action bar allows you to select different kinds of online help.

### 2.6 Action characters

The action characters are entered in the NP column of tabular panels.

In most cases, action characters cause system commands to be issued. Both the ability to issue some action characters, and the command that is generated, depend on your installation options and operating system level.

Display the valid action characters for a panel with the SET ACTION command.

The help for each SDSF panel includes a list of the action characters that are valid for that panel.

### 2.7 SDSF server

The SDSF server is an address space that SDSF uses to:

- Process ISFPARMS statements.
Provide sysplex data on the device and browse panels.

A server is required in the JES3 environment to process ISFPRMxx. You define your ISFPARMS using statements rather than assembler macros. To process ISFPARMS, the server must be active on each system that contains SDSF users. To provide Sysplex data, the server must be active on each system that is to be included on SDSF panels.

An SDSF server JCL sample is shown in Example 2-8.

Example 2-8  SDSF server JCL sample

```
//SDSF     PROC  M=00, /* SUFFIX FOR ISFPRMXx */
//             P='LC(T)'       /* USE SYSOUT CLASS A FOR SDSFLOG */
//SDSF     EXEC  PGM=ISFHCTL,REGION=32M,TIME=1440,PARM='M(&M),&P'
```

2.8 SDSF security and ISFPARMS overview

ISFPARMS defines global options and the format of the panels. The options include things such as the names of SDSF data sets, what generic and wildcard characters to allow in SDSF commands, and whether to display the action bar on SDSF panels. The format of the panels includes the order and titles of the columns.

SDSF for JES3 implementation requires the SDSF server address space to be started to process ISFPARMS. The server uses dynamic ISFPARMS, which are defined with statements rather than assembler macros. Statements are easier to code and are more dynamic than the assembler macros: they can be updated without reassembling or link-editing.

As an overview to the SAF SDSF security the sample ISFPARMS definitions in ISF.AISFJCL(ISFPRM00) data set are used in the following discussion. This sample is included in Appendix B.1, "ISFPRM00 sample" on page 104 for your reference.

The sample ISFPRM00 defines security for three SDSF groups of users that are common to most installations:

- **Group 1-- System programmers.** User must have JCL, OPER and ACCT TSO authority.
- **Group 2--Operators.** User must have JCL and OPER TSP authority.
- **Group 3--General users.** User must have JCL TSO authority.

You have to choose SAF to protect SDSF functions in the JES3 environment. Even when SAF is used for all of SDSF security, you need ISFPARMS to control the following:

- Global values (ISFPMAC macro or OPTIONS statement)
- Any values for groups that are not related to security (GROUP statement)
- Code page - ITRTAB statement

The control of user membership into a group is accomplished with SAF profiles, as shown in Table 2-2 on page 23.
Table 2-2  SAF profiles for controlling user membership in a group

<table>
<thead>
<tr>
<th>User group</th>
<th>SAF profile</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Programmers</td>
<td>GROUP.ISFSPROG.*</td>
<td>READ</td>
</tr>
<tr>
<td>Operators</td>
<td>GROUP.ISFOPER.*</td>
<td>READ</td>
</tr>
<tr>
<td>General users</td>
<td>GROUP.ISFUSER.*</td>
<td>READ</td>
</tr>
</tbody>
</table>

The access authorities to other profiles in classes SDSF, OPERCMDS, WRITER, XFACILIT, and LOGSTRM control the actions allowed for members in a group. Refer to z/OS SDSF Operation and Customization for a complete description of the SAF profiles.

The z/OS SDSF Operation and Customization document also describes how to configure SAF security for the function provided by GROUP statements.

In general, all TSO users can access the JESSPOOL resources they own. Users do not need access authority to work with their own jobs and output.

When you provide SAF authority to the SDSF resources by group, go from broad access (for example, RACF® generic profiles) to limited access (RACF discrete profiles).

System programmers need access to all profiles for each group in order to attain access to all resources. Likewise, the operators, in addition to having access to their own profiles, also need access to all profiles defined for end users.

2.8.1 ISFPARMS statements for the JES3 environment

The statements for the JES3 environment that make up ISFPARMS are as follows:

- **OPTIONS** - Specifies global SDSF initialization parameters.
- **CONNECT** - Defines a server as a default server.
- **GROUP** - Defines a group of users and the SDSF functions that are available to a member of the group. It also includes initialization parameters.
  In the JES3 environment you must use SAF along with your group definitions to control membership and authorization.
- **FLD** and **FLDENT** - Customizes the fields shown on an SDSF primary or alternate tabular panels for members of the associated group.
- **NTBL** and **NTBLENT** - Specifies such things as user IDs, job names, and destination names to further qualify group membership and authority. Associated with a GROUP statement.
- **PROPLIST** and **PROPERTY** - Specifies a property to customize. Provides an alternative to a user exit routine. Associated with a GROUP statement.

2.8.2 FLD/FLDENT statements and tabular displays

An FLD statement along with FLDENT statements, defines the fields that are displayed on an tabular SDSF panel. It is associated with the field list for a particular panel by a GROUP statement.

You can define a **primary** and **alternate** variable field list for each SDSF panel. The primary field list contains those fields that are shown upon entry into a panel. The alternate field list contains fields that can be displayed with the ? command.
It is also important to locate overtypable fields on the panel so that the entire field is visible on one panel. An overtypable field can be overtaped only when the entire field is visible.

The fields that are available on the display depend on your JES level and installation options. The ARRANGE command allows users to change the order and widths of the fields in each field list.

The columns on SDSF panels that display data in a tabular format are customized with:

- FLD statements. The NAME on FLD statement is referenced by a group. The TYPE on FLD statements name the SDSF panel for which the list of following FLDENT statements defines columns that are included on a tabular panel, as well as their order, titles, and widths.

  On an FLDENT statement the COLUMN parameter names an SDSF panel that displays tabular information. TITLE is the title that appears on a panel for the column defined by column. WIDTH is the width of the column on the panel.

- REXX execs reference columns by their names rather than by their titles.

FLD and FLDENT statements’ syntax is shown in Example 2-9.

**Example 2-9  FLD and FLDENT syntax**

```
FLD NAME(FLD-statement-name),TYPE(panel-ID)
  FLDENT COLUMN(column),TITLE(title),WIDTH(width)
```

The source of the data for each column is extracted from either of the following:

- From in-storage control blocks. These columns are in the primary field list. SDSF performance is best when the columns with data from in-storage control blocks are at the beginning of the field list.

- From the JES spool data set, requiring an I/O operation. These columns are in the alternate field list. I/O operations are only done when the columns are visible on the screen or being sorted. SDSF performance is best when the columns with data from the spool data set are at the end of the field list.

The z/OS SDSF Operation and Customization document has tables that show the column definitions for each SDSF tabular panel and the source of the column data. The tables are for the following panels:

- Display Active Users panel (DA)
- Enclaves panel (ENC)
- Health Checker panel (CK)
- Held Output panel (H) - JES2
- Initiator panel (INI) - JES2
- Input Queue panel (I)
- Job Class panel (JC)
- Job Data Set panel (JDS)
- Lines panel (LI) - JES2
- Multi-Access Spool panel (MAS) - JES2
- Members in the JESPlex (JP) - JES3
- Nodes panel (NO) - JES2
- Output Descriptors panel (OD)
- Output Queue panel (O) - JES2
- Printer panel (PR) - JES2
- Processes panel (PS)
- Punch panel (PUN) - JES2
- Reader panel (RDR) - JES2
2.9 COLSHELP command

The COLSHELP command displays a table of column information for SDSF panels. In Figure 2-10 the table display shows some of the columns and the column titles on the SDSF CK (Health checker) panel.

![COLSHELP command output pop-up](image)

An X in the Delayed? column indicates that access for the column is delayed. Including these columns on a panel may impact performance.

By default, the table shows the columns for the current SDSF panel. Select All panels to include columns from all SDSF panels. If you use the COLSHELP command from the SDSF primary option menu, the table includes columns for all panels.

Scroll to the first row for a specific panel with the LOCATE panel command. LOCATE can be abbreviated as L, for example, L PR.

Filter the columns based on panel, name or title with the FILTER command. For more information, tab to the link and press F1.

Sort the table using one of the indicated PF keys as follows:
- F5 (panel) to sort by panel name.
- F6 (column) to sort by column name.

---

Note: SDSF JES3 implementation does not use all of the panels.
F10 (title) to sort by title.

The sorting in effect is indicated by the underlining of the selected column (panel, column or title) in the headings of the table. For example, if you press F5, the headings will be displayed as shown in Example 2-10.

**Example 2-10**

<table>
<thead>
<tr>
<th>Panel</th>
<th>Column</th>
<th>Title</th>
<th>Delayed?</th>
<th>Overtype?</th>
</tr>
</thead>
</table>

You may select an option (All panels and Include descriptions) by typing any character in the input field. Deselect it by blanking out the input field.

- **All panels** includes columns from all SDSF panels.
- **Descriptions** includes a brief description for each column.

If you cannot find a field on a tabular panel that you are interested in, use the COLSHELP command to display all fields of the panel you are working with. If the field you are interested in is listed in the COLSHELP display, but is marked with an X in the Delayed? column, you can switch the panel field list to ALTERNATE to see the contents of the delayed field. To switch to the panel field list, select View from the action bar and action 4. Change field list to PRIMARY/ALTERNATE from the View pop-up.

## 2.10 Overtyping fields

You can change some data on SDSF panels by typing over it. For example, you can change the class of a job by typing a new value for the class on the input queue panel. (JES3 command *F,J=jobno,C=new_class is issued for the overtype value.)

To be able to overtype a field:

- You must be authorized.
- The entire field must be visible.

You can use the tab key to move from one overtypable field to another. Fields that can be overtyped are highlighted (red or green, by default).

The help for each SDSF panel includes guidance on valid values for overtypable fields. In most cases, overtyping a field causes a system command to be issued.

Blanking out a value with the space bar does not delete the value. Some fields, where the associated system command allows it, support deleting the value by typing a comma by itself in the field.

The overtype extension function also lets you delete values when the field supports a set of related values. You can display the overtype extension pop-up by typing a + by itself in any overtypable field. Figure 2-11 on page 27 is an example of the overtype extension pop-up.
When using the overtype extension pop-up, type a value on the pop-up.

The input field on the pop-up may be longer than the maximum valid value for the column; use the maximum length displayed on the pop-up as a guide.

To remove a value from a set of related fields, blank them out.

To repeat an overtype, type \= in the NP column to repeat the last action character or overtyped fields. The action character or overtype does not have to be on the immediately preceding row. You cannot enter another action character or overtype a field in the row where the \= action character is.

---

**Figure 2-11  Overtype extension pop-up**

<table>
<thead>
<tr>
<th>Display</th>
<th>Filter</th>
<th>View</th>
<th>Print</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDSF STATUS</td>
<td>DISPLAY</td>
<td>ALL CLASSES</td>
<td>COMMAND INPUT</td>
<td>====&gt;</td>
<td>SCROLL</td>
</tr>
<tr>
<td>PREFIX=</td>
<td>DEST=(ALL)</td>
<td>0</td>
<td>ACTION=A,=,+,?,CA,C,</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| ACTION= &amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;apos;&amp;&amp;apos;
Working with JES3

This chapter introduces SDSF features for working with JES3. Topics covered are:

- User authorization to SDSF panel commands
- Filtering display data
- Viewing alternate form of a tabular panel
- Input Queue (I) panel
- Status (ST) panel
- Viewing job output
- JESPLEX (JP) panel
- Job Class (JC) panel
- Spool volumes (SP) panel
- SDSF hardcopy log displays
3.1 SDSF features for working with JES3

SDSF offers many panels and features for interacting with JES3. In this chapter we cover the following topics:

- User authorization to SDSF panel commands
- Filtering display data
- Viewing alternate forms of a tabular SDSF panel
- The Input Queue (I) panel that allows authorized users to display information about jobs that are on the JES input queue or that are executing.
- The Status (ST) panel, which allows authorized users to display information about jobs, started tasks, and TSO users on the various JES queues.
- How to view output formatted for a line-mode device. You can use the S action character, or, to invoke ISPF Browse or Edit, the SB, SE, or SJ action characters.
- The Job Data Set panel allows authorized users to list and display information about the SYSOUT data sets for a job, started task, or TSO user. The Job Data Set panel is accessed with the ? action character.
- To view output formatted for a page printer, you can use the V action character. The V action character requires GDDM® (Version 2 Release 2 or a later release).
- The JESPLEX (JP) panel, which allows authorized users to display and control the main processors of a JES3 JESPLEX.
- The Job Class (JC) panel, which allows authorized users to display and control the job classes in a JES3 complex. It shows both JES and WLM managed classes.
- The Spool Volumes (SP) panel, which allows authorized users to display information about JES spool volumes and spool partitions.
- SDSF hardcopy log displays the following:
  - The OPERLOG, which allows authorized users to display a merged, sysplex-wide system message log, which contains console messages, operator commands, and operator responses for the MVS systems.
  - The operations log (OPERLOG) is a log stream that uses the system logger to record and merge communications from each system in a sysplex.
  - The SYSLOG, which allows authorized users to display the system log. The system log is a collection of JES data sets that contain console messages, operator commands, and operator responses for a z/OS system.
  - SYSLOG individually records command and message traffic for each system in MVS format.
  - JES3 DLOG centrally records command and message traffic for systems in a JES3 complex. The JES3 DLOG is written in JES3 format to SYSLOG on the global processor.
  - SYSLOG on the global processor must be active for DLOG to be active.

3.2 Users’ authorization

The target objects (for example, the job, output group, initiator, or printer) of the SDSF action characters are controlled as resources in the SAF SDSF class and in the JESSPOOL class.
JES uses the JESSPOOL class to protect SYSIN/SYSOUT data sets. SDSF extends the use of the JESSPOOL class to protect SDSF job resources as well.

SDSF checks a user's SAF authorization to:

- Job resources on the Display Active Users, Input Queue, and Status panels.
- Output groups on the Held Output Queue, Job Data Set, Output Queue, and Output Descriptors panels.
- SYSIN/SYSOUT data sets on the Job Data Set panel and any other panel used for browsing with the S or V action characters and printing with the X action character.

Protection for each type of resource can be defined separately, so that, for example, a user may be authorized to issue action characters for a job, but not be authorized to browse that job's data sets. Users can always access the JESSPOOL resources they own; they do not need additional authority to work with their own jobs and output.

SDSF checking authority requirements to JESSPOOL class resources:

- Action characters //, =, +, ? or Q on the DA, job data set (JDS), output descriptor (OD) and ST panels:
  No SDSF security checking is done.
- Action characters S (browse), X (print), or V (view) on the DA, I, JDS, OD, and ST panels:
  READ access to the nodeid.userid.jobname.jobid.Ddsid.dsname resource
- Action character SJ (JCLEdit) on the DA, I, JDS, OD, and ST panels:
  READ access to the nodeid.userid.jobname.jobid.JCL resource
- Action character SB (ISPFBrowse), SE (ISPFEdit) on the DA, I, JDS, OD, and ST panels:
  – READ access to the nodeid.userid.jobname.jobid.JESMSGLG resource
  – READ access to the nodeid.userid.jobname.jobid.JESYSMSG resource
- Action characters D (display) and L (list) on the DA, I, and ST panels:
  – READ access to the nodeid.userid.jobname.jobid resource
- All other action characters on the DA, I, and ST panels:
  – ALTER access to the nodeid.userid.jobname.jobid resource
- All other action characters on the JDS and OD panels:
  – ALTER access to the nodeid.userid.jobname.jobid.Ddsid.dsname resource

In the above:

- **nodeid** is the NJE node ID of the target JES subsystem.
- **userid** is the local user ID of the job owner.
- **jobname** is the name of the job.
- **jobid** is the JES job ID of the:
  – job (for jobs on DA, I, and ST)
  – job with which the data set is associated (for SYSIN or SYSOUT data sets).
- **Ddsid** is the data set ID number that identifies the job data set prefixed by the required letter D.
- **dsname** is the user-specified or system-assigned data set name.

Typically, when you define SAF authority for JESSPOOL resources, you also need to define other authorities for action characters and overtypable fields. For most action characters, a user must be authorized for jobs or job output. However, the S, V, and X action characters require authorization only for SYSIN/SYSOUT data sets. No security checking is made for the object when the ? or Q action character is used.
Some other profiles for commands generated by SDSF action characters are also required, such as:

- In the OPERCMDS class: JESx.** profiles for JES3 commands
- In the OPERCMDS class: MVS.** profiles for MVS commands

To protect resources individually in the OPERCMDS class with restrictive profiles, you would use the specific resource name for the command generated by the action character.

The group function parameters AUTH (authorized-command-list) in the ISFPARMS specification indicates which SDSF commands a member of the group is authorized to use. The values that can be included in authorized-command-list are:

- ALL, for all SDSF commands.
- ALLOPER, for all “operator” commands. The list of operator commands is the same as that for ALL, except for the omission of ABEND, INPUT and TRACE.
- ALLUSER, for all “end user” commands. The end user commands are DA, I, ST and SE.
- Any SDSF command that requires authorization, which is: ABEND, ACTION, CK, DA, DEST, ENC, FINDLIM, I, INIT, INPUT, JC, LI, LOG, MAS, NO, PR, PREF, PS, PUN, RDR, RES, RM, RSYS, SE, SO, SP, SR, ST, SYSID, SYSNAME, TRACE, and ULOG.

The IBM-supplied class descriptor table provides a resource group class (GSDSF) and a resource member class (SDSF). For a resource group class, each user or group of users permitted access to that resource group is permitted access to all members of the resource group. For each GSDSF class created, a second class representing the members must also be created.

Resource group profiles enable you to protect multiple resources with one profile. However, the resources do not have to have similar names.

A resource group profile is a general resource profile with the following special characteristics:

- Its name does not match the resource it protects.
- The ADDMEM operand of the RDEFINE command specifies the resources it protects (not the profile name itself).
- The related member class (not the resource class itself) must be RACLISTed. For example, the SDSF class must be RACLISTed, not the GSDSF class. Use the SETROPTS command with the RACLIST operand for this task.

When the SAF class a resource is in is inactive, or the profile to protect the resource is not defined, in a JES3 environment, the request fails.

Authorized SDSF commands are protected by defining resource names in the SAF SDSF class. These commands include ABEND, ACTION, CK, DA, DEST, ENC, FINDLIM, I, INPUT, JC, JESNAME parameter on SDSF command, LOG, OWNER, PR, PREFIX, PS, RES, SE, SO, SP, SR, ST, SYSID, SYSNAME, TRACE, and ULOG.

The input display shows jobs in execution or waiting on the JES input queue to be executed. A highlighted row indicates an active job.
3.3 Filtering display data

SDSF data filtering can be set either using the Filter pull-down of the action bar or filter commands.

Filter option of the action bar
The Filter pull-down of the action bar allows you to filter the data displayed on SDSF panels. SDSF displays a list of filters in a pull-down.

The choices on the filter pull-down are:

1. Filter...
2. Prefix of jobname...
3. Owner...
4. Destination...
5. System name...
6. *. Change APPC to OFF (JES2 environment only)
7. Replies on the Log...

The Filter choice of the filter pull-down displays the filter pop-up, which allows you to filter the data displayed on SDSF panels that display data in tabular format.

To select the choice, type the number of the choice or place the cursor on the choice and press Enter. Under ISPF, the values you specify are saved across sessions.

<table>
<thead>
<tr>
<th>Pop-up choice</th>
<th>Setting filtering data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td><strong>Column Oper Value</strong> are the pop-up filtering data fields</td>
</tr>
<tr>
<td></td>
<td>Type filter criteria. Type a / in the Column or Oper fields for valid prompt pop-up. Press F11/23 to clear all.</td>
</tr>
<tr>
<td></td>
<td>You can either type the column names directly or select them from a prompt pop-up.</td>
</tr>
<tr>
<td></td>
<td>You can abbreviate the column name to the shortest string of characters that uniquely identifies that column. The value field data may include * and %.</td>
</tr>
<tr>
<td>Prefix of jobname...</td>
<td>Type a prefix to limit jobs on the DA, I, PS and ST panels. The prefix string may include * and %.</td>
</tr>
<tr>
<td>Owner</td>
<td>Type an owner to limit jobs on the DA, I, PS, and ST panels. The owner string may include * and %.</td>
</tr>
<tr>
<td>Destination</td>
<td>Type up to 4 destinations to limit jobs on the ST panel following the JES rules for destination names. Only those jobs whose names match the destination are displayed.</td>
</tr>
<tr>
<td></td>
<td>To delete a destination, simply blank it out. Blank out all destinations on the pop-up to display jobs for all destinations, or for the destinations named filter criteria in the IDEST parameter of ISFPARMS if one is coded.</td>
</tr>
<tr>
<td>System name...</td>
<td>Type a system name or leave blank for the system you are logged on to. The system name string may include * and %.</td>
</tr>
<tr>
<td>Replies on the Log...</td>
<td>Type a system name to limit WTORs on the Log panels. Leave blank for the system you are logged on to. The system name string may include * and %.</td>
</tr>
</tbody>
</table>
Filter commands
Filter commands filter data on the SDSF panels. Under ISPF, filters are saved (one set for each JES type).

- The FILTER command format is shown in Example 3-1.

**Example 3-1  FILTER command format**

```
FILTER ON | OFF | OR | AND | (+|-)column (operator) value | ?
```

- **OFF** turns filtering off but retains filter criteria.
- **ON** turns filtering on.
- **OR** and **AND** specify the relationship between filters both within a column and between columns.
- **(+|-)column** names a column for filtering and turns filtering on. Column name can be abbreviated to the shortest unique name.
  - **+** adds the filter to any previous filters. There is a limit of 25 filters under ISPF, but no limit with isffilter under REXX. When you use this with isffilter, you must specify an operator.
  - **-** discards all filters for the column. (ISPF only)
- **operator** is one of the following:
  - **EQ** or **=** Equal (the default)
  - **NE** or **¬=** Not equal
  - **LT** or **<** Less than
  - **GT** or **>** Greater than
  - **LE** or **<=** Less than or equal
  - **GE** or **>=** Greater than or equal
- **value** is the value to be used for comparison. Value can contain pattern matching characters. If it includes embedded blanks, enclose it in quotation marks.
- **?** displays filters and their current state. Under ISPF, it displays the Filter pop-up.

Use pattern matching characters ( * and % by default) for an inexact or partial match. For example:

- FILTER JOBNAME EQ %A* matches jobs with a name that has A in the second position.

You can change the pattern matching characters with the SET SCHARS command.

- The ACTION command controls the display of Write-To-Operator-with-Reply (WTOR) messages on the log by specifying which WTOR messages are displayed at the bottom of the Log panel. You must be authorized to use this command. ACTION may be used on any SDSF panel. The ACTION command format is shown in Example 3-2.

**Example 3-2  ACTION command format**

```
ACTION routing-code-list | ?
```

- **routing-code-list** is up to four routing codes separated by blanks (1-28)
  - **MVS** is all routing codes reserved for MVS (1-12).
  - **USER** is all routing codes reserved for customer use (13-28).
  - **ALL** requests the display of WTORs for all routing codes.
  - **OFF** requests the display of no WTORs. This is the default.
  - ? displays the current setting for ACTION on the message line.
- Use up to 4 parameters. The routing-code-list, MVS, and USER parameters may be combined. ACTION commands are cumulative.

- The DEST command limits jobs to be selected for display by destination. You must be authorized for the command and for the destination. The DEST command may be used on
any panel. It affects only the ST panel. The DEST command format is shown in Example 3-3.

Example 3-3  DEST command format

```
DEST (+ or -) (destination-names) | ?
+ add-destination-names
- delete-destination-names
destination-names are destination names of up to 18 characters. Enter up to 4 destination names.
? displays the current setting on the command line or pop-up.
```

The OWNER command limits jobs selected for display by owner ID. You must be authorized to use this command. OWNER may be used on any SDSF panel but affects only the DA, I, PS, and ST panels. The OWNER command format is shown in Example 3-4.

Example 3-4  OWNER command format

```
OWNER ownerid|?
ownerid is the owning user ID of the job, or the netmail ID. It can be up to 8 characters including * (any string of characters) or % (any single character).
? displays the current setting on the command line or pop-up.
OWNER with no parameters displays all jobs.
```

The PREFIX command limits jobs selected for display by job name or netmail ID. This command may be used on any SDSF panel, but affects only the DA, I, PS, and ST panels. The PREFIX command format is shown in Example 3-5.

Example 3-5  PREFIX command format

```
PREFIX string | ?
string is the name of the job, up to 8 characters, including * (any string of characters) or % (any single character).
? displays the current setting on the command line or pop-up.
PREFIX with no parameters displays all jobs, except on the Held Output Queue panel, where it displays all jobs with names that begin with your user ID.
```

The RSYS command limits WTORs displayed at the bottom of the Log panels. You must be authorized for this command. This command may be used on any SDSF panel, but affects only the Syslog and Operlog panels. The RSYS command format is shown in Example 3-6.

Example 3-6  RSYS command format

```
RSYS system-name|?
system-name is the MVS system name, up to 8 characters, including * (any string of characters) or % (any single character).
? displays the current setting on the command line or pop-up.
RSYS with no parameters displays only WTORs from the system you are logged on to.
```

The SYSNAME command specifies the systems in the sysplex that are included on the CK, DA, ENC, and PS panels. You must be authorized to use this command. The SYSNAME command may be used on any SDSF panel. This command format is shown in Example 3-7 on page 36.
Example 3-7  SYSNAME command format

SYSNAME system-name|?

- **system-name** is the MVS system name, up to 8 characters, including * (any string of characters) or % (any single character).
- ? displays the current setting on the command line or pop-up.
- SYSNAME with no parameters displays only data for the system you are logged on to.

- The SELECT command temporarily limits the jobs (rows) displayed on tabular panels. This command only lasts until you exit the panel or issue another SELECT with no parameters. The SELECT command may be used on any tabular panel. The SELECT command format is shown in Example 3-8.

Example 3-8  SELECT command format

SELECT | S (selection-criteria)

- SELECT with no parameters removes any filtering done with SELECT.
- **selection-criteria** specifies the rows to be selected. The selection criteria varies depending on the current panel.

Queue panels (DA and ST):

- **jobname** {jobid}. The jobid is the job number. You do not need leading zeros.
- **job number**. You do not need to type leading zeros.

On these panels, SELECT overrides other filters (parameters on panel commands, FILTER, and, if you are authorized, PREFIX, OWNER and DEST. For DEST, you must also be authorized to the destination).

JDS panel:

- **ddname** {stepname}
- **dsid**

CK panel:

- **checkname** {checkowner}

You may use special characters (* and %) except with jobid.

Example 3-9  SET TIMEOUT command format

SET TIMEOUT timeout-value| ?

- **timeout-value** specifies the default timeout value (in seconds). The timeout value must be in the range of 0 to 9999, where 0 indicates that SDSF does not wait, that is, the sysplex support for device panels is disabled. When the sysplex support is disabled, the device panels show only the devices for the system you are logged on to.
- ? displays the current setting on the command line or pop-up.

SET TIMEOUT with no parameters results in the timeout value specified in ISFPARMS.

- The sysplex-wide DA panel requires RMF in a JES3 environment. Some of the values on the DA panel, such as CPU% and SIO, are approximate. For detailed and precise performance monitoring, use RMF.
3.4 View alternate form of a tabular SDSF panel

The ? command (not NP field action) displays the alternate form of a tabular panel. You may need to scroll right to see the alternate fields.

The action bar View pull-down choice 4. “Change field list to ALTERNATE” acts as a toggle to display the primary or alternate fields on SDSF tabular display panels.

3.5 Input queue (I) panel

The input queue panel displays information about jobs that are on the JES input queue or that are executing.

The input display is accessed with the I command from any SDSF panel. The format of the INPUT command is shown in Example 3-10.

Example 3-10   INPUT display format

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Displays only held jobs.</td>
</tr>
<tr>
<td>NH</td>
<td>Displays only jobs that are not held.</td>
</tr>
</tbody>
</table>

Input queue panel fields

The input queue panel may include the following fields. (The order and titles may be different, depending on installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBNAME</td>
<td>Jobname of the address space</td>
</tr>
<tr>
<td>JobID</td>
<td>JES job ID, or work ID</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>JNum</td>
<td>JES job number</td>
</tr>
<tr>
<td>Owner</td>
<td>User ID of job creator</td>
</tr>
<tr>
<td>Prty</td>
<td>JES input queue priority</td>
</tr>
<tr>
<td>C</td>
<td>JES input class</td>
</tr>
<tr>
<td>Pos</td>
<td>Position in the JES input queue</td>
</tr>
<tr>
<td>PrtDest</td>
<td>JES print destination name or default print routing</td>
</tr>
<tr>
<td>SAff</td>
<td>JES execution system affinity (if any)</td>
</tr>
<tr>
<td>ASys</td>
<td>JES execution system ID</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
</tr>
<tr>
<td>SecLabel</td>
<td>Security label of job</td>
</tr>
<tr>
<td>OrigNode</td>
<td>Origin node name</td>
</tr>
<tr>
<td>ExecNode</td>
<td>Execution node name</td>
</tr>
<tr>
<td>Device</td>
<td>Device or JES processor name</td>
</tr>
<tr>
<td>PhaseName</td>
<td>Name of the job phase</td>
</tr>
<tr>
<td>Phase</td>
<td>Number of the job phase</td>
</tr>
<tr>
<td>SrvClass</td>
<td>Service class</td>
</tr>
<tr>
<td>Dly</td>
<td>Indicator that job processing is being delayed.</td>
</tr>
<tr>
<td>Use the I action character for details.</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>Subsystem managing the job (WLM or JES)</td>
</tr>
</tbody>
</table>

The following columns have delayed access (except Spin).

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WPos</td>
<td>Position in the WLM queue</td>
</tr>
<tr>
<td>Scheduling-Env</td>
<td>Scheduling environment for the job</td>
</tr>
<tr>
<td>RNum</td>
<td>Room number on job card</td>
</tr>
<tr>
<td>Programmer-Name</td>
<td>Programmer name</td>
</tr>
<tr>
<td>Acct</td>
<td>Account number</td>
</tr>
<tr>
<td>Notify</td>
<td>TSO user ID from the NOTIFY parameter</td>
</tr>
<tr>
<td>ISys</td>
<td>JES input system ID</td>
</tr>
<tr>
<td>Rd-Time</td>
<td>Time the job was read in</td>
</tr>
<tr>
<td>Rd-Date</td>
<td>Date the job was read in</td>
</tr>
<tr>
<td>ESys</td>
<td>JES execution system ID</td>
</tr>
<tr>
<td>St-Time</td>
<td>Time execution began</td>
</tr>
<tr>
<td>St-Date</td>
<td>Date execution began</td>
</tr>
<tr>
<td>Cards</td>
<td>Number of cards read for the job</td>
</tr>
<tr>
<td>MC</td>
<td>MSGCLASS of the job</td>
</tr>
<tr>
<td>SubGroup</td>
<td>Submittor group</td>
</tr>
<tr>
<td>Tot-Lines</td>
<td>Total number of spool records for job</td>
</tr>
<tr>
<td>Spin</td>
<td>Indicator that jobs in the class can be spun</td>
</tr>
</tbody>
</table>

Figure 3-1 on page 39 shows a snippet of an SDSF input queue PRIMARY field list display.
The action bar View pull-down choice 4. “Change field list to ALTERNATE” acts as a toggle to display the primary or alternate fields on SDSF panels that display information in tabular format. To select the choice, type the number of the choice or place the cursor on the choice and press Enter.

The ? command also displays the alternate form of a tabular panel.

Figure 3-2 displays some fields on the SDSF input queue ALTERNATE field list.

To get back to the input queue PRIMARY field list display, redo the action bar View pull-down choice 4. “Change field list to PRIMARY”.

The SDSF input queue definition for JES3 does not include any overtype fields.
In Figure 3-1 on page 39, the action bar Options pull-down selection, 1. “Set action character display...”, has been used to set the display of “action characters on with descriptions”. Also, the action bar View pull-down selection, 2. “Arrange...”, has been used to move the Status column after the Owner column.

**ULOG**

Figure 3-3 shows an example of the JES3 commands response displayed when ULOG is active. The response overlays the top display data on the panel.

The ULOG command has been entered on the COMMAND INPUT ===> field. The User Session Log (ULOG) panel allows authorized users to display MVS and JES commands and responses issued during the SDSF session. The ULOG shows commands generated by SDSF and SAF. SDSF deletes the user session log when an SDSF session is ended or when the ULOG CLOSE command is issued.

SDSF uses MVS MCS console services to acquire an extended console for the ULOG. The action bar Options pull-down choice, 9. “Set console name...”, displays a pop-up that allows you to set the name of the extended console used by SDSF, which is used by the ULOG panel. Instead of the pop-up, the SET CONSOLE name command may be issued to set the extended console name.

**Example 3-11 ULOG command format**

```
{U|U} [CLOSE]
```

CLOSE deletes all entries in the user session log and deactivates the extended console.

ULOG with no parameters displays the ULOG panel. An extended console is activated if one is not already active.

When the ULOG is active, the output of the JES or MVS operator commands issued for actions is displayed on the current panel.

![Figure 3-3 JES3 command ULOG response for a DX action on the I panel](image-url)
### Input queue panel NP field actions

The following lists actions available on the SDSF input queue display:

<table>
<thead>
<tr>
<th>NP-Description</th>
<th>JES3 command / SDSF action</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Extend</td>
</tr>
<tr>
<td></td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td>Block repeat; type // on the first row and another // on the last row to be processed. The action to be repeated should be typed once after the // characters.</td>
</tr>
<tr>
<td>?-JDS</td>
<td>SDSF job data set display</td>
</tr>
<tr>
<td>=-Repeat</td>
<td>Repeat previous action character or overtype</td>
</tr>
<tr>
<td>A-Release</td>
<td>*F J=jobno,R - Release a held job</td>
</tr>
<tr>
<td>C-Cancel</td>
<td>*F J=jobno,CO - Cancel a job and process output data sets</td>
</tr>
<tr>
<td>CA-CancelARM</td>
<td>*F J=jobno,C,ARMR - Cancel a job that is defined to Automatic Restart Manager (ARM).</td>
</tr>
<tr>
<td>CD-CancelDump</td>
<td>*F J=jobno,C,D - Cancel a job and take a dump</td>
</tr>
<tr>
<td>CDA-CancelARMDump</td>
<td>*F J=jobno,C,D,ARMR - Cancel a job that is defined to ARM, and take a dump.</td>
</tr>
<tr>
<td>CP-CancelPrint</td>
<td>*F J=jobno,CP - Cancel a job and print data sets ready for printing</td>
</tr>
<tr>
<td>D-Display</td>
<td>*I J=jobno - Display job information in the log</td>
</tr>
<tr>
<td>DE-DisplayEstimates</td>
<td>*I J=jobno,E</td>
</tr>
<tr>
<td>DL-DisplayLong</td>
<td>*X DISPLAY,J=jobno</td>
</tr>
<tr>
<td>DM-DisplayMains</td>
<td>*I J=jobno,M</td>
</tr>
<tr>
<td>DMA-DisplayMDSAlloc</td>
<td>*I S,A,J=jobno</td>
</tr>
<tr>
<td>DME-DisplayMDSerror</td>
<td>*I S,E,J=jobno</td>
</tr>
<tr>
<td>DMR-DisplayMDSRestart</td>
<td>*I S,R,J=jobno</td>
</tr>
<tr>
<td>DMSS-DisplayMDSysSel</td>
<td>*I S,SS,J=jobno</td>
</tr>
<tr>
<td>DMSV-DisplayMDSysVer</td>
<td>*I S,SV,J=jobno</td>
</tr>
<tr>
<td>DMU-DisplayUnavailVol</td>
<td>*I S,U,J=jobno</td>
</tr>
<tr>
<td>DSD-DisplayDDnames</td>
<td>*I J=jobno,SD</td>
</tr>
<tr>
<td>DSH-DisplaySpoolHold</td>
<td>*I J=jobno,SH</td>
</tr>
<tr>
<td>DSP-DisplaySpoolPartition</td>
<td>*I J=jobno,SP</td>
</tr>
<tr>
<td>DX-DisplayExtended</td>
<td>*I J=jobno,X</td>
</tr>
<tr>
<td>E-Restart</td>
<td>*R main,jobno</td>
</tr>
<tr>
<td>H-Hold</td>
<td>*F J=jobno,H</td>
</tr>
<tr>
<td>I-Info</td>
<td>SDSF job information pop-up (See Figure 3-4 on page 42)</td>
</tr>
<tr>
<td>J-Start</td>
<td>*F J=jobno,RUN</td>
</tr>
<tr>
<td>L-List</td>
<td>*I U,Q=WTR,J=jobno</td>
</tr>
<tr>
<td>LB-ListBDT</td>
<td>*I U,Q=BDT,J=jobno</td>
</tr>
<tr>
<td>LH-ListHold</td>
<td>*I U,Q=HOLD,J=jobno</td>
</tr>
<tr>
<td>LT-ListTCP</td>
<td>*I U,Q=TCP,J=jobno</td>
</tr>
<tr>
<td>P-Purge</td>
<td>*F J=jobno,C</td>
</tr>
<tr>
<td>Q-OutDesc</td>
<td>SDSF output descriptor display</td>
</tr>
<tr>
<td>S-Browse</td>
<td>SDSF browse of the selected job's spool data set data</td>
</tr>
<tr>
<td>SB-ISPFBrowse</td>
<td>ISPF browse of the selected job's spool data set data</td>
</tr>
<tr>
<td>SE-ISPFEdit</td>
<td>ISPF edit of the selected job's spool data set data</td>
</tr>
<tr>
<td>SJ-JCLEdit</td>
<td>ISPF edit of the selected job's JCL</td>
</tr>
<tr>
<td>W-Spin</td>
<td>*F J=jobno,SPIN</td>
</tr>
<tr>
<td>X-Print</td>
<td>Print the selected job's spool data</td>
</tr>
<tr>
<td>XC-PrintClose</td>
<td>Close print</td>
</tr>
<tr>
<td>XD-PrintDS</td>
<td>SDSF open print data set and print selected spool data</td>
</tr>
<tr>
<td>XDC-PrintDSClose</td>
<td>Open, print spool data and close print data set</td>
</tr>
<tr>
<td>XF-PrintFile</td>
<td>Print the selected job's spool data using DD-name</td>
</tr>
<tr>
<td>XFC-PrintFileClose</td>
<td>Print the selected spool data using DD-name and close</td>
</tr>
<tr>
<td>XS-PrintSysout</td>
<td>SDSF open SYSOUT data set and print selected data</td>
</tr>
<tr>
<td>XSC-PrintSysoutClose</td>
<td>Open SYSOUT, print selected data and close SYSOUT</td>
</tr>
</tbody>
</table>

The list is in ascending sort order by NP field.

The JES3 commands and command responses resulting from actions are recorded in the hardcopy log.
Figure 3-4 displays the Job Information panel when action character I (info) is entered for a row on the DA panel.

**Input queue display action example**

Figure 3-1 on page 39 displays status HOLD for jobs VAINI1 to VAINI5. The response for action D for job VAINI1 is shown in Example 3-12.

**Example 3-12  Action D response**

```
IAT8674 JOB VAINI1 (JOB13689) P=01 CL=A NET=NET HOLD=(OP) CI
IAT8699 INQUIRY ON JOB STATUS COMPLETE, 1 JOB DISPLAYED
```

Job VAINI1 is in operator hold and can be released with an A action.

The response for action D for job VAINI2 is shown in Example 3-13.

**Example 3-13  Action D response**

```
IAT8674 JOB VAINI2 (JOB13690) P=01 CL=A NET=NET HOLD=(N) CI(RESCHEDULED)
IAT8699 INQUIRY ON JOB STATUS COMPLETE, 1 JOB DISPLAYED
```

The responses indicate that both jobs are also in a JES3 DJC net. SDSF for JES3 does not provide DJC net panels. The response from the JES3 inquiry COMMAND_INPUT ===> /*I,N,ID=NET is shown in Example 3-14.

**Example 3-14  /*I,N,ID=NET response**

```
IAT8578 NET-ID=NET TOT=0000005 COMP=0000000 PEND=0000000 MISSC=N DATE= 04/13/2009
TIME= 16:15:15
```
JES3 message IAT8578 indicates that in the DJC net-id=NET are five jobs. The slash command /I,N,ID=NET,LIST response shows all jobs in the DJC net, as shown in Example 3-15.

Example 3-15 /I,N,ID=NET,LIST response

<table>
<thead>
<tr>
<th>IAT8580</th>
<th>NET-ID</th>
<th>JOB NAME</th>
<th>JOB NUM</th>
<th>NHOLD CT</th>
<th>SUCCESSR</th>
<th>REL/SCH</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAT8581</td>
<td>NET</td>
<td>VAIN1</td>
<td>JOB13689</td>
<td>00000000</td>
<td>000004</td>
<td>000000</td>
<td>E</td>
</tr>
<tr>
<td>IAT8581</td>
<td>NET</td>
<td>VAIN2</td>
<td>JOB13690</td>
<td>00000000</td>
<td>000000</td>
<td>000000</td>
<td>H</td>
</tr>
<tr>
<td>IAT8581</td>
<td>NET</td>
<td>VAIN3</td>
<td>JOB13691</td>
<td>00000001</td>
<td>000000</td>
<td>000000</td>
<td>H</td>
</tr>
<tr>
<td>IAT8581</td>
<td>NET</td>
<td>VAIN4</td>
<td>JOB13692</td>
<td>00000000</td>
<td>000000</td>
<td>000000</td>
<td>H</td>
</tr>
<tr>
<td>IAT8581</td>
<td>NET</td>
<td>VAIN5</td>
<td>JOB13693</td>
<td>00000000</td>
<td>000000</td>
<td>000000</td>
<td>H</td>
</tr>
</tbody>
</table>

SDSF messages

SDSF displays messages on the panel line above the COMMAND INPUT ===> line. In Figure 3-5, the INVALID COMMAND response is displayed on the right of the screen above the COMMAND INPUT line.

Each SDSF message has a help panel you can display to see an explanation and response to the message. Information about displaying the message helps is included on SDSF help panels. To display help for a message with no message number, type the initial letter of the message. For example, for help on the message ACTIVE MODIFY INVALID, type the letter A.

You can also search in online documents using the BOOK command (see the online help for more information). When the cursor is in the message area, BOOK uses the message text as a search string.

SDSF does not use the ISPF message services.

3.6 Status (ST) panel

The status panel allows authorized users to display information about jobs, started tasks, and TSO users on the JES queues.

Figure 3-6 on page 44 shows an example of an SDSF status display for some JES3 jobs. In the figure, the Status field has been moved (arranged) after C (class) and ASys after Status.

In this example, the select command (S R* 13456) issued on the ST panel limits the output of the display to jobs whose JOBNAME starts with the letter R and whose JOBID equals 13456. A select command with no parameters returns the display to the original display.

The action character display is in short format.
**Figure 3-6 Status (ST) panel**

### Status panel fields

- **JOBNAME**: Job name
- **JNum**: JES job number
- **JobID**: JES job ID
- **Owner**: User ID of job owner
- **Prty**: JES job queue priority
- **Queue**: JES queue name for job
- **C**: JES input class
- **SAff**: JES execution system affinity (if any)
- **ASys**: JES active system ID (if job active)
- **Status**: Status of job
- **PrtDest**: JES print destination name
- **SecLabel**: Security label of job
- **OrigNode**: Origin node name
- **ExecNode**: Execution node name
- **Device**: JES device name
- **Max-RC**: Return code information for the job
- **SrvClass**: Service class
- **WPos**: Position on the WLM queue
- **Scheduling-Env**: Scheduling environment for the job
- **Dly**: Indicator that job processing is delayed
- **Mode**: Subsystem managing the job (JES or WLM)
- **Spin**: Indicator of whether the job is eligible to be spun
- **Phase**: Name of the phase the job is in
- **PhaseNum**: Number of the phase the job is in

The following columns have delayed access:

- **Pos**: Position in JES queue
- **RNum**: JES job room number
- **Programmer-Name**: JES programmer name
- **Acct**: JES account number
- **Notify**: TSO user ID from NOTIFY parameter on job card
- **ISys**: JES input system ID
- **Rd-Time**: Time that the job was read in
- **Rd-Date**: Date that the job was read in
3.7 Viewing jobs’ spool data

To view output formatted for a line-mode device, you can use the S action character, or, to invoke ISPF Browse or Edit, the SB, SE, or SJ action characters on I, ST, and DA panels. The SDSF Output Data Set panel is used to view data for action code S.

NP field action S - SDSF browse
When used to view a job's spool data, the displayed data includes the JES job log, JCL for the job, and any job-related messages.

The INPUT {ON|OFF} command specifies whether jobs' input data sets are to be included when you view jobs from the DA, ST, or I panels. You must be authorized to use this command. The action bar Options pull-down choice 3 can be used to toggle between input ON or OFF.

The SET HEX {ON|OFF} command controls display in hexadecimal for this session. The action bar View pull-down choice 3 “Set hex to ON|OFF” may be used instead of the SET HEX command to control display in hexadecimal.

The SDSF browse does not support the ISPF type labels for data lines and the ISPF picture string find commands.

NP field action V - GDDM browse
To view output formatted for a page printer, you can use the V action character on the job data set display panel. The V action character requires GDDM. If GDDM is not available or if the data to be viewed is not formatted for a page printer, the spool data set display is formatted for a line-mode printer.

Page-mode output may be indicated by the following on the Job Data Set panel: a value of PAGE in the PRMODE field, and a value other than blanks in the PAGE-CNT field.

NP field action SB - ISPF browse
The ISPF browse is invoked with the SB action character. ISPF browse ignores the SDSF SET HEX setting. To display data in hexadecimal, use the ISPF HEX primary command. Labels and picture find commands are available.
When the ISPF browse is active, SDSF commands are not available. To use SDSF commands (such as / or PRINT) you must access SDSF’s browse with the S action character.

**NP field actions SE and SJ - ISPF Edit**

To display the job’s output with ISPF Edit, use SE. To display just the JCL for the job, use SJ. You can change and resubmit the JCL from the display; changes you make to the data are not saved.

The SET BROWSE command controls the default browse action character (S, SB, or SE) that is issued when you place the cursor in the NP column and press Enter.

Figure 3-7 shows an example of the SDSF job output browse display.

![Sample SDSF browse (S) display](image)

**NP field action ? on I, ST, and DA panels - Job Data Set panel**

The Job Data Set panel allows authorized users to list and display information about the SYSOUT data sets for a job, started task, or TSO user. The Job Data Set panel is accessed with the ? action character.
Figure 3-8 shows an example of the SDSF job data set panel. INPUT ON is set. SDSF displays the type of the spool data sets.

<table>
<thead>
<tr>
<th>JDS panel fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>DDNAME</td>
</tr>
<tr>
<td>StepName</td>
</tr>
<tr>
<td>ProcStep</td>
</tr>
<tr>
<td>DsID</td>
</tr>
<tr>
<td>Owner</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>Dest</td>
</tr>
<tr>
<td>Rec-Cnt</td>
</tr>
<tr>
<td>Page-Cnt</td>
</tr>
<tr>
<td>Byte-Cnt</td>
</tr>
<tr>
<td>CC</td>
</tr>
<tr>
<td>SecLabel</td>
</tr>
<tr>
<td>PrrMode</td>
</tr>
<tr>
<td>Burst</td>
</tr>
<tr>
<td>Create-Date-Time</td>
</tr>
<tr>
<td>Forms</td>
</tr>
<tr>
<td>FCB</td>
</tr>
<tr>
<td>UCS</td>
</tr>
<tr>
<td>Wtr</td>
</tr>
<tr>
<td>Flash</td>
</tr>
<tr>
<td>FlashC</td>
</tr>
<tr>
<td>SegID</td>
</tr>
<tr>
<td>DSName</td>
</tr>
<tr>
<td>Chars</td>
</tr>
<tr>
<td>CpyMod</td>
</tr>
<tr>
<td>PageDef</td>
</tr>
<tr>
<td>FormDef</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Building</td>
</tr>
<tr>
<td>Department</td>
</tr>
</tbody>
</table>
**JDS panel NP field action characters**

Action characters that can be entered in the NP column by authorized users are:

- **//** Block repeat
- **=** Repeat previous action character or overtype
- **+** Expand the NP column. (Use RESET to reset.)
- **C** Purge an output data set.
- **H** Hold an output data set.
- **O** Release an output data set.
- **P** Purge an output data set.
- **Q** Display output descriptors for the data set.
- **S** Display line-mode data set or data sets. Other forms: SB (ISPF Browse), SE (ISPF Edit), SJ (Edit JCL)
- **V** View a job's page-mode data sets using GDDM.
- **X** Print output data sets. You can add the following:
  - **C** - Close the print file after printing (XC)
  - **D** - Display the Open Print Data Set panel (XD or XDC)
  - **F** - Display the Open Print File panel (XF or XFC)
  - **S** - Display the Open Print panel (XS or XSC)

**JES3 commands for actions**

- **C** 
  ```
  *F U,J=jobno,DD=ddn,C
  ```
- **H** 
  ```
  *F U,Q=WTR,DD=ddn,NQ=HOLD
  ```
- **O** 
  ```
  *F U,Q=HOLD,DD=ddn,NQ=WTR
  ```
- **P** 
  ```
  *F U,Q={WTR|HOLD},J=jobno,DD=ddn,C
  ```

To re-edit a job's JCL, the SJ action can be entered on any line on the job data set display panel, as shown in Figure 3-9.

![Figure 3-9 SDSF JCL edit - SJ action](image)

**NP field action Q on I, JDS, ST, and DA panels - Output Descriptors Panel**

The Output Descriptors Panel (OD) allows authorized users to display JES output descriptors. Output descriptors provide information about a SYSOUT data set, for example, an address or a building. The output descriptors display is accessed with the **Q** action character.
Figure 3-10 is an example of the SDSF Output Descriptors panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDNAME</td>
<td>Ddname of the data set</td>
</tr>
<tr>
<td>Output-Descriptors</td>
<td>Output descriptor for the data set</td>
</tr>
<tr>
<td>PageDef</td>
<td>Library member used by PSF to specify print characteristics such as page length and width</td>
</tr>
<tr>
<td>FormDef</td>
<td>Library member used by PSF to specify print characteristics such as overlays</td>
</tr>
<tr>
<td>Title</td>
<td>Title of output</td>
</tr>
<tr>
<td>Name</td>
<td>Output name</td>
</tr>
<tr>
<td>Building</td>
<td>Output building</td>
</tr>
<tr>
<td>Department</td>
<td>Output department</td>
</tr>
<tr>
<td>Room</td>
<td>Output room</td>
</tr>
<tr>
<td>Address</td>
<td>Output address lines 1 through 4</td>
</tr>
<tr>
<td>OutBin</td>
<td>Output bin</td>
</tr>
<tr>
<td>ComSetup</td>
<td>Printer setup options</td>
</tr>
<tr>
<td>FormLen</td>
<td>Form length</td>
</tr>
<tr>
<td>ColorMap</td>
<td>AFP resource for the data set containing color translation information</td>
</tr>
<tr>
<td>InTray</td>
<td>Paper source</td>
</tr>
<tr>
<td>OverlayB</td>
<td>Overlay for the back of each sheet</td>
</tr>
<tr>
<td>OverlayF</td>
<td>Overlay for the front of each sheet</td>
</tr>
<tr>
<td>OffsetXB</td>
<td>Offset in the x direction from the page origin for the back of each page</td>
</tr>
<tr>
<td>OffsetXF</td>
<td>Offset in the x direction from the page origin for the front of each page</td>
</tr>
</tbody>
</table>

Output descriptor fields can be overtyped if the output descriptors panel was accessed from the DA, I or ST panels. The data set must be closed.

**OD panel fields**

The Output Descriptors panel includes some or all of the following fields. Their order and titles may be different, depending upon installation and user options.
OffsetYB
Offset in the y direction from the page origin for the back of each page

OffsetYF
Offset in the y direction from the page origin for the front of each page

PortNo
Number of the TCP/IP port where the FSS connects to the printer

Notify
Print completion notification for 1 to 4 IDs

UserLib
User resource (AFP) libraries to be used by PSF

RetainS
Retain time for successful transmissions (hh:mm:ss)

RetainF
Retain time for unsuccessful attempts (hh:mm:ss)

RetryL
Maximum number of retries

RetryT
Time between retries (hh:mm:ss)

PrtOptns
Entry in the PrintWay™ options data set

PrtQueue
Print queue name

IP Destination
IP address or TCP/IP name (for example, node.IP:1.2.333.444.5, IP:1.2.333.444.5, or any other valid DEST syntax)

UserData
User data

AFPParms
Data set containing parameters used by the AFP Print Distributor

**OD panel NP field action characters**

Action characters that can be entered in the NP column by authorized users are listed here. Type action characters on lines with ddnames.

- **E**  Erase an output descriptor. E is valid only when the Output Descriptors panel was accessed from the job data set panel if it was accessed from the Output Queue panel or the Held Output Queue panel.

- **S**  Display line-mode data sets. (Access the Output Data Set panel.) Alternatives: SB - Use ISPF Browse and SE - Use ISPF Edit.

- **V**  View page-mode data sets using GDDM.

- **X**  Print output data sets. You can add the following:
  - **C** - Close the print file after printing (XC)
  - **D** - Display the Open Print Data Set panel (XD or XDC)
  - **F** - Display the Open Print File panel (XF or XFC)
  - **S** - Display the Open Print panel (XS or XSC)

- **?**  Display a list of data sets (access the Job Data Set panel).

### 3.8 JESPLEX (JP) panel

The JESPLEX (JP) panel allows authorized users to display and control the main processors in a JES3 complex.

Figure 3-11 shows a JESPLEX panel for a three main processor JES3 complex on an 80-byte line length screen. The ConnState field has been arranged after the NAME field. The C (command character) field has been shortened (ARR C 1) to one byte to fit more visible fields on the display lines. (The ARRANGE command reorders and changes the widths of columns on the current panel.)
The title line of the JESPLEX panel displays the information shown in Example 3-16.

**Example 3-16  JESPLEX title line**

<table>
<thead>
<tr>
<th>SDSF</th>
<th>JP</th>
<th>DISPLAY</th>
<th>SC75</th>
<th>WTSC75J3</th>
<th>45%</th>
<th>SPOOL</th>
<th>LINE</th>
<th>1-3</th>
<th>(3)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main</td>
<td>the</td>
<td>XCF group</td>
<td>Spool</td>
<td>utilization,</td>
<td>as a percentage</td>
<td>of the spool in use</td>
<td>Lines</td>
<td>displayed</td>
<td></td>
</tr>
<tr>
<td>user</td>
<td>is</td>
<td>name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>logged</td>
<td>on</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**JESPLEX panel fields**

The JESPLEX panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
</table>
| NAME       | Member name. The names of undefined systems have a leading *.
| Status     | Status of the member                                                        |
| SID        | System ID number                                                            |
| SysName    | System name of the MVS image on which this JES system is active             |
| Version    | Version of JES the member is running                                        |
| C          | Command character                                                           |
| JESN       | JES subsystem name                                                           |
| SLevel     | JES3 service level                                                           |
| Global     | JES3 global indicator                                                       |
| Start-Type | Last start type for the member                                              |
| Start-Date-Time | Date and time the member was started                                      |
| LastGCon-Date-Time | Last time global was contacted                                               |
| PrimTG     | Primary track group allocation                                              |
| SecTG      | Secondary track group allocation                                            |
| WTOLim     | WTO message limit                                                            |
| WTOInt     | WTO message interval                                                         |
| PBufCSA    | PBUF CSA limit                                                               |
| PBufAux    | PBUF JES3AUX                                                                 |
| PBuffixed  | Fixed PBUFS                                                                  |
| UserPages  | User pages per open SYSOUT dataset                                          |
| SelectModeName | Selection mode name                                                        |
| PartName   | Spool partition name                                                         |
| MsgPrefix  | Message prefix                                                               |
| MsgDest    | Message Destination                                                         |
| ConnStat   | Connect status                                                               |
| AttStat    | Attach status                                                                |

The following fields can be overtyped by authorized users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>JES3 Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartName</td>
<td>Spool partition name</td>
<td>*F G,main,SP,partname</td>
</tr>
<tr>
<td>SelectModeName</td>
<td>Selection mode name</td>
<td>*F G,main,SELECT,MODE,modename</td>
</tr>
</tbody>
</table>

**JESPLEX panel NP field actions**

Action characters that can be entered in the NP column by authorized users:

- + Extend
- // Block
- *=Repeat
- C-Connect          | *S main,CONNECT         |
- D-Display           | *I MAIN=main             |
- DL-DisplayLong      | *I MAIN=main,X           |
- F-Flush             | *S main,FLUSH            |
Using SDSF in a JES3 Environment

3.9 Job Class (JC) panel

The Job Class (JC) panel allows authorized users to display and control the job classes in the JES3 JESPLEX. Both JES- and WLM-managed classes are shown.

The job class display is invoked with the JC[one_class] command. (In the JC command there is no spaces allowed between the JC and the one_class parameter.) The job class panel in Figure 3-12 on page 52 was invoked with the command JCA and shows some of the job class panel fields for class A.

![Figure 3-12 Job Class (JC) panel](image)

The title line of the Job Class panel displays the information shown in Example 3-17.

<table>
<thead>
<tr>
<th>SDSF JOB CLASS DISPLAY CLASS A</th>
<th>LINE 1-3 (3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND INPUT ===&gt;</td>
<td>SCROLL ===&gt; HALF</td>
</tr>
<tr>
<td>ACTION=-Block,-Repeat,--Extend,D-Display,DC-DisplayClass,DG-DisplayGroup,ST-Status</td>
<td></td>
</tr>
<tr>
<td>NP</td>
<td>CLASS</td>
</tr>
<tr>
<td>A</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>A</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>A</td>
<td>ACTIVE</td>
</tr>
</tbody>
</table>

**Example 3-17 Job Class panel title line**

<table>
<thead>
<tr>
<th>SDSF JOB CLASS DISPLAY CLASS A</th>
<th>LINE 1-20 (20)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JES3 job classes</td>
<td>Lines on being displayed</td>
</tr>
</tbody>
</table>

**Job class panel NP field actions**

Action characters that can be entered in the NP column by authorized users are:

- `//` Block repeat; `//action` on the first row and another `//` on the last row
- `=` Repeat previous action character or overtype.
- `+` Expand the NP column. (Use RESET to reset.)
- `D` Display information about a job class in the logs and ULOG.
- `DC` Display status for the class in the logs and ULOG (JES3 only).
- `DG` Display status for the group in the logs and ULOG (JES3 only).
- `ST` Display the ST panel for all jobs in the class.

**JES3 commands for the action characters:**

<table>
<thead>
<tr>
<th>Action</th>
<th>JES3 Command</th>
</tr>
</thead>
</table>
**Job Class panel fields**

The Job Class panel may include the following fields. (The order and titles may be different, depending on installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLASS</td>
<td>Job class</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the job class</td>
</tr>
<tr>
<td>Member</td>
<td>Member name</td>
</tr>
<tr>
<td>Group</td>
<td>Group name</td>
</tr>
<tr>
<td>Mode</td>
<td>Manager of the class (JES or WLM) is released by an operator command</td>
</tr>
<tr>
<td>Xeq-Cnt</td>
<td>Number of active jobs</td>
</tr>
<tr>
<td>TDepth</td>
<td>Job class limit for the system</td>
</tr>
<tr>
<td>Log</td>
<td>Print the job log</td>
</tr>
<tr>
<td>Jrnl</td>
<td>Job journaling status: YES or NO.</td>
</tr>
<tr>
<td>Rst</td>
<td>Restart the job from the first step. The job will be restarted on the</td>
</tr>
<tr>
<td></td>
<td>processor on which it was active.</td>
</tr>
<tr>
<td>JESLog</td>
<td>Spin options for JES joblogs</td>
</tr>
<tr>
<td>SDepth</td>
<td>Setup depth</td>
</tr>
<tr>
<td>PartName</td>
<td>Spool partition name</td>
</tr>
<tr>
<td>PriTrk</td>
<td>Primary track group allocation</td>
</tr>
<tr>
<td>SecTrk</td>
<td>Secondary track group allocation</td>
</tr>
<tr>
<td>Prio</td>
<td>Priority</td>
</tr>
</tbody>
</table>

The following fields can be overtyped by authorized users:

- **JESLog**: Spin options for JES joblogs; SPIN,line-count or NOSPIN.
- **Prio**: Priority
- **SDepth**: Setup depth
- **TDepth**: Job class limit for the system

### 3.10 Spool Volumes (SP) panel

The Spool Volumes (SP) panel is accessed with the SP command. It allows authorized users to display information about JES spool volumes. Figure 3-13 is an example of data on the Spool Volumes panel.

![Figure 3-13 Spool Volumes (SP) panel](image)

The Spool Volumes panel title line shows the information in Example 3-18 on page 54.
Example 3-18  Spool Volumes panel title

<table>
<thead>
<tr>
<th>SDSF</th>
<th>SPOOL DISPLAY</th>
<th>SC75</th>
<th>48% ACT</th>
<th>15000 FRE</th>
<th>7782 LINE 1-4 (4)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main the user is logged on</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spool utilization</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Spool Volumes panel NP field actions

Action characters that can be entered in the NP column by authorized users are:

- //: Block repeat.
- =: Repeat previous action character or overtype.
- +: Expand the NP column. (Use RESET to reset.)
- A: Release the spool data set and all jobs that have data on spool for scheduling
- D: Display the status of a spool volume.
- DL: Display the long form of status.
- H: Hold the spool data set and further scheduling for jobs with data on the data set
- HC: Hold the spool data set and cancel all jobs using it.
- HP: Hold the spool data set and further scheduling of jobs with data on it. Cancel jobs active on the main and using the data set.
- J: Display all jobs using the spool volume.
- P: Drain a spool volume.
- U: Resume allocating space on the spool data set.

MVS and JES commands issued for the action characters:

<table>
<thead>
<tr>
<th>Action</th>
<th>JES3 Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>*F Q,DD=ddname,RELEASE</td>
</tr>
<tr>
<td>D</td>
<td>*I Q,DD=ddname or *I Q,SP= spart</td>
</tr>
<tr>
<td>DL</td>
<td>*I Q,SP=spart,DD</td>
</tr>
<tr>
<td>H</td>
<td>*F Q,DD=ddname,HOLD</td>
</tr>
<tr>
<td>HC</td>
<td>*F Q,DD=ddname,CANCEL</td>
</tr>
<tr>
<td>HP</td>
<td>*F Q,DD=ddname,STOP</td>
</tr>
<tr>
<td>J</td>
<td>*I Q,SP=spart,U</td>
</tr>
<tr>
<td>P</td>
<td>*F Q,SP=spart,DRAIN</td>
</tr>
<tr>
<td>U</td>
<td>*F Q,SP=spart,USE</td>
</tr>
</tbody>
</table>

Spool Volumes panel fields

The Spool Volumes panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Spool volume DD name</td>
</tr>
<tr>
<td>Status</td>
<td>Spool status</td>
</tr>
<tr>
<td>TGPct</td>
<td>Spool utilization</td>
</tr>
<tr>
<td>TGNum</td>
<td>Total track groups</td>
</tr>
<tr>
<td>TGUse</td>
<td>Track groups in use</td>
</tr>
<tr>
<td>Ext</td>
<td>Extent number, in hexadecimal</td>
</tr>
<tr>
<td>LoCyl</td>
<td>Low cylinder</td>
</tr>
<tr>
<td>LoTrk</td>
<td>Absolute low track number, in hexadecimal</td>
</tr>
<tr>
<td>LoHead</td>
<td>Low head</td>
</tr>
<tr>
<td>HiCyl</td>
<td>High cylinder</td>
</tr>
<tr>
<td>HiTrk</td>
<td>Absolute high track number, in hexadecimal</td>
</tr>
<tr>
<td>HiHead</td>
<td>High head</td>
</tr>
<tr>
<td>TrkPerCyl</td>
<td>Number of tracks per cylinder</td>
</tr>
<tr>
<td>RecPerTrk</td>
<td>Number of records per track</td>
</tr>
<tr>
<td>TrkPerTG</td>
<td>Number of tracks per track group</td>
</tr>
<tr>
<td>Type</td>
<td>Spool type (PARTITION or EXTENT)</td>
</tr>
</tbody>
</table>
The following fields can be overtyped by authorized users:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MinPct</td>
<td>Minimal SLIM threshold percentage</td>
</tr>
<tr>
<td>OverFNam</td>
<td>Overflow partition name</td>
</tr>
<tr>
<td>PartName</td>
<td>Partition name</td>
</tr>
</tbody>
</table>

JES commands generated for overtyping fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>JES3 Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>MinPct</td>
<td>*F Q,SP=spart,MN=nn</td>
</tr>
<tr>
<td>OverFNam</td>
<td>*F Q,SP=spart,O={spart2</td>
</tr>
<tr>
<td>PartName</td>
<td>*F Q,DD=ddname,SP=spart</td>
</tr>
</tbody>
</table>

### 3.11 Hardcopy log displays

SDSF hardcopy log displays:

- The OPERLOG, which allows authorized users to display a merged, sysplex-wide system message log, which contains console messages, operator commands, and operator responses for the MVS systems.

  The operations log (OPERLOG) is a log stream that uses the system logger to record and merge communications from each system in a sysplex.

- The SYSLOG, which allows authorized users to display the system log. The system log is a collection of JES data sets that contain console messages, operator commands, and operator responses for a z/OS system.

  SYSLOG individually records command and message traffic for each system in MVS format

- JES3 DLOG centrally records command and message traffic for systems in a JES3 complex in JES3 format. The JES3 DLOG is written to SYSLOG on the global processor.

  SYSLOG on the global processor must be active when DLOG is active.

IBM recommends use of OPERLOG on all systems in the sysplex as the only normally active hardcopy medium. The OPERLOG MDB records contain considerably more information than either the JES3 DLOG or SYSLOG formats. In addition, with OPERLOG each system writes its own command and message traffic to the common log, rather than all log activity taking place on the JES3 global processor, as with DLOG.
You control which messages are included in the hardcopy message set with the VARY,HARDCPY command to specify the routing codes of messages that are included in the hardcopy message set. You can add to the existing set (AROUT operand), subtract from the existing set (DROUT), or redefine the set (ROUT).

Assign the hardcopy medium with the VARY command. Use the HARDCPY operand on the VARY command to assign SYSLOG or OPERLOG as the hardcopy medium. You can assign both SYSLOG and OPERLOG as the hardcopy medium by issuing the command separately. To display information about the hardcopy medium, enter:

```
DISPLAY CONSOLES,HARDCOPY or D C,HC
```

Unless you specify otherwise, the system includes all operator and system commands, responses, and status displays in the hardcopy message set. To request that some commands and command responses not be included in the hardcopy message set, the system gives you the following choices on the VARY,HARDCPY command:

- **NOCMDS** - The system does not include operator commands or their responses in the hardcopy message set.
- **INCMDS** - The system includes all operator commands and their responses, excluding any status displays, in the hardcopy message set.
- **STCMDS or CMDS** - The system includes all operator and system commands, their responses, and status displays in the hardcopy message set. As of z/OS V1R8, STCMDS and CMDS are equivalent.

Use the JES3 *MODIFY,O command to activate or deactivate the DLOG:

```
*MODIFY,O,DLOG={ON|OFF}
```

The JES3 *INQUIRY,O,DLOG command displays the status of the DLOG.

**Defaults for the hardcopy log display**

The default hardcopy log display panel can be set with the SET LOG command on any SDSF panel. The command specifies the panel that is displayed when you enter the LOG command with no parameters, or select the Log choice of the Display pull-down. The format of the SET LOG command is shown in Example 3-19.

**Example 3-19  Hardcopy log display format**

```
SET LOG {OPERACT|OPERLOG|SYSLOG|?}
```

SET LOG with no parameters is the same as SET LOG OPERACT.

**OPERACT** or **A** specifies that the OPERLOG panel is displayed if the Operlog component is active on the system you are logged on to; otherwise, the SYSLOG panel is displayed.

**OPERLOG** or **O** specifies that the OPERLOG panel is displayed.

**SYSLOG** or **S** specifies that the SYSLOG panel is displayed.

? displays the current setting for SET LOG command.

Action bar Options pull-down choice 18 can also be used to set the Log default.

The FINDLIM command resets the maximum number of lines searched by the FIND command on the Log, ULOG, and Output Data Set panels. The format of the FINDLIM command is shown in Example 3-20.
Example 3-20  FINDLIM command format

FINDLIM {number|?}

number is any number between 1000 and 9999999.

? displays the current value on the command line or pop-up.

Under ISPF, this command remains in effect across SDSF sessions.

Action bar Options pull-down choice 16 “Operlog limit for filter…” can be used to limit the amount of OPERLOG data SDSF will search for records that meet filter criteria.

OPERLOG panel (LOG O)
The OPERLOG panel displays a merged, Sysplex-wide system message log, which contains console messages, operator commands, and operator responses for the MVS systems. It is accessed with the LOG O command.

The first time you access the OPERLOG panel in a session, SDSF positions the data to show the most recent OPERLOG entries. If you exit the panel and then reaccess it, you must scroll to the bottom to see the most recent entries.

Figure 3-14 shows an OPERLOG display panel. The COLS command has been used to display the formatted line for identifying display columns. The RESET command resets the results of a previous COLS command.

The ACTION OFF is in effect; no WTOR messages are displayed.

Figure 3-14 OPERLOG (LOG O) display

The data on the OPERLOG panel is in the same format as on the SYSLOG panel. It is shown in Example 3-21.
Example 3-21  OPERLOG panel format

<table>
<thead>
<tr>
<th>NR0000000</th>
<th>SYS1</th>
<th>2001363</th>
<th>09:46:34</th>
<th>HZSPROC</th>
<th>00000090</th>
<th>HZ50002E</th>
<th>CHECK(…</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td></td>
<td>Time</td>
<td>User exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td>Julian</td>
<td>flags</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>routing</td>
<td>date</td>
<td>codes</td>
<td>Console name, Message text,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>System name</td>
<td>jobname, or beginning with</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>and Request type</td>
<td>multi-line ID</td>
<td>message ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Commands for the OPERLOG panel

A few useful commands are shown. Some require authorization.

The / command is used to issue a system command. The format is shown in Example 3-22.

Example 3-22  Issue a system command

(W)(I)[command]  Issue a system command

/ with no command displays the system command extension pop-up, primed with the text of the previous slash command.

W waits the full delay interval before displaying messages. The delay interval is specified with the SET DELAY command.

I uses console ID 0 (INTERNAL) to issue the command. command is any MVS or JES command.

+ displays the system command extension pop-up. The system command extension pop-up lets you enter longer commands and select commands from a list of recently issued commands.

The ACTION command is used to specify which WTORs to display. The format is shown in Example 3-23.

Example 3-23  Specify WTORs displayed

ACTION routing-code-list  Specify WTORs displayed

ACTION {routing-code-list|MVS|USER|ALL|OFF|?}

Specifies which Write-To-Operator-with-Reply (WTOR) messages are displayed at the bottom of the Log panel. You must be authorized to use this command.

The BOOK command is used to invoke BookManager. The format is shown in Example 3-24.

Example 3-24  Invoke BookManager with a search string

BOOK string  Invoke BookManager with a search string
The FILTER command is used to filter log records. The format is shown in Example 3-25.

**Example 3-25  Filter log records**

<table>
<thead>
<tr>
<th>FILTER column oper value</th>
<th>Filter log records</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILTER ON</td>
<td>OFF</td>
</tr>
</tbody>
</table>

FIL (+|-)column (operator) value

Filters data on the current SDSF panel. Under ISPF, filters are saved (one set for each JES type).

OFF turns filtering off but retains filter criteria.

ON turns filtering on.

OR and AND specify the relationship between filters both within a column and between columns.

(+|-)column names a column for filtering and turns filtering on. column can be abbreviated to the shortest unique name.

+ adds the filter to any previous filters. There is a limit of 25 filters under ISPF - discards all filters for the column.

The FIND command is used to search for a character string. The format is shown in Example 3-26.

**Example 3-26  Search for a character string**

<table>
<thead>
<tr>
<th>FIND string</th>
<th>Search for a character string</th>
</tr>
</thead>
</table>

The LOCATE command is used to find a specific time and date. The format is shown in Example 3-27.

**Example 3-27  Locate a time and a date**

<table>
<thead>
<tr>
<th>LOCATE hh:mm:ss mm/dd/yyyy</th>
<th>Locate a time and date</th>
</tr>
</thead>
</table>

The NEXT and PREV command control scrolling options. The format is shown in Example 3-28.

**Example 3-28  Scroll by hours, days, minutes, seconds**

| NEXT / PREV number H|D|M|S | Scroll by hours, days, minutes, seconds |
|---------------------|-------------------------|

The PRINT command is used to print data. The format is shown in Example 3-29.

**Example 3-29  Print data**

<table>
<thead>
<tr>
<th>PRINT begin-time begin-date end-time end-date</th>
<th>Print data</th>
</tr>
</thead>
</table>

The RSYS command is used to limit WTORs by the system. The format is shown in Example 3-30.

**Example 3-30  Limit WTORs by system**

<table>
<thead>
<tr>
<th>RSYS system</th>
<th>Limit WTORs by system</th>
</tr>
</thead>
</table>

RSYS {system-name|?}

RSYS with no parameters displays only WTORs from the system you are logged on to.

system-name is the MVS system name, up to 8 characters, including * (any string of characters) or % (any single character).

? displays the current setting on the command line or pop-up.

Under ISPF, RSYS remains in effect across sessions.
Columns on the OPERLOG panel

The OPERLOG panel columns to use with the filter command are:

- **SYSNAME**: MVS system name.
- **DATE**: Date the message was logged, in character format. Enter the date as it is displayed.
- **TIME**: Time the message was logged, in character format. Enter the time as it is displayed.
- **DATETIME**: Date and time the message was logged, in date/time format. This column accepts the date format set with SET DATE. Use operators with > or <.
- **JOBNAME**: Originating job name.
- **JOBID**: Job ID.
- **CONSOLE**: Console name.
- **MSGID**: Message ID (first 8-character token of the message text).
- **MSGTEXT**: Message text (includes message ID). Note that because this column includes the message ID, you may want to include a leading generic pattern matching character in your filter command, for example, FIL MSGTEXT EQ "STARTED".

Figure 3-15 shows the column select pop-up for setting filtering criteria on OPERLOG data. The pop-up choice 1."Filter" from the action bar’s Filter selection was used to invoke this menu.

![Figure 3-15 Column select pop-up for filtering on OPERLOG data](image)

### 3.12 SYSLOG panel (LOG S)

A SYSLOG often consists of multiple SYSOUT data sets, making it cumbersome to browse its contents. z/OS V1R10 had a limitation that SDSF users could not browse the entire SYSLOG using JES3 SDSF.
With JES3 V1R11, the SYSLOG stream is merged into a single logical SYSLOG data set. This allows for all the SYSLOG data sets on a system to be logically concatenated into a single logical SYSLOG data set for browse requests.

With this new support, JES3 users can now access the SYSLOG as a single entity. Instead of searching multiple SYSLOG data sets, searching can be performed on a single, logical SYSLOG data set.

New SYSLOG support
On the main SDSF panel, selecting **LOG** now allows access to all the concatenated SYSLOG data sets in a seamless manner. For example, instead of searching for text in each SYSLOG data set one by one, only one search is necessary. The logical concatenation of the SYSLOG data sets is named as follows:

```
sysname.SYSLOG.SYSTEM
```

Where **sysname** is the main processor name.

SYSLOG panel display description
The SYSLOG panel displays the system log, which is a collection of JES3 data sets that contain console messages, operator commands, and operator responses for a z/OS system. It is accessed with the **LOG S** command.

The first time you access the SYSLOG panel in a session, SDSF positions the data to show the most recent SYSLOG entries. If you exit the panel and then reaccess it, you must scroll to the bottom to see the most recent entries.

Figure 3-16 is an example of SYSLOG data display before and after the JES3 DLOG is enabled. ACTION ROUTE CODES=ALL is in effect.

![Figure 3-16 SYSLOG (LOG S) display (MVS SYSLOG and JES3 DLOG data)](image)

The MVS format of data description of the SYSLOG panel is shown in Figure 3-17 on page 62.
Using SDSF in a JES3 Environment

3.12.1 Commands for the SYSLOG panel

A few useful commands are shown here:

- `(W)(I)/(command)` Issue a system command
- `ACTION routing-code-list` Specify WTORs displayed
- `FIND string` Search for a character string
- `LOCATE hh:mm:ss mm/dd/yyyy` Locate a time and date
- `PRINT begin-time begin-date end-time end-date` Print data
- `RSYS system` Limit WTORs by system

Figure 3-17  MVS format of the SYSLOG description

The JES3 DLOG format of data on the SYSLOG panel is shown in Figure 3-18.

Figure 3-18  JES3 DLOG description of the SYSLOG

The MVS format of data on the SYSLOG panel is the same as on the OPERLOG panel. It is shown in the example in Figure 3-19.

Figure 3-19  MVS format of the SYSLOG

The JES3 DLOG format of data on the SYSLOG panel is shown in Figure 3-20.

Figure 3-20  JES3 DLOG format of the SYSLOG

3.12.1 Commands for the SYSLOG panel

A few useful commands are shown here:

- `(W)(I)/(command)` Issue a system command
- `ACTION routing-code-list` Specify WTORs displayed
- `FIND string` Search for a character string
- `LOCATE hh:mm:ss mm/dd/yyyy` Locate a time and date
- `PRINT begin-time begin-date end-time end-date` Print data
- `RSYS system` Limit WTORs by system
SYSID system-id Specify the system ID

The format of the SYSID command is shown in Example 3-31.

Example 3-31  SYSID command format

SYSID {system-id|*|?}

with no parameters indicates the SYSLOG panel should display the SYSLOG for the system the user is logged on to.

system-id is a 1-8 characters main name.

* specifies that the JES3 global system is to be used.

? displays the current SYSID setting on the command line, as well as a list of the members defined in the JESPLEX.

Filtering for SYSLOG data is not supported.

Note: JES3 DLOG activates an extended MCS console to receive messages from the sysplex systems that are defined to belong to the JES3 complex. The DLOG processing, on the JES3 global, extracts the messages from the data space, formats them in JES3 DLOG format, and writes them to SYSLOG using a WTL macro service.

The SYSLOG on the global may contain messages from JESPLEX systems that are IPLed, but do not have an active JES3 primary subsystem.
Working with MVS

In this chapter the following topics are discussed:

- The Display Active Users (DA) panel, which allows authorized users to display information about jobs, TSO users, started tasks, and initiators that are active in the sysplex. It also shows system data, such as CPU usage and paging information.
  
  In a JES3 environment, the DA panel requires RMF to be active.

- The System Requests (SR) panel, which allows authorized users to display information about reply and action messages.

- The Scheduling Environment (SE) panel, which allows authorized users to display the Scheduling Environments in the sysplex.

- The Resource (RES) panel, which allows authorized users to display WLM resources.

- The Enclaves (ENC) panel, which allows authorized users to display information about WLM enclaves.

- The Processes (PS) panel, which allows authorized users to display information about z/OS UNIX System Services processes.

- The Health Checker (CK) panel, which allows authorized users to display information from IBM Health Checker for z/OS. The panel shows the active checks. Checks that are currently running are highlighted.
4.1 Display Active Users (DA) panel

The Display Active Users (DA) panel displays information about jobs, TSO users, started
tasks, and initiators that are active in the sysplex. It also shows system data, such as CPU
usage and paging information.

The DA panel in a JES3 environment requires that RMF Monitor I be started. By default,
Monitor I is started when you start RMF.

The DA panel is invoked with the DA command. The command parameters allow you to limit
the display by:
- Types of address spaces: jobs, TSO users, started tasks, or initiators
- Positions of address spaces: swapped in, swapped out, in transition, or ready.

The format of the DA command is shown in Example 4-1.

*Example 4-1  DA command syntax*

<table>
<thead>
<tr>
<th>Position</th>
<th>Type</th>
<th>Only</th>
<th>No</th>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td>DA [IN]</td>
<td>[JOB]</td>
<td>[OJOB]</td>
<td>[NOJOB]</td>
<td>[ALL]</td>
</tr>
<tr>
<td>[OUT]</td>
<td>[TSU]</td>
<td>[OTSU]</td>
<td>[NOTSU]</td>
<td>[ALLT]</td>
</tr>
<tr>
<td>[TRANS]</td>
<td>[STC]</td>
<td>[OSTC]</td>
<td>[NOSTC]</td>
<td>[ALLP]</td>
</tr>
<tr>
<td>[READY]</td>
<td>[INIT]</td>
<td>[OINIT]</td>
<td>[NOINIT]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[OIN]</td>
<td>[NOIN]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[OOUT]</td>
<td>[NOOUT]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[OTRANS]</td>
<td>[NOTRANS]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[OREADY]</td>
<td>[NOREADY]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Position** and **Type** parameters include those address spaces.

**Only** parameters limit the display to those types or positions. Use only one parameter
from this column.

**No** parameters exclude those types or positions.

**All** parameters show all address spaces, or all types or positions. They cannot be used
with other parameters.

The maximum number of parameters is four.

The information displayed may also be limited by your authorization, and by settings for
filters such as FILTER, PREFIX, and SYSNAME.
Figure 4-1 is a sample DA display that is invoked with DA ALL command.

```
Figure 4-1 Display Active Users (DA) panel
```

**Note:** The DA panel shows information about jobs, TSO users, started tasks, and initiators that are active in the JESPLEX even if some of the systems are not running JES3 as the primary job entry subsystem.

The heading information of the DA panel is explained in Example 4-2.

**Example 4-2 Display active users panel headings**

```
<table>
<thead>
<tr>
<th>SDFS DA SC75</th>
<th>(ALL)</th>
<th>PAG 0</th>
<th>CPU/L/Z</th>
<th>CPU/L/Z</th>
<th>LINE 1-25 (132)</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID</td>
<td>Total demand</td>
<td>Lines displayed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>of system you are logged on to</td>
<td>paging rate</td>
<td>or first line if 100,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Systems displayed</td>
<td>Percentage of time the CPU is busy,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MVS, LPAR and zaAP views</td>
<td>Total lines</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSNAME value</td>
<td>SIO, if shown, is the total system start I/O rate.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAG, SIO, and CPU values are for the system you are logged on to.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Display active users (DA) panel NP field actions**

Action characters that can be entered in the NP column by authorized users are:

- **//** Block repeat.
- **=** Repeat previous action character or overtype.
- **+** Expand the NP column. (Use RESET to reset.)
- **A** Release a held job.
- **C** Cancel a job, also print non-held data sets.
- **CA** Cancel a job that is defined to Automatic Restart Manager (ARM).
- **CD** Cancel a job and take a dump.
CDA  Cancel a job that is defined to ARM, and take a dump.
CP  Cancel a job and delete held data sets.
D  Display job information in the log. You can add:
   E - Line, page, record and card counts
   L - Long form
   SD - DDNAMES of spool data sets that contain data
   SH - DDNAMES of spool data sets in spool hold that contain data
   SP - Spool partition name
   X - Extended
   E - Process a job again.
   H - Hold a job.
   K - Cancel a started task (system cancel).
   KD - Cancel a started task and take a dump (system cancel).
   L - List output status of a job in the log (job output in the writer queue). You can add:
      B - SNA/NJE output
      H - Output on the hold queue
      T - TCP/IP job output
      P - Cancel a job and purge its output.
      R - Reset and resume a job.
      RQ - Reset and quiesce a job.
   Q - Display output descriptors for all of the data sets.
   S - Display the data sets for a job. You can add:
      B - Use ISPF Browse
      E - Use ISPF Edit
      J - Use ISPF Edit to edit the JCL
   W - Cause job and message logs to spin.
   X - Print output data sets. You can add:
      C - Close the print file after printing (XC)
      D - Display the Open Print Data Set panel (XD or XDC)
      F - Display the Open Print File panel (XF or XFC)
      S - Display the Open Print panel (XS or XSC)
   Y - Stop a started task (system stop).
   Z - Cancel a started task (system force).
   ? - Display a list of data sets for a job. (Access the Job Data Set panel.)

**JES3 and MVS commands for the action characters on the DA panel**

<table>
<thead>
<tr>
<th>Action</th>
<th>JES3 or MVS command</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>*F J=jobno,R</td>
</tr>
<tr>
<td>C</td>
<td>*F J=jobno,CO</td>
</tr>
<tr>
<td>CA</td>
<td>*F J=jobno,C,ARMR</td>
</tr>
<tr>
<td>CD</td>
<td>*F J=jobno,C,D</td>
</tr>
<tr>
<td>CDA</td>
<td>*F J=jobno,C,D,ARMR</td>
</tr>
<tr>
<td>CP</td>
<td>*F J=jobno,CP</td>
</tr>
<tr>
<td>D</td>
<td>*I J=jobno</td>
</tr>
<tr>
<td>DE</td>
<td>*I J=jobno,E</td>
</tr>
<tr>
<td>DL</td>
<td>*I A,J=jobno</td>
</tr>
<tr>
<td>DSD</td>
<td>*I J=jobno,SD</td>
</tr>
<tr>
<td>DSH</td>
<td>*I J=jobno,SH</td>
</tr>
<tr>
<td>DSP</td>
<td>*I J=jobno,SP</td>
</tr>
<tr>
<td>DX</td>
<td>*I J=jobno,X</td>
</tr>
<tr>
<td>E</td>
<td>*R main,jobno</td>
</tr>
<tr>
<td>H</td>
<td>*F J=jobno,H</td>
</tr>
<tr>
<td>K</td>
<td>C jobname.identifier,A=asidx</td>
</tr>
<tr>
<td>KD</td>
<td>C jobname.identifier,DUMP,A=asidx</td>
</tr>
<tr>
<td>L</td>
<td>*I U,Q=WTR,J=jobno</td>
</tr>
<tr>
<td>LB</td>
<td>*I U,Q=BDT,J=jobno</td>
</tr>
<tr>
<td>LH</td>
<td>*I U,Q=HOLD,J=jobno</td>
</tr>
<tr>
<td>LT</td>
<td>*I U,Q=TCP,J=jobno</td>
</tr>
<tr>
<td>P</td>
<td>*F J=jobno,C</td>
</tr>
<tr>
<td>R</td>
<td>RESET jobname,A=asidx</td>
</tr>
</tbody>
</table>
Display active users panel fields

The display active users panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBNAME</td>
<td>Job name of the address space</td>
</tr>
<tr>
<td>StepName</td>
<td>Job step name, or TSO procedure name for TSO users</td>
</tr>
<tr>
<td>ProcStep</td>
<td>Procedure step name, or terminal name for TSO users</td>
</tr>
<tr>
<td>Type</td>
<td>Type of address space: job, started task, TSO user, or initiator</td>
</tr>
<tr>
<td>JNum</td>
<td>JES job number</td>
</tr>
<tr>
<td>Owner</td>
<td>User ID of job creator</td>
</tr>
<tr>
<td>C</td>
<td>JES input class at the time the job was selected for execution</td>
</tr>
<tr>
<td>Pos</td>
<td>Address space position; swapped in, swapped out, nonswappable, in transition</td>
</tr>
<tr>
<td>DP</td>
<td>Address space dispatching priority in hexadecimal</td>
</tr>
<tr>
<td>Real</td>
<td>Current utilization of real storage in frames</td>
</tr>
<tr>
<td>Paging</td>
<td>Demand paging rate (only present if the address space was swapped in for the entire interval)</td>
</tr>
<tr>
<td>SIO</td>
<td>Address space’s EXCP rate in EXCPs per second</td>
</tr>
<tr>
<td>CPU%</td>
<td>Percent of CPU time used on behalf of this address space during the most recent interval measured</td>
</tr>
<tr>
<td>ASID</td>
<td>Address space identifier</td>
</tr>
<tr>
<td>ASIDX</td>
<td>Address space identifier in hexadecimal</td>
</tr>
<tr>
<td>EXCP-Cnt</td>
<td>Address space’s EXCP count for the current job step. Uses hexadecimal scaling.</td>
</tr>
<tr>
<td>CPU-Time</td>
<td>Accumulated CPU time (TCB plus SRB) consumed on behalf of the address space, for the current job step, in seconds</td>
</tr>
<tr>
<td>SR</td>
<td>Swap out reason code</td>
</tr>
<tr>
<td>JobID</td>
<td>JES job ID or work ID</td>
</tr>
<tr>
<td>Status</td>
<td>PROT (job is protected)</td>
</tr>
<tr>
<td>Workload</td>
<td>Workload name</td>
</tr>
<tr>
<td>SrvClass</td>
<td>Service class name</td>
</tr>
<tr>
<td>SP</td>
<td>Service class period</td>
</tr>
<tr>
<td>ResGroup</td>
<td>Resource group name</td>
</tr>
<tr>
<td>Server</td>
<td>Server indicator, indicates if resource goals are being honored</td>
</tr>
<tr>
<td>Quiesce</td>
<td>Quiesce indicator (address space is quiesced)</td>
</tr>
<tr>
<td>SysName</td>
<td>System on which the address space is running</td>
</tr>
<tr>
<td>SPag</td>
<td>Demand paging rate for the system (see note)</td>
</tr>
<tr>
<td>SCPU%</td>
<td>System CPU utilization for the system that is processing the job (see note)</td>
</tr>
<tr>
<td>ECPU-Time</td>
<td>Accumulated CPU time consumed within the address space, for the current job step, in seconds</td>
</tr>
<tr>
<td>ECPU%</td>
<td>CPU usage consumed within the address space</td>
</tr>
<tr>
<td>CPUCrit</td>
<td>Current address space CPU protection</td>
</tr>
<tr>
<td>StorCrit</td>
<td>Current address space storage protection</td>
</tr>
<tr>
<td>RptClass</td>
<td>Report class</td>
</tr>
<tr>
<td>MemLimit</td>
<td>Memory limit</td>
</tr>
<tr>
<td>Tran-Act</td>
<td>Elapsed time the transaction has been active</td>
</tr>
<tr>
<td>Tran-Res</td>
<td>Elapsed time the transaction was swapped in</td>
</tr>
<tr>
<td>Spin</td>
<td>Indicator of whether jobs in the job class can be spun (</td>
</tr>
<tr>
<td>Seclabel</td>
<td>Security label</td>
</tr>
<tr>
<td>GCP-Time</td>
<td>Accumulated general processor service time, in seconds</td>
</tr>
<tr>
<td>zAAP-Time</td>
<td>Accumulated zAAP service time, in seconds</td>
</tr>
<tr>
<td>zACP-Time</td>
<td>Accumulated general processor service time that was eligible for a zAAP, in seconds</td>
</tr>
<tr>
<td>GCP-Use%</td>
<td>Percent of the total general processor time used by the address space in the most recent interval (not normalized)</td>
</tr>
</tbody>
</table>
Some SDSF commands for the DA panel

A few useful commands are shown here. Some require authorization.

FILTER column oper value Filter jobs shown on any column.
FIND jobname Search for a job name.
SET DISPLAY Show settings for PREFIX, DEST, SORT, and so on.
SORT column A|D Sort based on a column, ascending or descending.
SYSNAME system Filter jobs by system name.

Note: In IBM System z9® and successor mainframes, the System z® Integrated Information Processor (zIIP) is a special purpose processor, intended to offload certain DB2® processing from the general mainframe central processors (CPs), and now also used to offload other z/OS workloads.

The IBM System z Application Assist Processor (zAAP) is a mainframe processor. zAAP engines are dedicated to running specific Java™ and XML workloads under z/OS, accelerating performance. zAAPs are available for zSeries® 990 and 890 servers and all System z9 and System z10™ servers.

4.2 System Requests (SR) panel

The System Requests (SR) panel displays information about reply and action messages. The SR panel is invoked with the SR command.

If the Action Message Retention Facility (AMRF) is not active, the SR panel shows only reply messages. The AMRF parameter in the CONSOLxx PARMLIB member INIT statement specifies whether AMRF is to be active.

You change the status of AMRF with the CONTROL command:

CONTROL M,AMRF={Y|N}

To learn the status of AMRF, issue the CONTROL M,REF command.

Figure 4-2 on page 71 shows an example of the SDSF System Requests panel.
Chapter 4. Working with MVS

Figure 4-2  System Requests (SR) panel

The panel title line data is shown in Example 4-3.

Example 4-3  SR panel headings

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SR</td>
<td>command</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>counts of reply, immediate action, critical eventual action and eventual action Total messages lines</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>748051</td>
<td>SCS</td>
<td>JES3</td>
<td>IAT7321 ISSUE START/CANCEL/RESTART DC REQ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2320051</td>
<td>SCS</td>
<td>SMF</td>
<td>IEEE391A SMF ENTER DUMP FOR DATA SET ON V0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2372051</td>
<td>SCS</td>
<td>SMF</td>
<td>IEEE391A SMF ENTER DUMP FOR DATA SET ON V0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2374051</td>
<td>SCS</td>
<td>HZSPROC</td>
<td>HZ50003E CHECK(IBMRCF,RAF_SENSITIVE_RES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>SCS</td>
<td>XYZYY</td>
<td>0069 REPLY SOMETHING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>SCS</td>
<td>XYZYYA</td>
<td>0070 REPLY SOMETHING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>71</td>
<td>SCS</td>
<td>XYZYYA</td>
<td>0071 REPLY SOMETHING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>73</td>
<td>SCS</td>
<td>XYZYYA</td>
<td>0073 REPLY SOMETHING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>885052</td>
<td>SCS</td>
<td>HZSPROC</td>
<td>HZ50000E CHECK(IBMXCF,XCF_SYSSTADDET_PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>886052</td>
<td>SCS</td>
<td>HZSPROC</td>
<td>HZ50000E CHECK(IBMXCF,XCF_XCF_SFM_SUM_ACTION)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>889052</td>
<td>SCS</td>
<td>HZSPROC</td>
<td>HZ50000E CHECK(IBMRCAF,RAF_SENSITIVE_RES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>SCS</td>
<td>XYZYY</td>
<td>0075 REPLY SOMETHING</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SR command
The format of the SR command is shown in Example 4-4.

Example 4-4  SR command format

SR {ALL|ACTIONS|A|CEM|EN|EM|MOUNTS|M|REPLIES|R|RM}

ALL displays all reply and action messages. This is the default.
ACTIONS or A displays action messages.
CEM displays critical eventual action messages.
EM displays eventual action messages.
IM displays immediate action messages.
MOUNTS or M displays DASD and tape mount messages. SDSF considers a message to be a mount if it has tape or DASD pool routing codes.
REPLIES or R or RM displays reply messages.

System requests panel NP field actions
Action characters that can be entered in the NP column by authorized users are:

/  Block repeat
=  Repeat previous action character or overtype
+  Expand the NP column. (Use RESET to reset.)
C  Remove an action message.
D  Display a message in the logs or ULOG.
R[command]  Reply to the message. R by itself displays a pop-up on which you can complete the command.

MVS commands issued for the action characters
- C   K C.A.id
- D   D R,CN=(ALL),MSG=msgid
- R   R id,'text'

System requests panel fields
The System Requests panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPLYID</td>
<td>Reply ID of the message</td>
</tr>
<tr>
<td>SysName</td>
<td>Originating system name</td>
</tr>
<tr>
<td>JobName</td>
<td>Name of the issuing job</td>
</tr>
<tr>
<td>Message-Text</td>
<td>Message ID and text</td>
</tr>
<tr>
<td>JobID</td>
<td>JES job ID of the issuing job (JES2) or Proc name or job name (JES3)</td>
</tr>
<tr>
<td>Date</td>
<td>Date when the message was logged</td>
</tr>
<tr>
<td>Time</td>
<td>Time when the message was logged</td>
</tr>
<tr>
<td>Console</td>
<td>Target console</td>
</tr>
<tr>
<td>RouteCd</td>
<td>First 28 routing codes, in hexadecimal</td>
</tr>
<tr>
<td>Desc</td>
<td>Descriptor codes, in hexadecimal</td>
</tr>
<tr>
<td>Type</td>
<td>Message type</td>
</tr>
<tr>
<td>Queue</td>
<td>Queue the message is on (CEM - critical eventual action, EM - eventual action, IM - immediate, RM - reply)</td>
</tr>
</tbody>
</table>

Some SDSF commands for the SR panel
- ARR column A|B column - Arrange a column before or after another
- FILTER column oper value - Filter messages on any column
- FIND replyID - Search for a message by reply ID
- SORT column A|D - Sort based on a column, ascending or descending.

4.3 Scheduling Environment (SE) panel

The Scheduling Environment (SE) panel displays the scheduling environments in the sysplex.

A scheduling environment is a list of abstract resource names along with their required states. If an MVS image satisfies all of the requirements in the scheduling environment associated with a given unit of work, then that unit of work can be assigned to that MVS image. If any of the requirements are not satisfied, then that unit of work cannot be assigned to that MVS image.

For every resource name that is referenced by a scheduling environment, a corresponding resource state must be set on each system in the sysplex. The resource state can be:

- **ON**, which will satisfy a resource state requirement of ON.
- **OFF**, which will satisfy a resource state requirement of OFF.
- **RESET**, which will not satisfy any resource state requirement.

Resources are put into the RESET state when:
- A system is IPLed
- A policy is activated that defines a resource name that did not exist in the previously active policy
A scheduling environment is dynamic. It identifies the dependency that a job has to run on particular systems without specifically naming the systems. Since a scheduling environment can change state, the systems where a job is eligible to run can change without modification to its JCL.

The JES3 //*MAIN JECL SYSTEM parameter is specific and static, since it lists system names. You can use scheduling environments and the SYSTEM parameter together.

Figure 4-3 displays a scheduling environment (SE) panel. The SE panel is invoked with the SDSF SE primary command. You must be authorized to use the command.

<table>
<thead>
<tr>
<th>NP</th>
<th>SCHEDULING-ENV</th>
<th>Description</th>
<th>Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>JES2</td>
<td>MVS</td>
<td></td>
<td>SC74</td>
</tr>
<tr>
<td>JES3</td>
<td>JESPLEX</td>
<td></td>
<td>SC75</td>
</tr>
<tr>
<td>PLEX75</td>
<td>SYSPLEX</td>
<td></td>
<td>SC74, SC75</td>
</tr>
</tbody>
</table>

Figure 4-3 Scheduling Environment (SE) panel

**Scheduling environment panel NP field actions**
- `/` Block repeat
- `=` Repeat previous action character or overtype
- `+` Expand the NP column. (Use RESET to reset.)
- `D` Display scheduling environments in the log. This issues the MVS D command.
- `R` Display resources for a scheduling environment.
- `ST` Display the ST panel for all jobs requiring the scheduling environment.

**Scheduling environment panel fields**
The SE panel may include the following fields. (The order and titles may be different, depending on installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCHEDULING-ENV</td>
<td>Scheduling environment name</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the scheduling environment</td>
</tr>
<tr>
<td>Systems</td>
<td>Systems with the scheduling environment available</td>
</tr>
</tbody>
</table>

The SE panel displays the same data that is returned by the D WLM,SCHENV=*,SYSTEMS command IWM036I response message.

### 4.4 Resource (RES) panel

The Resource (RES) panel displays WLM resources. To display sysplex resources with SDSF, access the resource panel with the RES command. To display resources for a scheduling environment, access the panel with the R action character from the SE panel.

Resource, when used as part of a scheduling environment, is an abstract element that can represent an actual physical entity (such as a peripheral device), or an intangible quality (such as a certain time of day). A resource is listed in a scheduling environment along with a
required state of ON or OFF. If the corresponding resource state on a given system matches the required state, then the requirement is satisfied for that resource.

Figure 4-4 shows a WLM resource display. The resource panel is invoked with the RES command. You must be authorized to use the command.

<table>
<thead>
<tr>
<th>Display</th>
<th>Filter</th>
<th>View</th>
<th>Print</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDSF RESOURCE DISPLAY ALL SYSTEMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMAND INPUT ===&gt; -</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCROLL ===&gt; HALF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NP</td>
<td>RESOURCE</td>
<td>SC74</td>
<td>SC75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLEX75</td>
<td>ON</td>
<td>ON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SC70</td>
<td>ON</td>
<td>OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SC74</td>
<td>ON</td>
<td>OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SC75</td>
<td>OFF</td>
<td>ON</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Resource panel NP field actions**

// Block repeat
=
 Expand previous action character or overtype
+ Expand the NP column. (Use RESET to reset.)
D Display resources in the Log. This issues the MVS command
D WLM,RESOURCE=resource,SYSTEMS. Message IWM038I is issued as the command response.

**Resource panel fields**
The RES panel may include the following fields. (The order and titles may be different, depending on installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESOURCE</td>
<td>WLM resource name</td>
</tr>
<tr>
<td>ReqState</td>
<td>Required state of the resource as defined in WLM (displayed only when the panel is accessed with the R action character from the SE panel)</td>
</tr>
<tr>
<td>System</td>
<td>System in the Sysplex, showing the state of the resource on the system</td>
</tr>
</tbody>
</table>

4.5 **Enclaves (ENC) panel**

The Enclaves (ENC) panel displays information about WLM enclaves. It is accessed with the ENC command.

An enclave is a transaction that can span multiple dispatchable units (SRBs and tasks) in one or more address spaces and is reported on and managed as a unit. A multisystem enclave can run in multiple address spaces spanning multiple systems within a Parallel Sysplex®.

With all units of work of a job running in the same enclave, WLM can manage all of the work to a single performance goal.

Multisystem enclaves are displayed as multiple rows. When you act against any of these rows, SDSF issues the WLM service against the original enclave.

Figure 4-5 on page 75 is a SDSF enclave display. It is invoked with the ENC command. You must be authorized to use this command.
Chapter 4. Working with MVS

Figure 4-5 Enclave (ENC) panel

The ENC command format is shown in Example 4-5.

Example 4-5 ENC command format

ENC {ACTIVE|ALL}

ACTIVE displays only active enclaves
ALL displays all enclaves. This is the default.

Enclave panel NP field actions:

// Block repeat
= Repeat previous action character or overtype
+ Expand the NP column. (Use RESET to reset.)
I Display additional information about the enclave.
M Match the enclave by export token, to display only the instances of a multisystem enclave. Valid only for multisystem enclaves, as indicated in the Scope column. To see all enclaves again, reaccess the panel.
R Reset and resume an enclave.
RQ Reset and quiesce an enclave.

Note: If you reset a dependent enclave, the owner address space is reset.

Enclave panel fields

The Enclave panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Enclave token</td>
</tr>
<tr>
<td>SSType</td>
<td>Subsystem type (for example, DB2, MQ)</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the enclave</td>
</tr>
<tr>
<td>SrvClass</td>
<td>Service class</td>
</tr>
<tr>
<td>Per</td>
<td>Period number</td>
</tr>
<tr>
<td>PGN</td>
<td>Performance group</td>
</tr>
<tr>
<td>RptClass</td>
<td>Report class</td>
</tr>
<tr>
<td>ResGroup</td>
<td>Resource group</td>
</tr>
<tr>
<td>CPU-Time</td>
<td>Total CPU time</td>
</tr>
<tr>
<td>OwnerSys</td>
<td>Enclave owner system</td>
</tr>
<tr>
<td>OwnerJob</td>
<td>Enclave owner jobname</td>
</tr>
<tr>
<td>OwnerAS</td>
<td>Enclave owner ASID</td>
</tr>
<tr>
<td>OwnerASX</td>
<td>Enclave owner ASID in hexadecimal</td>
</tr>
<tr>
<td>Scope</td>
<td>Scope of the enclave, either LOCAL (single-system) or MULTISYS (the enclave has an export token and so is multisystem-capable)</td>
</tr>
<tr>
<td>Type</td>
<td>Enclave type: IND (independent) or DEP (dependent)</td>
</tr>
<tr>
<td>Original</td>
<td>For an enclave that has been exported, YES if this is the original enclave</td>
</tr>
</tbody>
</table>
Using SDSF in a JES3 Environment

Quiesce  Indicates if the enclave is in a quiesce delay, which occurs if the address space has been reset with the MVS RESET,QUIESCE command

Workload  Workload name
SysName  System that reported the data
SysLevel  Version and release
Subsys  Subsystem name
zAAP-Time  Accumulated zAAP time, in seconds
zACP-Time  Accumulated zAAP on CP time, in seconds
zIIP-Time  Accumulated zIIP time, in seconds
zICP-Time  Accumulated zIIP on CP time, in seconds
Promoted  Promoted due to a chronic resource contention
zAAP-NTime  Normalized zAAP time, in seconds
zIIP-NTime  Normalized zIIP time, in seconds

Pop-up display for enclave I action character

Figure 4-6 shows the additional information pop-up display for action character I (Info).

![Image of pop-up display]

Figure 4-6  Enclave I action pop-up display

Data on the additional information display about the enclave that WLM uses to classify the enclave:

- **Subsystem type**: Type of the subsystem
- **Subsystem name**: Name of the subsystem
- **Priority**: Priority associated with the subsystem
- **Userid**: User ID associated with the request
- **Transaction name**: Transaction program name for the request
- **Transaction class**: Class name within the subsystem
- **Netid**: Network identifier associated with the requester
- **Logical unit name**: Local LU name associated with the requester
- **Subsys collection**: Subsystem collection name
- **Process name**: Process name associated with the request
- **Plan name**: Access plan name for the set of associated SQL statements
- **Package name**: Package name for the set of associated SQL statements
- **Connection type**: Name associated with the environment that is creating the request
- **Collection name**: Customer-defined name for the group of associated packages
- **Correlation**: Name associated with the user/program creating the request, which may reside anywhere in the network
- **Procedure name**: DB2-stored SQL procedure name associated with the request
- **Function name**: Function name
4.6 Processes (PS) panel

The Processes (PS) panel displays information about z/OS UNIX System Services processes.

A UNIX process is defined as being an instance of a program running on a system and the resources that it uses. A process can have one or more threads; a thread is a single flow of control within a process. Application programmers create multiple threads to structure an application in independent sections that can run in parallel for more efficient use of system resources.

Figure 4-7 shows the Processes panel displayed by the PS command.

![Figure 4-7 Processes (PS) panel](image)

In z/OS UNIX, the STARTUP_PROC statement in the BPXPRMxx parmlib member specifies the cataloged procedure that initializes the kernel. The default name is OMVS.

In the UNIX operating environment, the innermost level of UNIX is the kernel. This is the actual UNIX operating system, a program that always resides in memory. Sections of the code in this program are executed on behalf of users to do needed tasks, like access files or terminals.

The OMVS address space is not considered a process.

BPXOINIT is the started procedure that runs the z/OS UNIX initialization process. BPXOINIT is also the jobname of the initialization process. At system IPL time, kernel services are started automatically.
The BPXOINIT address space has two categories of functions:
1. It behaves as PID(1) of a typical UNIX system, is the parent of /etc/rc, and it inherits orphaned children so that their processes get cleaned up using normal code in the kernel. BPXOINIT is also the parent of MVS address spaces that are dubbed and not created by fork or spawn. Therefore, TSO/E commands and batch jobs have a parent PID of 1.
2. Certain functions that the kernel performs need to be able to make normal kernel calls. This address space is used for these activities, for example, mmap() and user ID alias.

The SDSF PS command invokes the processes panel. The command may be issued on any SDSF panel. You must be authorized to use this command.

The PS panel command format is shown in Example 4-6.

Example 4-6  PS panel command format

```
PS [ALL|ACTIVE]
```

ALL displays all z/OS UNIX System Services processes. This is the default.
ACTIVE displays only active processes.

Processes panel NP field actions
```
//    Block repeat
=    Repeat previous action character or overtype
+    Expand the NP column. (Use RESET to reset.)
C    Cancel the address space that owns the process
D    Display information about processes
K    Kill the process (SIGKILL)
T    Kill the process (SIGTERM)
```

MVS commands issued for the action characters
```
C    C jobname,A=asidx
     C jobname,U=userid
D    D OMVS,PID=processid
K    F BPXOINIT,FORCE=processid
     F BPXOINIT,TERM=processid
```

Processes panel fields
The Processes panel includes some or all of the following fields. (The order and titles may be different, depending upon installation and user options.)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBNAME</td>
<td>Job name</td>
</tr>
<tr>
<td>JobID</td>
<td>JES job ID</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the process</td>
</tr>
<tr>
<td>Owner</td>
<td>Userid of the owner</td>
</tr>
<tr>
<td>State</td>
<td>State of the process or the most recently created thread</td>
</tr>
<tr>
<td>CPU-Time</td>
<td>Compute time in hundredths of seconds</td>
</tr>
<tr>
<td>PID</td>
<td>Process ID</td>
</tr>
<tr>
<td>PPID</td>
<td>Parent process ID</td>
</tr>
<tr>
<td>ASID</td>
<td>Address space ID</td>
</tr>
<tr>
<td>ASIDX</td>
<td>Address space ID in hexadecimal</td>
</tr>
<tr>
<td>LatchWaitPID</td>
<td>PID on which this process is waiting</td>
</tr>
<tr>
<td>Command</td>
<td>Command that created the process</td>
</tr>
<tr>
<td>ServerName</td>
<td>Server name</td>
</tr>
<tr>
<td>Type</td>
<td>Server type</td>
</tr>
<tr>
<td>ActFiles</td>
<td>Number of active files</td>
</tr>
<tr>
<td>MaxFiles</td>
<td>Maximum number of files</td>
</tr>
</tbody>
</table>
4.7 Health Checker (CK) panel

The SDSF Health Checker (CK) panel displays information from IBM Health Checker for z/OS. The panel shows the active checks. Checks that are currently running are highlighted.

IBM Health Checker for z/OS is a z/OS component that installations can use to gather information about their system environment and system parameters to help identify potential configuration problems before they impact availability or cause outages. Individual products, z/OS components, or ISV software can provide checks that take advantage of the IBM Health Checker for z/OS framework.

Figure 4-8 shows the Health Checker panel displayed with the CK command.

![Health Checker (CK) panel](image)

The CK command on any SDSF pane invokes the health checker panel display. You must be authorized to use this command.
The CK command format is shown in Example 4-7.

**Example 4-7  CK command format**

```
CK [category|E|EH|EM|EL|EN|D|ALL]
```

with no parameters displays active checks.

**category** shows only checks for that category. The value can include * (any string of characters) or % (any single character).

**E** displays all exception checks, with these variations:
- **EH** - exception-high
- **EM** - exception-medium
- **EL** - exception-low
- **EN** - exception-none

**D** displays deleted checks.

**ALL** displays deleted as well as active checks.

---

**Health checker panel NP field actions**

Action characters that can be entered in the NP column by authorized users are:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>Block repeat</td>
</tr>
<tr>
<td>=</td>
<td>Repeat previous action character or overtype</td>
</tr>
<tr>
<td>+</td>
<td>Expand the NP column. (Use RESET to reset.)</td>
</tr>
<tr>
<td>A</td>
<td>Activate</td>
</tr>
<tr>
<td>D</td>
<td>Display</td>
</tr>
<tr>
<td>DL</td>
<td>Display long</td>
</tr>
<tr>
<td>DP</td>
<td>Display policies</td>
</tr>
<tr>
<td>DPO</td>
<td>Display policies that are outdated and not applied</td>
</tr>
<tr>
<td>DS</td>
<td>Display status</td>
</tr>
<tr>
<td>E</td>
<td>Refresh</td>
</tr>
<tr>
<td>H</td>
<td>Deactivate</td>
</tr>
<tr>
<td>P</td>
<td>Delete</td>
</tr>
<tr>
<td>PF</td>
<td>Delete force: delete even if it is running</td>
</tr>
<tr>
<td>R</td>
<td>Run</td>
</tr>
<tr>
<td>S</td>
<td>Browse (access SDSF's Output Dataset Panel)</td>
</tr>
<tr>
<td>SB</td>
<td>Browse using ISPF Browse</td>
</tr>
<tr>
<td>SBI™</td>
<td>Browse REXX input data set using ISPF browse</td>
</tr>
<tr>
<td>SBO</td>
<td>Browse REXX output data set using ISPF browse</td>
</tr>
<tr>
<td>SE</td>
<td>Browse using ISPF Edit</td>
</tr>
<tr>
<td>SEI</td>
<td>Edit REXX input data set using ISPF Edit</td>
</tr>
<tr>
<td>SEO</td>
<td>Edit REXX output data set using ISPF Edit</td>
</tr>
<tr>
<td>U</td>
<td>Remove all categories for the check</td>
</tr>
<tr>
<td>X</td>
<td>Print the check output. You can add the following:</td>
</tr>
<tr>
<td></td>
<td>- C - Close the print file after printing (XC)</td>
</tr>
<tr>
<td></td>
<td>- D - Display the Open Print Data Set panel (XD or XDC)</td>
</tr>
<tr>
<td></td>
<td>- F - Display the Open Print File panel (XF or XFC)</td>
</tr>
<tr>
<td></td>
<td>- S - Display the Open Print panel (XS or XSC)</td>
</tr>
</tbody>
</table>

---

**Health checker panel fields**

The Health Checker panel includes some or all of the following fields. The order and titles may be different, depending on installation and user options. Some fields are blank for deleted checks.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Check name</td>
</tr>
<tr>
<td>CheckOwner</td>
<td>Check owner</td>
</tr>
<tr>
<td>State</td>
<td>Check state</td>
</tr>
<tr>
<td>Status</td>
<td>Check status</td>
</tr>
<tr>
<td>Result</td>
<td>Result from the last invocation of the check</td>
</tr>
</tbody>
</table>
### Diag1
Diagnostic data from the check (first word)

### Diag2
Diagnostic data from the check (second word)

### DiagFrom
Source for the diagnostic data: ABEND, HCHECKER or CHECKRTN

### Global
Indicator if this is a global check

### GlobalSys
System on which the global check is running

### ExcCount
Number of exceptions detected in the last iteration of the check

### RunCount
Number of times the check has been invoked

### Fail
Number of times the check failed

### Severity
Severity level of the check

### SevCode
Numeric severity level of the check

### WTOType
WTO type or descriptor code

### ModifiedBy
How the check was modified

### PolicyStatus
Policy error status

### WTONum
Number of WTOs issued by the check

### NumCat
Number of categories in which the check is defined

### Category
Category name

### Category2-16
Category names two through sixteen

### ExitName
Exit module name that added the check

### ModName
Check module name at which the check runs

### MsgName
Message load module name

### UserDate
Current date of the check (YYYYMMDD)

### DefDate
Default date of the check (YYYYMMDD)

### Debug
Debug mode indicator

### Start-Date-Time
Date and time the check last started

### Interval
Interval at which the check runs

### NextSch-Date-Time
Date and time the check is next scheduled to run (YYYY.DDDD HH:MM:SS)

### NextSch-Int
Time remaining until the check runs, in hhh:mm:ss

### Log-Date-Time
Date and time of the last successful write to System Logger

### Deleted-Date-Time
Date and time the check was deleted

### ProcName TaskID
Procedure name and started task ID for IBM Health Checker for z/OS

### Reason
Description of the reason for the check

### UpdateReason
Description of updates to the check

### ParmLen
Length of the check parameters

### Parameters
Check parameters. Unprintable characters are translated to periods (.)

### SysLevel
Level of the operating system

### SysName
System name

### EInterval
Interval at which the check runs when it finds an exception (SYSTEM, HALF, hhh:mm)

### ExecName
Name of the exec to run

### Locale
Where the check is running

### Origin
Origin of the check

### Verbose
Verbose mode for the check

### RexxIn
Rexx input data set name

### RexxOut
Rexx output data set name

### Fields overtypable by authorized users

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Category of the check. Type + alone to work with the full set of categories.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debug mode indicator (OFF, ON)</td>
</tr>
<tr>
<td>EInterval</td>
<td>Interval at which the check runs when it finds an exception (SYSTEM, HALF, hhh:mm)</td>
</tr>
<tr>
<td>Interval</td>
<td>Interval at which the check runs (hh:mm:mm)</td>
</tr>
<tr>
<td>Parameters</td>
<td>Parameters for the check.</td>
</tr>
<tr>
<td>Severity</td>
<td>Severity level of the check (HIGH, MEDIUM, LOW, NONE)</td>
</tr>
<tr>
<td>UserDate</td>
<td>Date of the check</td>
</tr>
<tr>
<td>Verbose</td>
<td>Verbose mode for the check</td>
</tr>
<tr>
<td>WTOType</td>
<td>WTO type or descriptor code, in decimal</td>
</tr>
</tbody>
</table>

### MVS commands issued for the overtypable fields

| Field      | MVS Command |
|------------|-------------|-------------|

---

Chapter 4. Working with MVS 81
<table>
<thead>
<tr>
<th>Category</th>
<th>F (Modify)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>EInterval</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>Interval</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>Parameters</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>Severity</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>UserDate</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>Verbose</td>
<td>F (Modify)</td>
</tr>
<tr>
<td>WTOType</td>
<td>F (Modify)</td>
</tr>
</tbody>
</table>
This chapter briefly discusses:

- How to access SDSF data and functions with the REXX programming language. Using REXX with SDSF provides a simpler and more powerful alternative to using SDSF in batch.

- How to use batch processing to issue often-repeated SDSF commands by creating a list of the commands as control statements. In the list, you specify the SDSF panel you wish to use and the operation you wish to perform on it.
5.1 SDSF REXX

SDSF REXX provides access to SDSF functions through the REXX programming language. The REXX support is a simpler and more powerful alternative to SDSF batch.

To access SDSF functions with REXX, you use:
- The ISFCALLS command, to add and delete the SDSF host command environment
- The ISFEXEC command, for SDSF commands, such as the commands that access SDSF panels
- The ISFACT command, for action characters and overtyping columns
- Special REXX variables, to provide function equivalent to other SDSF commands, and for messages and table data

You must be authorized to use SDSF from REXX, and to the SDSF functions that you invoke from REXX. Depending on how your SDSF security is implemented, you may be placed in a different SDSF user group when you use SDSF from REXX than when you use SDSF interactively. In some cases, invoking an SDSF function from REXX when you are not authorized to the function will cause the exec to fail and the invocation of SDSF to end.

REXXHELP command

To display the online help for using REXX with SDSF, type REXXHELP on any command line in SDSF when using SDSF under ISPF. Figure 5-1 displays the REXXHELP pop-up.
A trivial sample SDSF REXX exec:
A sample REXX exec is shown in Example 5-1.

```
Example 5-1 Sample REXX exec
/* Show some SDSF REXX basic features - List jobs in MDS alloc q */
/* for the user who invokes this REXX exec */
zrc=isfcalls("ON") /* Add the SDSF host command environment*/
isfprefix=/* Set filtering PREFIX */
owner(SYSVAR("sysuid") /* Get userid for filtering OWNER */
isfowner=owner /* Set userid for filtering OWNER */
zcn="SD"owner /* Get ULOG console name */
isfcons=strip(substr(zcn,1,8),"T"," ") /* Set ULOG console name */
Address SDSF "ISFEXEC ST" /* Access ST panel with ISFEXEC command */
do i=1 to JNAME.0 /* Loop for all rows returned */
  if PhaseName.i="AWAIT RES ALLOC" then /* Job in JES3 MDS queue? */
    do /* Yes - Query why? - Ask JES3 */
      isfdelay=5 /* Wai for JES3 response */
      Address SDSF "ISFACT ST TOKEN('TOKEN.i') PARM(NP DMA)"
    /* Issue DMA action with ISFACT cmd */
    do j=2 to isfulog.0 /* JES3 response in ULOG for DMA action */
      Say substr(isfulog.j,41) /* Copy what JES3 says */
    end 
  end 
  zrc=isfcalls("OFF") /* Delete SDSF command environment */
```

**Note:** All error checking is omitted.

The highlights in the REXX exec are examples of SDSF REXX panel access commands, action character commands, and some special REXX variables which provide function equivalent to other SDSF commands.

An example of the above SDSF REXX output is shown in Example 5-2.

```
Example 5-2 Sample REXX exec output
+II 5,A,J=14437
IAT5642 MDS ALLOCATION NOT YET ATTEMPTED FOR JOB MDSWAIT (JOB14437) ON SC74 MAIN NAVAIL
IAT5642 MDS ALLOCATION NOT YET ATTEMPTED FOR JOB MDSWAIT (JOB14437) ON SC70 MAIN NAVAIL
IAT5642 MDS ALLOCATION NOT YET ATTEMPTED FOR JOB MDSWAIT (JOB14437) ON SC75 RESOURCE NAVAIL
IAT5648 MDS FAILED TO ALLOCATE THE FOLLOWING FOR JOB MDSWAIT (JOB14437) ON SC75
IAT5645 THE DEVICE REQUIRED FOR SERIAL=NOVOL#
```

**REXX SDSF commands**
Support for SDSF commands is provided in two ways:

- The ISFEXEC host command, which allows you to issue panel commands, the slash (/) command, and a few others.

You issue commands with the ISFEXEC host command as follows:

```
Address SDSF " ISFEXEC sdsf_command [options]"
```

The commands that access SDSF tabular panels are all supported with ISFEXEC.

The ISFEXEC command returns column data and tokens to identify each row, as follows:

- Column data. The column data is returned in stem variables in this format:
  
  `column-name.row-number`
– Tokens to identify each row. These are returned in the TOKEN stem variable. For example, variable TOKEN.2 contains a string that identifies row 2 on the panel being processed.

If you specify a prefix with the PREFIX option, the name of the stem variable containing tokens begins with the prefix. For example, if the prefix is JDS_, the name of the stem variable is JDS_TOKEN.

The following additional commands are supported with ISFEXEC:

- The / command, which lets you enter system commands, is supported with ISFEXEC. The W and I prefix parameters are not supported. Use the WAIT and INTERNAL host command options instead.
- WHO, which provides information about the user and the environment
- QUERY (AUTH | FILTER | MODULE module-name), which lists SDSF data such as the commands for which you are authorized.

Special REXX variables, which provide function equivalent to many of the remaining SDSF commands. The special variables use the following format:

`isf_variable_name=' parameters '`

**Action characters and modifying columns**

You invoke SDSF action characters and modify column values using the ISFACT host environment command as shown in Example 5-3.

**Example 5-3 ISFACT host environment command**

```
Address SDSF "ISFACT command TOKEN('"token"') PARM(parms [options])"
```

where

- `command` is a valid SDSF command for the panel
- `token` identifies the row to be acted upon. The token was previously set by ISFEXEC for the panel accessed with sdsf-command.
- `parms` is the list of parameters that specifies the action characters and modifications, in the form:

```
column1 value1 column2 value2 ... columnN valueN
```

**Issuing system commands with ISFSLASH**

You issue system commands using the ISFSLASH host environment command as shown in Example 5-4.

**Example 5-4 ISFSLASH host environment command**

```
Address SDSF "ISFSLASH ( {stem-name|list}) [(options)]"
```

where

- `stem` is the name of a stem variable containing the list of system commands to be issued. The 0 variable of the stem must contain a count of the variables in the stem.
- `list` is a list of one or more system commands to be issued, separated by a blank or a comma.
- `options` are the WAIT and INTERNAL. The W and I prefix parameters of the slash (/) command are not supported.

The output of the command entered with the ISFSLASH SDSF command is recorded in the ULOG.
Drop special variables with ISFRESET

You drop special variables using the ISFRESET() function. This unassigns the variables and restores them to their original undefined state. The syntax of ISFRESET is shown in Example 5-5.

**Example 5-5  ISFRESET syntax**

```
rc=isfreset({ALL|INPUT|O|INOUT|IO})
```

- **ALL** drops all special variables except the variables for printing. ALL is the default.
- **INPUT** or I drops all input special variables.
- **OUTPUT** or O drops all output special variables.
- **INOUT** or IO drops all input/output special variables.

The isfreset() function does not require access to SDSF and so no authorization is required to use it. ISFRESET is not dependent on ISFCALLS and can be issued at any point in the exec. However, it is most useful when issued prior to an Address SDSF command.

REXX SDSF special variables

There are a number of special variables that you can use when working with panels and panel commands. Where the variable is associated with an SDSF command, the parameters for the variable are the same as for the command, with the exception that the ? parameter is not supported in REXX. Substitute the variable for the command, for example:

- **Command:** SET TIMEOUT 5
- **Variable:** isftimeout="5"

The following lists some of the SDSF REXX special variables:

- **isfactions** - Specifies whether the action characters for the current panel should be returned in the ISFRESP stem variable.
- **isfcols** - Column name list. On input to an isf command, you set isfcols to the names of all the columns you want returned. On output from the command, isfcols is set to the names of all the columns returned.
- **isficons** - Sets the console name for the ULOG.
- **isfdisplay** - Contains the SET DISPLAY response for tabular panels.
- **isffilter** - Sets a single filter criterion.
- **isfmsg** - ISPF short message. Capsule description of how the command completed if not blank.
- **isfmsg2** - Additional message stem. Set to additional messages, informational, warning and error.
- **isfprefix** - Job name pattern. Setting isfprefix is the same as using the PREFIX command in interactive SDSF.
- **isfowner** - Ownerid pattern. Setting isfowner is the same as using the OWNER command in interactive SDSF.
- **isfucols** - Updatable column name list. On output from an isf command, this variable is set to the names of all columns in isfcols which can be updated by the user.
- **isfrows** - Returned row count.
- **isfresp** - Stem variable that contains responses from commands. isfresp.0 contains the count of the response variables that follow.
- `isfsort` - Sort order. You set `isfsort` to direct SDSF to sort the rows in the virtual table before returning them to you.

- `isfulog` - Stem variable that contains the MVS system command echo and any responses generated during the session. The `isfulog.0` stem variable contains a count of the variables that follow.

### Browsing output in REXX SDSF

To browse output on various panels you use a combination of action characters and special REXX variables.

- To browse job output from the DA, I, JDS, and ST panels, allocate the output data sets with special REXX-only action characters, then browse the data sets using EXECIO or a similar utility. The action characters are:
  - `SA` - Allocate `all` data sets associated with the item. On the DA or ST panels, this is all data sets in the job. On the JDS panel, it is a single data set.
  - `SJA` - Allocate the JCL data set.

  The following special variables describe the results of the allocation that you use with EXECIO or a similar utility:
  - `isfddname` is a stem variable that contains the system-generated DDNAME returned by allocation that is referenced on EXECIO or other utility. It is not the application-specified DDNAME that is contained in the DDNAME.x stem variable returned by ISFACT. `isfddname.0` contains a count of the number of variables that follow.
  - `isfdsname` is a stem variable that contains the application-specified data set name that has been allocated by SDSF. The variables have a one-to-one correspondence with the variables in `ISFDDNAME`. Thus, the REXX caller can associate the data set being processed with the system generated DDNAME that has been allocated. `isfdsname.0` contains a count of the number of variables that follow.

- To browse output from the CK panel, use the `S` action character with the following special variable:
  - `isfline` is a stem variable that contains lines of data in response to a browse request. `isfline.0` contains the number of stem variables that follow.

For a full description of SDSF REXX refer to *z/OS SDSF Operation and Customization*.

### A sample REXX to display JES3 job zero data sets

Appendix A, “A sample REXX exec to display JES3 job zero data sets” on page 93 is an example of a REXX exec and supporting assembler programs to display the JES3 job zero (JOB00000) spool data sets. The spool data sets may be browsed, held, released, or cancelled.

### 5.2 SDSF in batch

To run SDSF in batch you invoke SDSF on an EXEC statement with one of two program names:

- `SDSF`, which supports commands and action characters.
- `ISFAFD`, which supports commands, action characters, and overtyping of fields on tabular and other panels, such as the print panels.
In addition to the EXEC statement, provide an ISFIN DD statement for batch input, and an ISFOUT DD statement for the batch output.

For example, a batch job to invoke program name ISFAFD might use these statements as shown in Example 5-6.

**Example 5-6 example batch job to invoke program name ISFAFD**

```
// EXEC PGM=ISFAFD
//ISFOUT DD SYSOUT=*  
//ISFIN DD *
```

To change panel width and depth of the batch output, use the PARM='++xxxx,yyyy' parameter on the EXEC statement, where xxxx is the depth of the panel (number of lines) and yyyy is the width (number of characters). Example 5-7 shows how to set the depth to 32 and the width to 1000.

**Example 5-7**

```
// EXEC PGM=SDSF,PARM='++32,1000'
//ISFOUT DD SYSOUT=*  
//ISFIN DD *
```

If you do not use the PARM statement, the width defaults to 132 and the depth to 60. The maximum for width and depth is 9999.

A return code of 0016 when SDSF is invoked in batch indicates that the user could not be placed in any of the groups defined with ISFPARMS.

**Using program name SDSF**

To access a panel and display its contents, use the panel command and ++ALL action as ISFIN input data.

For example, to select the ST panel and display its contents, use:

```
ST
++ALL
```

When ++ALL is specified, anything else on the card is ignored. To move around on the panel, you can use scroll commands (RIGHT, LEFT, UP, DOWN, TOP, and BOTTOM).

Any SDSF commands may be used as you would enter it on the command line, following the syntax described in the online help. The maximum length of a command is 42 characters—only the first 42 characters of each record in ISFIN will be processed. Note that you cannot use commands that require ISPF, such as commands that display pop-ups.

To use an action character, code ++action-character in your batch job STFIN input. To prevent a confirmation pop-up from being displayed for destructive action characters, use the SET CONFIRM OFF command.

You must do a successful FIND prior to issuing an action character. This protects you from issuing an action character against the wrong row.

To allow for an unsuccessful FIND, you should follow each action character with a RESET command, which clears pending action characters. For example, to find job BECKER1 on the ST panel, issue the command FIND ‘BECKER1’.
On the “panel” display title line, where SDSF displays messages, the result of the FIND command is shown:

\[ :SDSF \text{ STATUS \text{ DISPLAY \ ALL \ CLASSES}} \quad : \quad \text{CHARS 'BECKER1' FOUND} \]

After a successful FIND, the ++S action invokes a spool data set browse for job BECKER1. The END command returns the display to the ST panel.

\begin{verbatim}
ST
TOP
FIND 'BECKER1'
++S
END
\end{verbatim}

If the ++S action fails, the “panel” title line displays the SDSF message:

\[ :SDSF \text{ STATUS \text{ DISPLAY \ ALL \ CLASSES}} \quad : \quad \text{NO DISPLAYABLE DATA} \]

**Using program name ISFAFD**

When you invoke SDSF with program name ISFAFD, it works the same as when you invoke it with program name SDSF, with some differences:

- Action characters do not require a successful FIND.
- Overtypes and PF keys are supported.
- The contents of a panel are not updated until you explicitly refresh the panel. You do this with the AFD REFRESH command.
- Attribute bytes (used to define characteristics of fields such as color and conditioning for input) are present on the SDSF panels. These attribute bytes are translated out when you invoke SDSF with program name SDSF.

**Note:** You use program name SDSF when you run batch SDSF under a TSO session and allocate the ISFOUT data set to the terminal. If program ISFAFD is used, the attribute bytes for the panel fields cause terminal I/O errors. The TSO/E Session Manager translates the attribute characters to colons (:) which do not cause terminal I/O errors.

With program name ISFAFD, you can use the SDSF commands as you would with program name SDSF. In addition, you can also use the AFD commands:

- AFD LOCATE - Scrolls the OPERLOG.
- AFD LOGSTAMP - Controls the addition of a log stamp prefix for each record in the OPERLOG or SYSLOG when printing the log with SDSF’s PRINT function.
- AFD QUERY DS - Displays information about the current data set or log as a message.
- AFD QUERY CODEPAGE - Displays the code page that is in use on the message line.
- AFD QUERY COLUMNS - Displays information about the columns on the current tabular panel.
- AFD REFRESH - Requests that SDSF refresh the current display.
- AFD WTOR - Controls the display of WTORs at the bottom of the Log panel.
- AFD NP - Controls the width of the NP column.
- AFD .END - Assigns a label, .END, to the current top line of the SYSLOG or OPERLOG.
With program name ISFAFD, you can use PF03 and PF05 keys by coding `++AFD PFxx`. For example, to perform a repeat-find, you would code:

```
++AFD PF05
```

PF03 ends the current panel.

**Note:** The syntax for action characters is the same as for program name SDSF. However, because a successful FIND is not required, the action character will always be issued against the top row on the panel. To avoid issuing action characters against the wrong row, you might want to first set filters to be sure that only the appropriate rows are displayed.

You can overtype columns on any tabular panel except OD. The syntax for overtyping columns on tabular panels is the column title followed by `=` and the new value, all within `< >`. Enclose the column title and value in single quotation marks.

For a more detailed description of the usage of SDSF and ISFAFP programs in batch, refer to *z/OS SDSF Operation and Customization*.

### An example of the SDSF in batch

The TSO terminal monitor program, in batch, is used to invoke a REXX exec, which invokes SDSF to display the status (ST) panel for all JES3 jobs. The output of the SDSF program is directed to a DASD data set. The ISFOUT data is read into stem variables, which are filtered to find jobs in the JES3 MDS queues.

JCL for the SDSF program batch execution is shown in Example 5-8.

**Example 5-8  JCL for SDSF batch execution**

```
//RXBATSD JOB (999,POK),EXPERT,MSGLEVEL=1,MSGCLASS=A,NOTIFY=&SYSUID
//TMP PROC
//TMP EXEC PGM=IKJEFT01,DYNAMNBR=99
//SYSPROC DD DSN=VAINI.U.CLIST,DISP=SHR
//SYSTSPRT DD SYSOUT=*
// PEND
// EXEC TMP
//SYSTSTIN DD *
BATSD /* REXX to execute SDSF in batch */
```

The BATSD REXX exec is shown in Example 5-9.

**Example 5-9  BATSD REXX exec**

```
/* Rexx Sample JCL from the book
 // EXEC PGM=SDSF,PARM='32,500'
 //ISFOUT DD SYSOUT=* 
 //ISFIN DD *
*/
"alloc dd(isfout) uni(sysallda) spa(1 1) cyl new reu"
"alloc dd(isfin) uni(vio) spa(1 1) tra new reu",
"recf(f) lrec(80) dsor(PS)"
isfi. = "" /* Build ISFIN data */
isfi.1 = "PREFIX " /* Set PREFIX for ST */
```

Tip: The terminal monitor program (TMP) provides an interface between the user, command processors, and the TSO/E control program. It obtains commands, gives control to command processors, and monitors their execution.
isfi.2 = "OWNER ** /* Set OWNER for ST */
isfi.3 = "ST" /* ST command */
isfi.4 = "? " /* Request alternate fields */
isfi.5 = "++ALL" /* Set everything action */
isfi.0 = 5
"EXECIO * DISKW ISFIN (FINIS STEM ISFI." /* Update ISFIN */
"call *(SDSF) '++32,500'" /* Invoke SFSF */
"EXECIO * DISKR ISFOUT (FINIS STEM SDVAR." /* Read ISFOUT */
sayit = 0 /* Control switch */
z = substr(date(s),1,2) || date(j)
say "Present time:" substr(z,1,4) || "." || substr(z,5) date(j) time()
do i = 1 to sdvar.0 /* Loop through SDSF output */
  if pos('SDSF STATUS DISPLAY',sdvar.i) <> 0 & sayit = 0 then do
    j = i + 2
    tp = pos("Rd-Time",sdvar.j) /* Find an alternate field */
    if tp > 0 then do /* Process alternate field data */
      sayit = 1 /* Set switch = start processing */
      jp = pos("JOBNAME",sdvar.j) /* Find field offsets */
      qp = pos("Queue",sdvar.j)
      pp = pos("PhaseName",sdvar.j)
      dp = pos("Rd-Date",sdvar.j)
    end
  end
  if sayit then do /* Find JES3 jobs in MDS queues */
    if pos('SDSF STATUS DISPLAY',sdvar.i) <> 0 then iterate
    if pos('COMMAND INPUT',sdvar.i) <> 0 then iterate
    if substr(sdvar.i,jp,15) = " " then iterate
    qinf = substr(sdvar.i,jp,10)
    pinf = substr(sdvar.i,pp,21)
    if qinf = "SETUP" | wordpos("MDS",pinf) <> 0 then do
      jinf = substr(sdvar.i,jp,25)
      pinf = substr(sdvar.i,pp,21)
      tinf = substr(sdvar.i,tp,8)
      dinf = substr(sdvar.i,dp,8)
      say left(jinf,25) left(qinf,10) left(pinf,21) dinf right(tinf,8)
    end
  end
end

Sample output from the BATSD Rexx exec is shown in Example 5-10.

Example 5-10 Sample output from the BATSD Rexx exec

<table>
<thead>
<tr>
<th>BATSD</th>
<th>/ * REXX to execute SDSF in batch */</th>
</tr>
</thead>
<tbody>
<tr>
<td>Present time: 2009.120 09120 13:37:39</td>
<td></td>
</tr>
<tr>
<td>NOUNITS</td>
<td>J0814506 VAINI EXECUTION MDS ERROR</td>
</tr>
<tr>
<td>BECKER1</td>
<td>J0804066 BECKER SETUP AWAIT RES ALLOC</td>
</tr>
<tr>
<td>MDSWAIT</td>
<td>J0814437 VAINI SETUP AWAIT RES ALLOC</td>
</tr>
<tr>
<td>NOVOLS</td>
<td>J0814503 VAINI SETUP UNAVAIL VOL</td>
</tr>
</tbody>
</table>

READY
A sample REXX exec to display JES3 job zero data sets

The sample REXX exec, SDRXJ0DS, uses the ISFSLASH host environment command to issue the JES3 output service command *I,U,J=0,DD=?,N=ALL to display job zero spool output information. The JES3 command response is extracted from the ULOG (ISFULOG. stem variables) and the spool data set names are parsed, added to an ISPF table and displayed. The action on the ISPF table display, panel USRJOB0, allows browsing, holding, releasing, and cancelling of the data sets.

The browse action uses the JES3 spool browse interface to allocate the data set. Since ISPF browse does not support direct spool data set browsing, the data set is copied into a temporary VIO data set for ISPF browse.

The hold, release, and cancel actions use the ISFSLASH host environment command to issue the respective JES3 output service command *F,U,J=0,DSN=...D######_#,action.

The job zero spool data allocation is done using the JOB0SPBR assembler program. The program for the spool data set copy to VIO is the JOB0UIVO assembler program.
5.3 SDRXJ0DS REXX

/* REXX to browse JES3 JOB00000 spool data - SDRXJ0DS */
/* Housekeeping: */
/* Make PLIBs, CLIST, PGM data sets available for this REXX */
parse upper arg a
z = wordpos("DB",a)
if z <> 0 then do; Trace "I"; a = delword(a,z,1); end
else Trace "O"
ZEDLMSG = ""
ZEDMSG = ""
vio = "VIO"  /* MVS VIO unit name */
plib = "'VAINI.U.PANELS'"  /* Panel data set */
llib = "'VAINI.U.LOAD'"  /* Program data set */
clist = "'VAINI.U.CLIST'"  /* Rexx ALTLIB data */
parse source . . rexx .
z = SYSVAR('SYSJES')
parse var z jes .
z = MVSVAR('SYSOPSYS')
parse var z . rel .
if rel < "01.10.00" | jes <> "JES3" then do
  z = sayit(rexx "REXX not supported in" z" for "jes"!"
  exit 16
end
If sysvar(SYSISPF) <> "ACTIVE" then do
  z = sayit(rexx "REXX requires ISPF to be active!"
  exit 16
end
address "ISPEXEC"  /* Ditto */
"CONTROL ERRORS RETURN "  /* Control ISPF errors */
"LIBDEF ISPPLIB DATASET ID(plib)"
"LIBDEF ISPLIB DATASET ID(llib)"
address "TSO",
"ALTLIB ACT APPL(CLIST) DA('VAINI.U.CLIST') "
z = dojob0()  /* Invoke job zero proc */
address "TSO" "ALTLIB DEACT APPL(CLIST)"
address "ISPEXEC"
"LIBDEF ISPPLIB"
"LIBDEF ISPLIB"
rc=isfcalls('OFF')
exit  /* Finish */
/* JES3 job zero processing */
dojob0:
numeric digits 16
rc=isfcalls('ON')
uid=SYSVAR("sysuid")  /* Get userid */
zcn="SD"uid  /* ULOG console name */
isfcons=strip(substr(zcn,1,8),"T"," ")  /* Set console name */
jz = jes3cc()  /* Comm char for JES3 */
again = 1  /* Table refresh cntl */
do while again
  again = 0  /* 1 command- Ask .. */
  cmd.0 = 1
  cmd.1 = jz"I,U,J=0,DD=?,N=ALL"  /* ...JES3 JOB0000 DDs */
  Address SDSF "ISFSLASH (cmd.) (WAIT)="/* Issue command */
  if rc <> 0 then do
    zrc = rc
    z = sayit(jz"I,U,J=0,DD=?,N=ALL command failed. ISFSLASH RC="rc"!")
    exit zrc
ds. = ""                        /* Spool data set names */
f. = ""                          /* Spool data set info */
s. = ""                          /* Spool data set info */
j = 0                            /* Count of data sets */
/* Process *I,U,J=0,DD=?,N=ALL response IAT8131 messages */
/* IAT8131 JOB JES3 (JOB00000), T=PRT, L=30, PG=0, SR=30, BY=8168, */
/* IAT8131 JOB JES3 (JOB00000), COPIES=1, DD=JES3.DC.OUTPUT(1), */
/* IAT8131 JOB JES3 (JOB00000), DSN=JES2.JES3.JOB00000.D0000004.DC.*/
do i = 1 to isfulog.0
if pos("IAT8131",isfulog.i) <> 0 then do
    select
    when pos("DSN=",isfulog.i) <> 0 then do /* 3rd line */
        parse var isfulog.i . 73 zds
        zds = strip(zds,'T','.')
        parse var zds . '=' zds
        z = value("ds."j,left(zds,40))
    end
    when pos("T=",isfulog.i) <> 0 then do /* 1st line */
        j = j + 1
        parse var isfulog.i . 73 zds
        zds = left(translate(zds,' ',','),36)
        z = value("fp."j,zds)
    end
    otherwise do                           /* 2nd line */
        parse var isfulog.i . 73 zds
        zds = translate(zds,' ',',')
        z = value("sp."j,zds)
    end
end
/* Create ISPF table display variables */
of. = ""
of.0 = j
do k = 1 to of.0
    z = ds.k fp.k
    z = value("of."k,z)
do
Address "ISPEXEC" "VGET (ZSCREEN)"   /* Get split number */
Address "TSO"
TN = "J0TBL" || ZSCREEN             /* ISPF table name */
SEL = 0                              /* Selected rows */
/* JES3 job zero spool data set table display loop */
z = tbc()                             /* Create the table */
do i = 1 to of.0                      /* Create table rows */
    dsd = strip(of.i)                 /* Spool data set name */
    dsd = right(strip(substr(dsd,63,7),"L","0' ),7)
    dsd = overlay(z,dsd,63)
    z = tba()                          /* Add row to the table */
drop of.
z = tbt()                            /* Display from top row */
z = tbd()                            /* Display table */
end
return rc
/* ISPF table create */
tbc:
Address "ISPEXEC"
"TBCREATE" TN "NAMES(DSD) NOWRITE REPLACE"
Address "TSO"
return rc
/* ISPF table add a row */
tba:
Address "ISPEXEC"
"TBADD" TN
Address "TSO"
return rc
/* Position table display to top */
tbt:
Address "ISPEXEC"
"TBTOP" TN
Address "TSO"
return rc
/* Display table and process selections */
tbd:
TRC = 0
TOP = 0
CRW = 1
SEL = 0
Address "ISPEXEC"
Do while TRC < 8                       /* Table display loop */
  If again = 1 then Leave
  "TBTOP" TN
  "TBSKIP" TN "NUMBER(\"TOP\")"
  src = RC
  "TBDISPL" TN "PANEL(USRJOB0) POSITION(TBL) CSRROW(\"CRW\")"
  TRC = RC
/* Process a selected row */
  If SEL = 0 Then do
    CRW = TBL
    z = selpro()
    O = ""
    "TBPUT" TN
  End
/* Process pending row selections */
  Do while ZTDSELS > 1
    "TBDISPL" TN "POSITION(TBL)"
    MRC = RC
    CRW = TBL
    z = selpro()
    O = ""
    "TBPUT" TN
  End
  if ZCMD = "R" then again = 1        /* Refresh the display */
  If TRC = 8 then Leave
End
/* End of table display */
"TBCLOSE" TN
Address "TSO"
return rc
/* Process selection actions; B | S browse, H hold, R release, */
/* C cancel the spool data set */
selpro:
select
  when o = "S" | o = "B" then do /* View the spool data */
    "CONTROL DISPLAY SAVE"
    z = msg("OFF")
    Address "TSO" "UNALLOC DD(SYSUT1 SYSUT2)"
z = msg(z)
sds = strip(substr(dsd,1,40),"T")
JOB0SDS = sds
"VPUT (JOB0SDS) SHARED"
/* Alloc the JES3 job zero data det */
Address "TSO" "CALL 'VAINI.U.LOAD(JOB0SPBR)' '"sds"'
/* Alloc a VIO data set for ISPF VIEW */
Address "TSO" "ALLOC DD(SYSUT2) UNIT("vio") SPA(2 2) CYL REU"
/* Copy spool data into the VIO data set */
Address "TSO" "CALL 'VAINI.U.LOAD(JOB0UIVO)'"
/* ISPF VIEW the VIO data */
"LMINIT DATAID(DID) DDNAME(SYSUT2) ENQ(SHR)"
ZEDLMSG = sds
"SETMSG MSG(ISRZ001)"
"VIEW DATAID("DID") MACRO(JOBOIMAC)"
"LMFREE DATAID("DID")"
Address "TSO" "UNALLOC DD(SYSUT1 SYSUT2)"
"CONTROL DISPLAY RESTORE"
end
when o = "H" | o = "R" | o = "C" then do /*Hold-Release-Cancel*/
    parse var dsd . ". . . . . dsn . . . . .
/* Build JES3 *F U command for H, R, or C action */
    ac = jz || "F,U,J=0,DSN=..." || dsn
if o = "C" then do
    y = "C"
    z = ",CANCEL"
    again = 1
end
else do
    y = "H"
    if o = "R" then do
        z = ",NH=N"
        y = ' '
    end
    else z = ",NH=Y"
end
ac = ac || z
/* Issue the *F U command for H, R, or C action */
cmd.0 = 1                        /* 1 command- Ask .. */
cmd.1 = ac                       /* ..JES3 JOB0000 DDs */
Address SDSF "ISFSLASH (cmd.)"   /* Issue command */
dsd = overlay(y,dsd,55)
end
when o = "?" then o = ' '
otherwise nop
End
return rc
/*Issue an ISPF message */
sayit:
parse arg xyz
if xyz = "" then zedlmsg = xyz
If sysvar(SYSISPFC) = "ACTIVE" then do
    zedlmsg = ""
    address "ISFEXEC" "SETMSG MSG(ISRZ000)"
end
else Say zedlmsg
return 0
/* Find one JES3 global communication character */
jes3cc:
cvt = c2x( storage(10,4) )
cvt_128 = d2x( x2d(cvt) + x2d(128) )
jesct = c2x( storage(cvt_128,4) )
jesct_18= d2x( x2d(jesct) + x2d(18))
ssct = c2x( storage(jesct_18,4) )
ssct_d = d2x( x2d(ssct) + x2d(0d) )
ssct_10 = d2x( x2d(ssct) + x2d(10) )
ssvt = c2x( storage(ssct_10,4) )
ssvt_3e4= d2x( x2d(ssvt) + x2d(3e4))
systs = c2x( storage(ssvt_3e4,4) )
if x2d(systs) = 0 then gpfx = "***" else do
gpfx = ""
wpt = systs
systs_3f= d2x( x2d(systs) + x2d(3f))
wpt = systs_3f
   do i = 0 to 6
   wpt = d2x( x2d(wpt) + (i*9) )
wpt_1 = d2x( x2d(wpt) + 1 )
z = c2x( storage(wpt_1) )
   if x2d(z)  = 0 then do
   if gpfx = "" then gpfx = "***" else leave
      end
   else gpfx = gpfx strip(storage(wpt_1,8),"B")
   end
   end
return word(gpfx,1)

JOB0SPBR program assembler source
JOB0SPBR CSECT
* * Module-Name = JOB0SPBR
* * Link-Edit attributes: AMODE=24 RMODE=24 AC=1
* * Include program name into IKJTSOxx parmlib AUTHPGM settings.
* *
* Descriptive-Name =
* Allocate JES3 Job Zero Spool Data Sets in a TSO session
* *
* Function =
* *
* This module is called to allocate a JES3 spool data set. The data set name is passed to the program as
* TSO CALL command parameter string.
* *
* The DDNAME for the allocation is SYSUT1.
* *
* Non-zero RC in R15 indicates a failure to allocate.
* *
* YREGS
* Some housekeeping
BAKR R14,0
LR R12,R15
USING JOB0SPBR,R12
LA R13,5A
* Get argument spool data set name
L R2,0(R1)
LH R1,0(R2)
LA R3,2(R2)
LTR R1,R1
BNZ ASDS There is an argument - Use it
Appendix A. A sample REXX exec to display JES3 job zero data sets

* No argument - Return w/ bad RC
LA R15,16 Set bad RC
B PR Return

* Set JCL spool data set name into DYNALLOC p-list
ASDS DS OH
STH R1,DSNL Data set name length
BCTR R1,0
MVC DSNT(0),0(R3)
EX R1,=*-6 Data set name

* Set UID from ASCB to browse token
L R2,'X'224'(,0)
L R2,'X'0B0'(,R2)
MVC UID,0(R2)

* Set JES3 name from SSCT into DYNALLOC p-list
L R2,'X'010'(,0)
L R2,'X'128'(,R2)
L R2,'X'018'(,R2)
MVC JES,8(R2)

* Complete DYNALLOC p-list initialization
LA R3,DALRB
USING S99RB,R3
MVI S99RBLN,S99RBEND-S99RB
MVI S99VERB,S99VRBAL
LA R1,TUPL
ST R1,S99TXTPP
LA R2,DALRBX
ST R2,S99RBX
USING S99RBX,R2
MVC S99EID,=CL6'S99RBX'
MVI S99EVER,S99RBXVR
MVI S99EOPTS,S99EIMSG+S99EWTP
LA R1,DALRBP
DYNALLOC

* Exit program - RC in R15
PR NOP +*4
PR
LTORG

* Data
BRTK DC H'110' DALBRTKN
DC H'7'
I1 DC H'4' ID LENGTH
DC CL4'BTOK' ID FIELD
I2 DC H'2' VERSION LENGTH
DC XL2'0303' SPOOL DATA SET / OS/390 RELEASE 10
I3 DC H'4' SPOOL TOKEN LENGTH
DC XL4'00' SPOOL TOKEN N/A
I4 DC H'4' JOB KEY LENGTH
DC XL4'00' JOB KEY (HEX)
I5 DC H'2' ASID LENGTH
DC XL2'00' ASID
I6 DC H'8' USERID LENGTH
UID DC CL8' ' USERID
I7 DC H'255' LOG STR LENGTH
I7T DC CL256' ' LOG STR

* DSN DC H'2' DALDSNAM
DC H'1'
DSNL DC H'48'
DSNT DC CL48' '
DISP DC H'4' DALSTATS
Using SDSF in a JES3 Environment

JOB0UIVO program assembler source

JOB0UIVO CSECT
JOB0UIVO AMODE 31
JOB0UIVO RMODE 24

* Module-Name = JOB0UIVO
* Link-Edit attributes: AMODE=31 RMODE=24 AC=0
* Descriptive-Name = Copy JES3 Job Zero Spool Data Set into a DASD PS data set
* Function =
* This module is called to copy a JES3 spool data set into a physical sequential DASD data set for ISFF browse. The spool data set is expected to have ddname SYSUT1. The output data set is expected to be allocated to ddname SYSUT2. The record format of the output data set is forced to VB.

* Housekeeping
SAVE (14,12),&SYSDATE-&SYSTIME-JOB0UIVO
LR R12,R15
USING JOB0UIVO,R12
ST R13,SAVEAREA+4
LA R13,SAVEAREA

* Open input and output data sets
OPEN (SYSUT1,INPUT)
OPEN (SYSUT2,OUTPUT)

* Prepare GET/PUT loop
LA R3,SYSUT1
USING IHADCB,R3
SLR R4,R4

* The GET/PUT loop
GPL DS OH
GET SYSUT1,UIN
ICM R4,3,DCBEROPT-Z Get U format input record's LRECL
LA R4,4(R4) Build RDW for the V format output
STH R4,VOUT
PUT SYSUT2,VOUT
B GPL Loop until EOF for input

* Eof input - Close files and exit
EOI DS OH
CLOSE SYSUT1
CLOSE SYSUT2
XR R15,R15
L R13,SAVEAREA+4
RETURN (14,12),RC=(15)

* LTORG

* Data
SAVEAREA DS 18F
VOUT DC AL2(0,0)

* SYSUT1 DCB DSORG=PS,DDNAME=SYSUT1,MACRF=(GM),EODAD=EOI,
RECFM=U,BLKSIZE=4096

SYSUT2 DCB DSORG=PS,DDNAME=SYSUT2,MACRF=(PM),
RECFM=VB,BLKSIZE=14404,LRECL=140

* DCBD DSORG=PS
END JOB0UIVO

USRJOB0 ISPF table display panel
)ATTR
  _ TYPE(INPUT) INTENS(HIGH)  PADC(NULLS) JUST(LEFT)  CAPS(ON)
  @ TYPE(INPUT) INTENS(LOW)   PAD(' ')   JUST(ASIS)  CAPS(ON)
  % TYPE(OUTPUT) INTENS(HIGH) PAD(' ')  JUST(ASIS)  CAPS(ON)
  ? TYPE(OUTPUT) INTENS(HIGH) PAD('-')  JUST(ASIS)  CAPS(OFF)
  ¢ TYPE(OUTPUT) INTENS(HIGH) PAD(' ')  JUST(RIGHT) CAPS(ON)
  + TYPE(OUTPUT) INTENS(LOW)  PAD(' ')  JUST(ASIS)  CAPS(ON)
  | TYPE(TEXT) INTENS(HIGH)  PAD(' ')  JUST(ASIS)  CAPS(ON)
  ¦ TYPE(TEXT) INTENS(LOW)    PAD(' ')  JUST(ASIS)  CAPS(ON)
)BODY
|------------------------ JES3 JOB00000 Spool Data -----------------------------
|&ZTIME|C=>_ZCMD |ROLL=>_AMT | |
|A |Spool Data Set Some info |
)MODEL
  _O +DSD
)INIT
  .AUTOSEL = NO
  .CSRROW = &CRW
)REINIT
  .AUTOSEL = NO
  .CSRROW = &CRW
Using SDSF in a JES3 Environment

```plaintext
IF (.MSG = ' ')
  &O = ' '
  REFRESH(O)
IF (.MSG = ISRZ001)
  &O = ' '
  &ZCMD = ' '
  REFRESH(O,ZCMD)
)PROC
  IF (&O = ?)
    &ZEDMSG = ' '
    &ZEDLMSG = 'Actions: B | S browse, H hold, R release, C cancel'
    .MSG = ISRZ001
  IF (&ZCMD = ?)
    &ZEDMSG = ' '
    &ZEDLMSG = 'Actions: B | S browse, H hold, R release, C cancel'
    .MSG = ISRZ001
  &TOP = &ZTDTOP
  &SEL = &ZTDSELS
)END

A sample job zero spool data set display

---

Figure 5-2  A sample job zero spool data set display

```
Sample files

This appendix provides sample files for reference.
B.1 ISFPRM00 sample

The sample ISFPARMS definitions in the ISF.AISFJCL(ISFPRM00) data set are shown in Example B-1.

Example B-1 ISFORM00 sample

```c
/******* Sample SDSF Initialization Statements */
/* Proprietary Statement = */
/* Licensed Materials - Property of IBM */
/* 5694-A01 */
/* Copyright IBM Corp. 1981, 2009. */
/* Status = HQX7760 */
/* EXTERNAL CLASSIFICATION = OTHER */
/* END OF EXTERNAL CLASSIFICATION: */
/* This is a sample SDSF parameter definition. It is equivalent */
/* to the macros supplied in ISFPARMS. */
/* To use this member, copy it to SYS1.PARMLIB or a dataset */
/* concatenated to it and edit the member as appropriate. */
/* Alternatively, you can modify the SDSF server JCL to point */
/* to a data set that contains the member. */
/* Note that, even with conditional processing, if you want */
/* to use a common member with different levels of SDSF, you */
/* must ensure that the member does not include support (such */
/* as new keywords or values) that was introduced in a */
/* higher level of SDSF. */
/* The SDSF server must be started for the member to be used. */
/* If the SDSF server is not active, the macros in ISFPARMS */
/* are used instead. */
/* The following are general syntax rules for coding the SDSF */
/* initialization statements. Refer to the SDSF Operation and */
/* Customization manual for more details. */
/* - Statements are free form, and can appear in any column 1-72. */
/* An optional sequence number may be coded in columns 73-80, */
/* but it is not used by SDSF. */
/* - A statement can span any number of lines. Use a trailing */
/* comma to indicate that a statement is continued. */
/* - Comments can be coded at any point a blank is allowed using */
/* the slash-asterisk notation. Blank lines can be inserted */
```
/ * at any point to improve readability. * /
/ * - All values are translated to upper case. Enclose the value in quotes if it contains special characters or contains mixed case. * /
/ * - Statements may appear in any order, except that the FLDENT must follow an FLD, and the NTBLENT must follow an NTBL. * /
/ * SERVER statements must follow a SERVERGROUP. * /
/ * - A keyword value of blanks may be specified by coding one or more blanks enclosed in quotes for the value. * /
***************************************************************************************/

/*********************************************************
* WHEN Statement - Provide Conditional Processing */
/***********************************************************/
WHEN
  /* Reset any prior WHEN conditions */

/*********************************************************
* SERVERGROUP, SERVER, and COMM - Define Communications */
/***********************************************************/
/* SERVERGROUP */                /* Defines a group of SDSF servers */

/*********************************************************
* Each SERVER statement defines an SDSF server in the sysplex. *
* The server in turn relates to a specific JES2 member for which data is to be gathered. Repeat the SERVER and COMM statements as many times as necessary to define all the JES2 members for which data is to be shown. *
* Note: All servers must be in the same sysplex and all JES2 members must be in the same MAS. *
/***********************************************************/
/* SERVER NAME(sdsf-servername), /* Names the SDSF server */
/* SYSNAME(system-name), /* System name for server */
/* JESNAME(jes2-subsystem-name), /* JES2 procedure name */
/* MEMBER(jes2-member-name), /* JES2 member name */
/* COMM(comm-statement-name) /* Related COMM statement */
/* COMM NAME(statement-name), /* Defines communications parms */
/* QMGR(qmgr-name) /* QMgr name for connections */
/* CLUSTER(clustername), /* Cluster name for queues */
/* QREPLACE(YES), /* Replace prior queue defs */
/* QDELETE(NO), /* Do not delete queues */
/* QDEFINE(YES) /* Define required queues */

/****************************/
/* CONNECT - Connection Options */
/****************************/
CONNECT DEFAULT(COND) /* Default server if not already assigned */
/* DEFAULT(NO) to not assign server as default */
/* DEFAULT(YES) to unconditionally assign */
/* server as default */

/****************************/
/* OPTIONS Statement - Global SDSF Options */
/****************************/
OPTIONS ATHOPEN(YES), /* Use authorized open for datasets */
DCHAR(‘?’), /* Command query character */
DSI(NO), /* Bypass ENQ for dynamic allocation */
FINDLIM(5000), /* Maximum lines to search for FIND */
IDBLKS(4096), /* HASPINDX blocksize */
INDEX(ISF.HASPINDX), /* HASPINDX dataset name */
LINECNT(55), /* Print lines per page */
LOGLIM(0), /* OPERLOG search limit in hours */
MENUS(ISF.SISFPLIB), /* Panels dataset name for TSO */
NIDBUF(5), /* Number of haspindx buffers */
SCHARS(‘*%’), /* Generic and placeholder characters */
SCRSIZE(1920), /* Maximum screen size */
SYSOUT(A), /* Default print sysout class */
TIMEOUT(5), /* Communications timeout in seconds */
TRACE(C000), /* Default trace mask */
TRCLASS(A), /* Default trace sysout class */
UNALLOC(NO) /* Do not free dynalloc data sets */

/****************************/
/* GROUP ISFSPROG - System Programmers */
/****************************/
GROUP NAME(ISFSPROG), /* Group name */
TSOAUTH(JCL,OPER,ACCT), /* User must have JCL, OPER, ACCT */
ACTION(ALL), /* All route codes displayed */
ACTIONBAR(YES), /* Display the action bar on panels */
APPC(ON), /* Include APPC sysout */
AUPDT(2), /* Minimum auto update interval */
AUTH(ALL), /* All authorized functions */
BROWSE(NONE), /* Browse default action character */
CMDAUTH(ALL), /* Commands allowed for all jobs */
CMDLEV(7), /* Authorized command level */
CONFIRM(ON), /* Enable cancel confirmation */
CPUFMT(LONG), /* Long format CPU utilization on DA */
CTITLE(ASIS), /* Allow mixed case column titles */
CURSOR(ON), /* Leave cursor on last row processed */
/*CUSTOM(SPRGPROP),*/ /* Uncomment for custom properties */
DADFLT(IN,OUT,TRANS,STC,TSU,JOB), /* Default rows shown on DA */
DATE(MMDDYYYY), /* Default date format */
DATESEP('/'), /* Default datesep format */
DFIELD2(DAFLD2), /* Sample alternate field list for DA */
DISPLAY(OFF), /* Do not display current values */
DSPAUTH(ALL), /* Browse allowed for all jobs */
EMCSAUTH(MASTER), /* Activate EMCS cons with master auth */
EMCSREQ(NO), /* EMCS console not required */
GPLEN(2), /* Group prefix length */
ILOGCOL(1), /* Initial display column in log */
INPUT(OFF), /* Initial value for INPUT command */
ISYS(LOCAL), /* Initial system default */
LANG(ENGLISH), /* Default language */
LOG(OPERACT), /* Default log option */
OWNER(NONE), /* Default owner */
RSYS(NONE), /* Initial system default for wtors */
UPCTAB(TRTAB2), /* Upper case translate table name */
VALTAB(TRTAB), /* Valid character translate table */
VIO(SYSALLDA) /* Unit name for page mode output */

/***************************/
/* GROUP ISFOPER - Operators */
/***************************/
GROUP NAME(ISFOPER), /* Group name */
TSAUTH(JCL,OPER), /* User must have JCL and OPER */
ACTION(ALL), /* All route codes displayed */
ACTIONBAR(YES), /* Display action bar on panels */
APPC(ON), /* Include APPC sysout */
AUPDT(2), /* Minimum auto update interval */
AUTH(ALLOPER), /* All operator authorized functions */
BROWSE(NONE), /* Browse default action character */
CMDAUTH(ALL), /* Commands allowed for all jobs */
CMDLEV(7), /* Authorized command level */
CONFIRM(ON), /* Enable cancel confirmation */
CPUFMT(LONG), /* Long format CPU utilization on DA */
CTITLE(ASIS), /* Allow mixed case column titles */
CURSOR(ON), /* Leave cursor on last row processed */
/*CUSTOM(OPERPROP),*/ /* Uncomment for custom properties */
DADFLT(IN,OUT,TRANS,STC,TSU,JOB), /* Default rows shown on DA */
DATE(MMDDYYYY), /* Default date format */
DATESEP('/'), /* Default datesep format */
DISPLAY(OFF), /* Do not display current values */
DSPAUTH(USERID,NOTIFY,AMSG), /* Browse authority */
EMCSAUTH(MASTER), /* Activate EMCS cons with master auth */
EMCSREQ(NO), /* EMCS console not required */
GPLEN(2), /* Group prefix length */
ILOGCOL(1), /* Initial display column in log */
ISYS(LOCAL), /* Initial system default */
LANG(ENGLISH), /* Default language */
LOG(OPERACT), /* Default log option */
OWNER(NONE),            /* Default owner               */
RSYS(NONE),            /* Initial system default for wtors */
UPCTAB(TRTAB2),        /* Upper case translate table name */
VALTAB(TRTAB),         /* Valid character translate table */
VIO(SYSALLDA)          /* Unit name for page mode output */

/*********************************/
/* GROUP ISFUSER - General Users */
/*********************************/
GROUP NAME(ISFUSER),    /* Group name */
TSOAUTH(JCL),          /* User must have JCL */
ACTION(11,12,USER),   /* Default route codes in log */
ACTIONBAR(YES),       /* Display action bar on panels */
APPC(ON),             /* Include APPC sysout */
AUPDT(-10),           /* Default auto update interval */
AUTH(ALLUSER),        /* All user authorized functions */
BROWSE(NONE),         /* Browse default action character */
CMDAUTH(USERID,NOTIFY),/* Command authority */
CMDLEV(2),            /* Command level */
CONFIRM(ON),          /* Enable cancel confirmation */
CPUFMT(LONG),         /* Long format CPU utilization on DA */
CTITLE(ASIS),         /* Allow mixed case column titles */
/*CUSTOM(USERPROP)*/,  /* Uncomment for custom properties */
CURSOR(ON),           /* Leave cursor on last row processed */
DADFLT(IN,OUT,TRANS,STC,TSU,JOB), /* Default rows on DA */
DATE(MMDDYYYY),       /* Default date format */
DATESEP('/'),         /* Default datesep format */
DISPLAY(OFF),         /* Do not display current values */
DSPAUTH(USERID,NOTIFY),/* Browse authority */
EMCSAUTH(MASTER),     /* Activate EMCS cons with master auth */
EMCSREQ(NO),          /* EMCS console not required */
ILOGCOL(1),           /* Initial display column in log */
LANG(ENGLISH),        /* Default language */
LOG(OPERACT),         /* Default log option */
OWNER(USERID),        /* Default owner */
PREFIX(USERID),       /* Default prefix */
UPCTAB(TRTAB2),       /* Upper case translate table name */
VALTAB(TRTAB),        /* Valid character translate table */
VIO(SYSALLDA)         /* Unit name for page mode output */

/*********************************/
/* Sample NTBL list */
/*********************************/
NTBL NAME(SLIST)
NTBLENT STRING($S),OFFSET(1)
NTBLENT STRING(P),OFFSET(7)
NTBLENT STRING(PAY),OFFSET(3)

/***********************************/
/* Define default SDSF Codepage */
/***********************************/
TRTAB CODPAG(SDSF) VALTAB(TRTAB) UPCTAB(TRTAB2)
```plaintext
/* Sample alternate field list for DA display */
FLD NAME(DAFLD2) TYPE(DA) /* Name is referenced by GROUP statement */

| FLDENT COLUMN(STEPN), TITLE('StepName'), WIDTH(D) |
| FLDENT COLUMN(PROCS), TITLE('ProcStep'), WIDTH(D) |
| FLDENT COLUMN(JobID), TITLE('JobID'), WIDTH(D)    |
| FLDENT COLUMN(OWNERID), TITLE('Owner'), WIDTH(D)  |
| FLDENT COLUMN(JCLASS), TITLE('C'), WIDTH(D)       |
| FLDENT COLUMN(ASID), TITLE('ASID'), WIDTH(D)      |
| FLDENT COLUMN(JIDX), TITLE('JIDX'), WIDTH(D)      |
| FLDENT COLUMN(EXCP), TITLE('EXCP-Cnt'), WIDTH(D)  |
| FLDENT COLUMN(CPU), TITLE('CPU-Time'), WIDTH(D)   |
| FLDENT COLUMN(REAL), TITLE('Real'), WIDTH(D)      |
| FLDENT COLUMN(PAGING), TITLE('Paging'), WIDTH(D)  |
| FLDENT COLUMN(EXCPRT), TITLE('SIO'), WIDTH(D)     |
| FLDENT COLUMN(CPUPR), TITLE('CPU%'), WIDTH(D)     |
| FLDENT COLUMN(DP), TITLE('DP'), WIDTH(D)          |
| FLDENT COLUMN(POS), TITLE('Pos'), WIDTH(D)        |
| FLDENT COLUMN(SWAPR), TITLE('SR'), WIDTH(D)       |
| FLDENT COLUMN(PGN), TITLE('PGN'), WIDTH(D)        |
| FLDENT COLUMN(DOMAIN), TITLE('DnM'), WIDTH(D)     |
| FLDENT COLUMN(STATUS), TITLE('Status'), WIDTH(D)  |
| FLDENT COLUMN(WORKLOAD), TITLE('WorkLoad'), WIDTH(D) |
| FLDENT COLUMN(SRVCLASS), TITLE('SrvClass'), WIDTH(D) |
| FLDENT COLUMN(PERIOD), TITLE('SP'), WIDTH(D)      |
| FLDENT COLUMN(RESGROUP), TITLE('ResGroup'), WIDTH(D) |
| FLDENT COLUMN(QUIESCE), TITLE('Quiesce'), WIDTH(D) |
| FLDENT COLUMN(SYSNAME), TITLE('SysName'), WIDTH(D) |
| FLDENT COLUMN(SPAGING), TITLE('SPag'), WIDTH(D)   |
| FLDENT COLUMN(SCPU), TITLE('SCPU%'), WIDTH(D)     |
| FLDENT COLUMN(ECPU), TITLE('ECPU-Time'), WIDTH(D) |
| FLDENT COLUMN(ECPUPR), TITLE('ECPU%'), WIDTH(D)   |
| FLDENT COLUMN(CPUCRIT), TITLE('CPUCrit'), WIDTH(D) |
| FLDENT COLUMN(STORCRIT), TITLE('StorCrit'), WIDTH(D) |
| FLDENT COLUMN(RPTCLASS), TITLE('RptClass'), WIDTH(D) |
| FLDENT COLUMN(MEMLIMIT), TITLE('MemLimit'), WIDTH(D) |
| FLDENT COLUMN(TRANACT), TITLE('Tran-Act'), WIDTH(D) |
| FLDENT COLUMN(TRANRES), TITLE('Tran-Res'), WIDTH(D) |
| FLDENT COLUMN(SPIN), TITLE('Spin'), WIDTH(D)      |
| FLDENT COLUMN(SECLABEL), TITLE('SecLabel'), WIDTH(D) |
| FLDENT COLUMN(GCPTIME), TITLE('GCP-Time'), WIDTH(D) |
| FLDENT COLUMN(ZAAPTIME), TITLE('zAAP-Time'), WIDTH(D) |
| FLDENT COLUMN(ZAAPCPTM), TITLE('zACP-Time'), WIDTH(D) |
| FLDENT COLUMN(GCPUSE), TITLE('GCP-Use%'), WIDTH(D) |
| FLDENT COLUMN(ZAAPUSE), TITLE('zAAP-Use%'), WIDTH(D) |
| FLDENT COLUMN(SZAAP), TITLE('SzAAP%'), WIDTH(D)    |
| FLDENT COLUMN(SZIIP), TITLE('SzIIP%'), WIDTH(D)    |
| FLDENT COLUMN(PROMOTED), TITLE('Promoted'), WIDTH(D) |
| FLDENT COLUMN(ZIIPTIME), TITLE('zIIP-Time'), WIDTH(D) |
| FLDENT COLUMN(ZIIPCPTM), TITLE('zICP-Time'), WIDTH(D) |
```
FLDENT COLUMN(ZIIPNTIM),TITLE('zIIP-Ntime') WIDTH(D)
FLDENT COLUMN(ZIIPUSE),TITLE('zIIP-Use%') WIDTH(D)
FLDENT COLUMN(SLCP),TITLE('SLCPU%') WIDTH(D)

/********************/
/* Custom Properties */
/********************/

/* The custom properties are defined using a PROLIST statement */
/* which is referenced by the CUSTOM keyword on the GROUP. For */
/* each PROLIST, define the PROPERTY statements for the custom */
/* properties that are required. See the SDSF Operation and */
/* Customization manual for the complete list of properties */
/* that may be specified. */

/* PROLIST NAME(SPRGPROP) Group ISFSROG properties */
/* PROPERTY NAME(property-name),VALUE(TRUE or FALSE) */

/* PROLIST NAME(OPERPROP) Group ISFOPER properties */
/* PROPERTY NAME(property-name),VALUE(TRUE or FALSE) */

/* PROLIST NAME(USERPROP) Group ISFUSER properties */
/* PROPERTY NAME(property-name),VALUE(TRUE or FALSE) */
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this paper.

IBM Redbooks

For information about ordering these publications, see "How to get Redbooks" on page 111. Note that some of the documents referenced here may be available in softcopy only.

- Implementing REXX Support in SDSF, SG24-7419-00

Other publications

These publications are also relevant as further information sources:

- z/OS SDSF Operation and Customization, SA22-7670

Online resources

These Web sites are also relevant as further information sources:

- SDSF home page: usage tips, presentations, as well as a wizard to help you enable the sysplex support at:
  http://www.ibm.com/servers/eserver/zseries/zos/sdsf

- Latest edition of the z/OS SDSF Operation and Customization, SA22-7670 which is available at the following URLs:

How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications and Additional materials, as well as order hardcopy Redbooks publications, at this Web site:

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services
# Index

## A
- **Action bar**
  - Display 17
  - Filter 18
  - Help 21
  - Logs 18
  - Options 19
  - Print 19
  - View 18
- Action bar overview 17
- Action characters 21

## B
- browsing output in REXX SDSF 88

## C
- COLSHELP command 25
- columns on the OPERLOG panel 60
- commands for OPERLOG panel 58
- commands for SYSLOG panel 62

## D
- default hardcopy log 56
- Display Active Users (DA) panel 66
- Display Active Users (DA) panel NP field actions 67
- Display Active Users panel fields 69

## E
- Enclave panel fields 75
- Enclave panel NP field actions 75
- Enclaves (ENC) panel 74

## F
- Filter commands 34

## H
- Health Checker (CK) panel 79
- Health Checker panel fields 80
- Health Checker panel NP field actions 80
- Help panel overview 10

## I
- Input queue panel 37
- Input queue panel fields 37
- ISFACT host environment command 86
- ISFEXEC host command 85
- ISFPARMS 22
- ISFPARMS AUTH parameter 32
- ISFPARMS FLD and FLDEINT statement 24
- ISFPARMS statements 23

## J
- JES3 and MVS commands for the action characters on DA panel 68
- JES3 DLOG 55
- JES3 monitor DSP 6
- JESPLEX (JP) panel 50
- JESPLEX panel fields 51
- JESPLEX panel NP field actions 51
- JESSPOOL class resources 31
- Job Class (JC) panel 52
- Job Class panel fields 53
- Job Class panel NP field actions 52
- Job Data Set panel 46

## N
- New SYSLOG support 61

## O
- OPERCMDS 32
- OPERLOG 55
- OPERLOG panel 57
- Output Descriptors panel 48
- Output Descriptors panel fields 49
- Output Descriptors panel NP field action characters 50
- overtyping fields 26

## P
- PF key definitions for SDSF 10
- Pop-up display for enclave I action character 76
- Processes (PS) panel 77
- Processes panel fields 78
- Processes panel NP field actions 78

## R
- Redbooks Web site 111
- Contact us viii
- Resource (RES) panel 73
- Resource group profiles 32
- Resource panel fields 74
- Resource panel NP field actions 74
- REXX SDSF commands 85
- REXX SDSF special variables 87
- REXXHELP command 84

## S
- SAF authorization 31
- Sample SDSF REXX exec 85
- Scheduling Environment (SE) panel 72
Scheduling Environment panel fields 73
Scheduling Environment panel NP field actions 73
SDSF action character authorization 30
SDSF and SAF based security 7
SDSF batch 88
SDSF batch example 91
SDSF data filtering 33
SDSF Display Active Users (DA) panel help screen examples 14
SDSF filtering options 33
   Destination 33
   Filter 33
   Owner 33
   Prefix of jobname 33
   Replies on the Log 33
   System name 33
SDSF for JES3 primary menu options 3
SDSF functions overview 2
SDSF hardcopy log 55
SDSF in batch 6
SDSF information resources 2
SDSF JES2 functions not available in SDSF JES3 5
SDSF panel colors 13
SDSF panel overview 13
SDSF panel structure 3
SDSF panels
   (CK) Health Checker panel 79
   (DA) Display Active Users panel 66
   (ENC) Enclaves panel 74
   (I) Input Queue 37
   (JC) Job Class panel 52
   (JP) JESPLEX panel 50
   (LOG O) OPERLOG panel 57
   (LOG S) SYSLOG panel 60
   (OD) Output Descriptors Panel 48
   (PS) Processes panel 77
   (RES) Resource panel 73
   (SE) Scheduling Environment panel 72
   (SP) Spool Volumes panel 53
   (SR) System Requests panel 70
   (ST) Status panel 43
   Job Data Set panel 47
SDSF REXX 84
SDSF server 7, 21
SDSF tutorial 13
Spool Volumes (SP) panel 53
Spool Volumes panel fields 54
Spool Volumes panel NP field actions 54
Status panel 43
SYSLOG 55
SYSLOG panel 60
SYSLOG panel display description 61
System Requests (SR) panel 70
System Requests panel fields 72
System Requests panel NP field actions 71

T
   Tabular panel alternate view 37

U
   ULOG 40
   using program name ISFAFD 90
   using program name SDSF 89
   using REXX with SDSF 7

V
   Viewing output
      (S) SDSF Browse 45
      (SB) ISPF Browse 45
      (SE and SJ) ISPF Edit 46
      (V) GDDM Browse 45
   viewing output 45
Using SDSF in a JES3 Environment

This IBM Redpaper publication offers a broad overview of features of the z/OS System Display and Search Facility (SDSF) for JES3. z/OS R10 delivers the (long-requested) ability to use SDSF in a JES3 environment.

This Redpaper describes the features, panels, and functions of SDSF for JES3 and provides implementation and customization details.

Simplify management of JES3 systems
Common UI for both JES2 and JES3
Write powerful scripts using SDSF/REXX

For more information:
ibm.com/redbooks